DSA8300
Digital Serial Analyzer
Printable Online Help
DSA8300
Digital Serial Analyzer
Printable Online Help
# Table of Contents

## Welcome
- Welcome to the DSA8300 Online Help .............................................................. 1
- Related Documents .......................................................................................... 1
- Analysis and Connectivity Support Overview .................................................... 2
- Get Analysis and Connectivity Software ........................................................... 4
- Accessories, Options, and Software ................................................................. 5

## Getting Started
- Getting Started Topics ....................................................................................... 7
- Instrument Operation
  - Theory of Operation ....................................................................................... 7
  - Signal Acquisition Process .............................................................................. 9
- User Interface Tour
  - User Interface Overview ................................................................................ 11
  - The DSA8300 Main Screen ............................................................................. 12
  - Graticules ....................................................................................................... 14
  - Touchscreen Operations ................................................................................... 14
  - Virtual Keyboard and Keypad Overview ......................................................... 15
  - Mouse and Touchscreen Operation Comparison ............................................. 17
- Front-Panel Controls
  - Channel Source Controls .............................................................................. 18
  - Channel Select Controls ................................................................................ 18
  - Vertical Controls ............................................................................................ 19
  - Timebase View Controls ................................................................................ 20
  - Acquisition Controls ....................................................................................... 20
  - Horizontal (Timebase) Controls ..................................................................... 21
  - Trigger Controls............................................................................................... 22
  - Utility Controls ................................................................................................ 23
  - Instrument Settings Overview ......................................................................... 23
  - Restore Default (Factory) Instrument Settings ................................................ 24
  - Select and Display Waveforms ......................................................................... 24
- View/Change Module Configuration
  - Changing Modules Without Powering Down the Mainframe ............................. 25
- Acquire and Display a Signal
  - Data Acquisition Overview ............................................................................ 26
  - Acquire and Display a Signal ......................................................................... 26
  - Signal Conditioning and Scaling Overview ...................................................... 28
  - Math Waveforms Overview ............................................................................. 29
### Controls-specific help

#### Acquisition setup
- Acquisition Setup Dialog Box Overview .......................................................... 37
- Signal Acquisition Modes ............................................................................... 37
- Acquisition Stop After Settings ..................................................................... 38
- Acquisition Stop Action Settings .................................................................... 40
- Acquisition background
  - Acquisition Background ............................................................................... 40
  - Acquisition Key Points ............................................................................... 41
  - Acquisition Sampling Process ..................................................................... 43

#### Cursor setup
- Cursor Setup Dialog Box Overview ............................................................... 45
- Cursor Function Settings ............................................................................... 46
- Cursor 1 and 2 Settings ................................................................................. 47
- Cursor Background ....................................................................................... 47
- Cursor Units ................................................................................................. 50

#### Display setup
- Display Setup Dialog Box Overview .............................................................. 50
- Display Style Settings ................................................................................ 51
- Display Graticule Settings ............................................................................ 53
- Waveform display background
  - Waveform Display Elements ...................................................................... 53
  - Waveform Display Key Points ..................................................................... 55
  - Display Settings ......................................................................................... 59
  - Waveform Display Persistence .................................................................. 60
  - Waveform Display Data Point Interpolation .............................................. 60
  - Display Features ....................................................................................... 61

#### Histograms setup
- Histograms Setup Dialog Box Overview ........................................................ 61
- Histogram Source Settings ........................................................................... 62
- Histogram Display Options .......................................................................... 63
- Histogram Limit Controls ............................................................................ 64
- Histogram Background ................................................................................ 64
# Table of Contents

Histogram Statistics .................................................................................................. 66

## Horizontal Setup

Horizontal Setup Dialog Box Overview ................................................................. 66

### Timebase Controls

- Horizontal Timebase Controls Overview .......................................................... 67
- Horizontal Timebase Selection .......................................................................... 68
- Horizontal Scale Control ................................................................................. 69
- Horizontal Position Control ............................................................................ 71
- Horizontal Resolution Control ....................................................................... 73
- Horizontal Record Length Control ................................................................. 74
- Horizontal Reference Point Control ............................................................... 75

### All Timebases Controls

- All Timebases Controls Overview .................................................................. 76
- Timebase Comm Standard Control .................................................................. 76
- Timebase Units Control .................................................................................. 77
- Display Scale Control ..................................................................................... 78
- The Pattern Sync/FrameScan Setup ................................................................. 79

## The Horizontal Acquisition Window Overview .................................................. 79

- Horizontal Scale versus Record Length versus Sample Interval versus Resolution .... 81
- Independent versus Shared Window .................................................................. 82

### FrameScan

- FrameScan Overview ...................................................................................... 82
- FrameScan Theory of Operation ....................................................................... 84
- FrameScan Enable and Scan Bits ..................................................................... 86

### Mask Setup

- Mask Setup Dialog Box Overview .................................................................... 86
- Mask Source Controls .................................................................................... 88
- Mask Display Controls .................................................................................. 89
- Mask Margins Controls ................................................................................. 90
- Autoset Data to Mask Controls ................................................................. 91

#### Autofit Mask To Data

- Autofit Mask to Data Overview ................................................................... 92
- Autofit Mask to Data Procedure .................................................................. 93

### Mask Edit Dialog Box Overview ................................................................. 94

#### Mask Usage Guidelines

- Mask Usage Guidelines ................................................................................. 95
- Mask Editing Guidelines ............................................................................... 95

#### Mask Hit Count Readout

- Mask Hit Count Readout ............................................................................... 98

### Measure setup

- Measure Setup Dialog Box Overview ............................................................. 98

#### Measurement Parameter Tabs

- Measurement Parameters Tabs Overview .................................................... 100
- Measurement Source Tab ........................................................................... 101
# Table of Contents

- Measurement Region Tab (Pulse Selected) .......................................................... 102
- Measurement Region Tab (RZ or NRZ Selected) ............................................... 103
- To Set a Measurement Region (Gates) ............................................................... 104
- Measurement Hi/Low Tab .............................................................................. 105
- Measurement Reference Level Tab ................................................................... 106
- To Set a Measurement Ref Level Method ......................................................... 107
- Automatic Measurements Overview ................................................................. 108
- Automatic Measurements Guidelines ............................................................... 108

## Phase Reference Setup
- Phase Reference Setup Dialog Box Overview .................................................. 110
- Phase Correction Settings .............................................................................. 113
- Phase Reference Clock Source Settings ......................................................... 113
- Phase Reference Setup Process ....................................................................... 116
- Phase Reference Background ........................................................................ 117
- Phase Reference Keys Points ........................................................................ 117
- Phase Reference Caveats ............................................................................... 119
- Phase Reference Characterization Status ......................................................... 120

## TDR Setup
- TDR Setup Dialog Box Overview ..................................................................... 120
- TDR Preset Settings ....................................................................................... 122
- TDR Step Settings ......................................................................................... 124
- TDR Acquisition Settings ............................................................................. 125
- TDR Step Deskew Settings ........................................................................... 126
- TDR Turn Off All Steps Settings .................................................................. 127
- Advanced TDR Setup .................................................................................. 127

## Mode/Trigger Setup
- Mode/Trigger Setup Dialog Box Overview ..................................................... 129
- Trigger Source Settings ................................................................................ 131
- Scope Mode (Clock Trigger Source) ............................................................ 133
- Clock Recovery Outputs ............................................................................. 133

### Pattern Sync/FrameScan
- Pattern Sync/FrameScan Setup Dialog Box .................................................. 134
- Pattern Sync Controls ............................................................................... 135
- AutoSync Options ...................................................................................... 137
- FrameScan Controls .................................................................................. 138

### Advanced Trigger Setup Controls
- Advanced Trigger Setup Controls ............................................................... 139

### Trigger Holdoff Reference Guidelines
- Trigger Holdoff Reference Guidelines .......................................................... 140

### Trigger Background
- Trigger Background ................................................................................... 141

### Triggering Key Points
- Triggering Key Points ................................................................................ 141

### Trigger Sources and Modes
- Trigger Sources and Modes ....................................................................... 143

### Trigger Process Overview
- Trigger Process Overview ........................................................................ 145

## Vertical Setup (Basic)
## Table of Contents

Vertical Setup (Basic) Dialog Box Overview............................................................ 147  
Waveform Selector Setting ................................................................................ 149  
Vertical Scale Setting....................................................................................... 149  
Vertical Position Setting.................................................................................... 151  
Vertical Offset Setting...................................................................................... 151  
Vertical Channel Deskew and Delay Settings ........................................................... 153  
Channel Deskew and Channel Delay Overview......................................................... 154  
Vertical Bandwidth, Units Settings ....................................................................... 155  
Vertical External Attenuation Setting ..................................................................... 156  
Vertical DC Cal Setting .................................................................................... 157  
Vertical Controls Background............................................................................. 158  
How Vertical Position, Scale, and Offset Affect Acquisition and Display ................. 159  
Vertical Setting Caveats .................................................................................... 161  
Vertical Settings Key Points ............................................................................... 162  
Vertical Signal Conditioning .............................................................................. 163  

**Vertical Setup (Optical Signals)**  
Vertical Setup (Optical) Dialog Box Overview.......................................................... 168  
Optical Waveform Selector ................................................................................ 169  
Optical Wavelength Setting................................................................................ 170  
Optical Filter Setting ....................................................................................... 170  
Optical Bandwidth.......................................................................................... 171  
Optical Compensation and Calibration .................................................................. 171  

Waveform Database Setup  
Waveform Database Setup Dialog Box Overview ...................................................... 171  
Waveform Database 1 - 4 Settings ........................................................................ 173  
Waveform Database Persistence Settings ................................................................ 174  
Waveform Database Display Options Settings .......................................................... 175  
Waveform Database Background ......................................................................... 176  
Waveform Database Caveats .............................................................................. 178  
Waveform Database Key Points........................................................................... 179  

**File & Edit Menu Functions Overviews**  
Clear References Dialog Box .............................................................................. 179  
Export Dialog Box .......................................................................................... 179  
Save Waveform Dialog Box ............................................................................... 181  
Page Setup Dialog Box ..................................................................................... 182  
Print Dialog Box ............................................................................................ 182  
Save Setup Dialog Box ................................................................................... 184  
Recall Setup Dialog Box................................................................................... 185  
Save/Recall Setups Caveats ............................................................................... 186  
Save/Recall Setups Key Points ............................................................................ 187  
Save Waveform Dialog Box ............................................................................... 188  
Recall Waveform Dialog Box ............................................................................... 189  

DSA8300 Printable Online Help
Table of Contents

- Save/Recall Waveforms Background .......................................................... 189
- Saving a Waveform as a Reference Waveform ........................................ 189

Define Math Waveforms
  - Define Math Dialog Box Overview ....................................................... 189
  - Math Waveform Slot Select .............................................................. 190
  - Math Expression Field ..................................................................... 191
  - Math Functions ................................................................................ 193
  - Math Function Definitions ............................................................... 193
  - Math Sources .................................................................................. 195
  - Math Keypad ................................................................................... 196
  - Math Syntax Controls ..................................................................... 197
  - Math Average, Risetime, and Mode .................................................. 198
  - Math Measurement Scalars .............................................................. 199
  - Math Expressions Syntax ................................................................ 200
  - Math Waveforms Background .......................................................... 200
  - Math Waveform Caveats .................................................................. 202
  - Math Waveform Key Points ............................................................. 202
  - Math Waveform Operations .............................................................. 204

System & Utilities Overviews
- About Dialog Box ................................................................................ 205
- Autoset
  - Autoset Properties Dialog Box .......................................................... 205
  - Autoset Mode Settings .................................................................... 205
  - Autoset Options Settings ................................................................. 207
  - Autoset TDR Options Settings .......................................................... 208
  - Autoset Notifier Windows ............................................................... 208
- Calibration
  - Calibration Dialog Box Overview ..................................................... 209
  - Calibration Readout Fields ............................................................... 210
  - Update Calibration Information ........................................................ 211
- Compensation
  - Compensation Dialog Box Overview ................................................. 211
  - Compensation Readout Fields .......................................................... 212
  - Compensation Select Action ............................................................ 214
  - Compensation Targets ..................................................................... 215
  - Compensation Results Storage ........................................................ 215
  - Execute Compensation .................................................................... 216
  - Compensation Indicator Button ......................................................... 216
- Diagnostics
  - Diagnostics: Subsystem Level Tab ..................................................... 217
  - Diagnostics: Area Level Tab ............................................................. 219
  - Diagnostics: Test Level Tab ............................................................... 220
Preferences Dialog Box
   User Preferences: General Tab ................................................................. 221
   User Preferences: Start-up Tab ................................................................. 222
   User Preferences: GPIB Configuration Tab .............................................. 224
Properties
   System Properties Dialog Box: Mainframe Tab ........................................ 225
   System Properties Dialog Box: Modules Tab ............................................. 226
   System Properties Dialog Box: Probes Tab ................................................ 227
   System Properties Dialog Box: Options Tab .............................................. 228
   Waveform Properties Dialog Box ............................................................. 229

Automatic Measurements Reference
   Automatic Measurements Reference Overview .......................................... 231
   Pulse Measurements
      Pulse Amplitude Measurements ............................................................. 231
      Pulse Timing Measurements .................................................................. 236
      Pulse Area Measurements ...................................................................... 239
   Return-to-Zero (RZ) Measurements
      RZ Amplitude Measurements ................................................................ 240
      RZ Timing Measurements ...................................................................... 250
      RZ Area Measurements ......................................................................... 254
   Non-Return-to-Zero (NRZ) Measurements
      NRZ Amplitude Measurements .............................................................. 254
      NRZ Timing Measurements .................................................................... 264
      NRZ Area Measurements ....................................................................... 268
   Reference Level Parameters and Calculation Methods
      Reference Level Calculation Method- All Sources .................................... 268
      Pulse Waveform Measurement Reference Levels .................................. 269
      RZ Waveform Measurement Reference Levels ....................................... 272
      NRZ Waveform Measurement Reference Levels ..................................... 273
   High/Low Level Tracking Algorithms ....................................................... 276

User Maintenance
   Exterior Cleaning ....................................................................................... 279
   Flat Panel Display Cleaning ...................................................................... 279
   Optical Connector Cleaning ....................................................................... 280

Network Operations
   Connect to a Network ................................................................................ 281
   Print a Hard Copy ...................................................................................... 281
   Save a Waveform to a File ......................................................................... 282
   Run Other PC Applications ....................................................................... 282
Table of Contents

Microsoft Windows Desktop Guidelines ............................................................... 282

Index
Welcome to the DSA8300 Online Help

Welcome to the Tektronix DSA8300 Digital Serial Analyzer Online Help.

New to the DSA8300?

Start with the Getting Started Topics (see page 7) for an overview of the instrument user interface, controls, and basic signal acquisition and measurement operations.

Want to Know the Name of a User Interface Control Element?

Move your mouse pointer on most menu titles, toolbar buttons, and other control elements to show the name of that element.

Need Context-Sensitive Help?

Click the Help button on instrument dialog boxes to open help for that dialog box. The dialog box help may also have links to more in-depth information.

Looking for Something Specific?

Click the Index or Search tab and enter a keyword for which to search.

Need Some Extra Help?

If you cannot find the information that you are looking for in the online help, see if any of the Related Documents (see page 1) have the information that you need. You can also contact Tektronix Technical Support for help with operating your instrument.

Related Documents

- **DSA8300 Quick Start User Manual**: This document includes installation, start up and other information to get you up and running on the DSA8300 Digital Serial Analyzer instrument.

- **DSA8300 Programmer Manual**: This PDF file includes an alphabetical listing of the programming commands and other information related to controlling the instrument over the GPIB (or over an Ethernet connection using virtual GPIB). Click Help > Programmer Guide from the TekScope application to open this manual.

- **DSA8300 Specifications and Performance Verification Manual**: This document includes the specifications and performance verification procedures for the DSA8300 mainframe and all modules available for use with the mainframe.
Several optional analysis and connectivity software applications are available that let you remotely control the instrument and transfer data between the instrument and software-development and data-analysis tools.

You can use the analysis and connectivity software provided with this instrument to:

- Gather instrument data (waveforms, measurements) and export it to analysis tools such as Microsoft Excel, MathWorks MATLAB, and MathSoft Mathcad.
- Interface with many software development environments, such as Microsoft Visual C++ and Visual Basic, National Instruments LabVIEW and LabWindows, and many Microsoft-Windows-compatible development tools.

Click the following software components to find out how to take advantage of the connectivity features provided by your instrument:

- **The VXI Plug-and-Play Instrument Driver (see page 3)**
## VXI Plug-and-Play Instrument Driver

The VXI plug&play instrument driver is a collection of software components, organized according to the standard VXI plug&play model established by the VXI plug&play Systems Alliance.

- **TekVISA™ (see page 3)**

## TekVISA™

TekVISA is a library of industry-standard compliant software components, organized according to the standard VISA model established by the VXIplug&play Systems Alliance. Use TekVISA software to write interoperable instrument drivers to handle communicating between software applications and your instrument.

- **TekVISA ActiveX Control (TVC) (see page 3)**

## TekVISA ActiveX Control (TVC)

The TekVISA Control (TVC) uses Microsoft Windows ActiveX control technology to simplify access from Microsoft Office and Visual BASIC applications to TekVISA and the underlying instrument. It does this by providing support for key TekVISA features within an ActiveX control object that is compatible with Excel’s Visual BASIC for Applications, Visual BASIC 6.0, and other popular programming environments for Microsoft Windows.

- **TekVISA Excel Toolbar (see page 3)**

## TekVISA Excel Toolbar

The TekVISA Excel Toolbar allows direct, fast transfer of instrument measurements or captured waveforms to an Excel 2010 worksheet. Transfer is done using a toolbar that is integrated into Excel, implemented using the TekVISA ActiveX Control (TVC) and the Visual BASIC for Applications (VBA) macro editor built into Excel. Source code for the toolbar is accessible through Excel’s built-in VBA editor. Access the source code to use as a tool for learning the TekVISA ActiveX Control, or to cut-and-paste selected components to new VB applications.

- **VXI 11.2 LAN Server (see page 3)**

## VXI 11.2 LAN Server

The VXI 11.2 LAN Server provides software connectivity between your instrument and remote PCs over an Ethernet LAN. This tool is a client-side component built-in with TekVISA; on each remote PC, you must install another copy of TekVISA to make use of its client-side component. The VXI-11 standard specifies a protocol for communication with devices over a network using a network instrument server. This protocol uses the ONC/RPC (Open Network Computing/Remote Procedure Call) standard that, in turn, is based on TCP/IP.
See Also:

Get Analysis and Connectivity Software (see page 4)

Get Analysis and Connectivity Software

The DSA8300 Product Software CD also includes the Analysis and Connectivity Software. By default, the Analysis and Connectivity Software is installed when reinstalling the product software from the CD.

**NOTE.** You can also install the Analysis and Connectivity Software on any personal computer running Microsoft Windows (see ReleaseNotes.pdf on the Product Software CD for installation details).

For More Information

The Analysis and Connectivity Software installs a TekVISA folder to the **Start > Programs** menu. This folder contains the following information:

- The book *Oscilloscope Analysis and Connectivity Made Easy* (see page 4)

  **Oscilloscope Analysis and Connectivity Made Easy**

  This book describes how to use popular software development environments to build graphical user interfaces to Tektronix Windows-based oscilloscopes. It includes examples of how to connect your oscilloscope to the latest PC software tools for analyzing waveform and measurement data. The examples use programming environments that include Excel VBA, Visual BASIC 6.0, MATLAB, Lab Windows, and LabVIEW.

  This book ships with appropriately equipped Tektronix oscilloscopes and may be available as a PDF file with the software that ships with your oscilloscope.

- The Release Notes

- The TekVISA ActiveX Control API

- The TekVISA Configuration tool

- The *TekVISA Programming Manual* (see page 4)

  **TekVISA Programming Manual**

  This book describes the TekVISA operations, attributes, and events. It includes programming samples using Microsoft Visual C++, and sections that include VISA Data Type Assignments, Completion and Error codes, and a glossary.

  This book is available from TekVISA installations and may be available as a PDF file with the software that ships with your oscilloscope.

- The TekVISA Quick Reference Card
Installing the VXI plug & play Instrument Driver (see page 5) adds a VxiPnp folder to the Start > Programs menu. This folder provides the following information:

**Installing the VXI plug & play Instrument Driver**

The VXI plug&play driver is not installed by default, but the installation folder is. To install the driver:

1. Minimize the instrument application by clicking the minimize (-) button in the upper right corner of the display.

2. Click the Window Explorer folder on the desktop.

3. From Explorer, find and open the folder C:\Program Files\Tektronix\VXIPNPInstall.

4. Double-click setup.exe in this folder to install the VXI PnP driver.

5. After installation, you will find the VXIplug&play Driver at C:\VXIpn\WINNT\bin\tk-tds8k_32.dll

6. To return the instrument application to the screen, click the DSA8300 button in the Windows task bar at the bottom of the screen.

- The Tkdsa83 Help
- The Tkdsa83 Samples
- The uninstall for the Tkdsa83 Instrument Driver

**Accessories, Options, and Software**

Go to the Tektronix Web site (www.tek.com) for the most current DSA8300 instrument options, standard options, optional accessories, application software, and product documentation.
Getting Started Topics

The following topics provide an introduction to the instrument operation, user interface elements, front panel controls, and waveform operations.

Instrument Operation

Theory of Operation (see page 7)
Signal Acquisition Process (see page 9)

User Interface Elements

User Interface Overview (see page 11)
Application Screen (see page 12)
Graticules (see page 14)
Control from the Display (see page 14)
Virtual Keyboard and Keypad (see page 15)

Front Panel Controls

Channel Source Controls (see page 18)
Channel Select Controls (see page 18)
Vertical Controls (see page 19)
Timebase View Controls (see page 20)
Signal Acquisition Controls (see page 20)
Horizontal (Timebase) Controls (see page 21)
Trigger Controls (see page 22)
Utility Controls (see page 23)
Change Instrument Settings (see page 23)
Restore Default Instrument Setup (see page 24)

Waveform Operations

Select and Display Waveforms (see page 24)
Acquire and Display a Signal (see page 26)
Signal Conditioning and Scaling Overview (see page 28)
Math Waveforms Overview (see page 29)
Waveform Database Overview (see page 29)
Waveform Measurement Tools (see page 30)

Theory of Operation

The block diagram and text provides background information on the instrument theory of operation.
The instrument contains five high-level subsystems or processes, embodying a variety of hardware and software functions:

■ **Modular Sampling Specialization System.** Allows selecting signal acquisition modules based on the types of signals to acquire: electrical or optical; with clock recovery or without, with bandwidth filter or not. Provides cost-effective solution for users needing very high bandwidth with superb time resolution on repetitive waveforms. Sampling modules determine the size of the vertical acquisition window for each channel.

■ **Digital Signal Acquisition.** Acquires a waveform record from each signal you apply to each channel using the following subsystems:
  - **Acquisition System.** Sets vertical offset for the vertical acquisition window for each channel. Performs the actual A/D (analog to digital) conversion and storing of digitized samples. Also performs post A/D sample-based corrections to compensate for nonlinearities of various analog circuits.
  - **Trigger System.** Recognizes a specific event of interest on the input trigger or clock signal and informs the Timebase that a trigger or clock event has occurred, gating the taking of a sample after a controlled, incremental delay. The trigger event is time zero for the waveform record, which means that all samples are displayed relative to this point.

There is no internal trigger pick off from the channels; rather, a trigger signal must be obtained through the external trigger inputs, from the internal TDR clock, from the internal free-running trigger, or from the clock recovery, when available from optical or accessory modules equipped with clock recovery.

  - **Timebase System.** Tells the Acquisition system to take a sample at a specified time relative to the trigger (or clock) event. In more general terms, synchronizes the capturing of digital samples in the Acquisition system to the trigger (or clock) events generated from the Trigger system.

■ **Signal Processing Transformation System.** Performs a variety of transformations or operations, such as waveform math operations, automatic measurements, and histogram generation, on the channel waveforms.
■ **Display, Input/Output, Storage Systems.** Provides display control. Sets the vertical scale and position of the display, which controls how much of the vertical acquisition window appears on screen. Provides output (and sometimes input) of instrument-data elements in a form suitable to the user.

■ **User Interface and Waveform Display.** Displays the instrument UI, waveforms, and software controls. Also provides a touch screen interface to the UI controls.

**Signal Acquisition Process**

The process flow diagram and text describe the signal acquisition steps.
1. The instrument starts in the idle state when powered on, after receiving most control setting changes, or when finishing acquisition tasks.

2. When you toggle the RUN/STOP control to RUN, the instrument implements its setup based on the current control settings (either the default settings or most recent setup, depending on user-set preferences).
3. The instrument then waits for a trigger. No sampling takes place until triggering criteria is met (Free Run and TDR trigger sources generate their own internal trigger events). The instrument accepts trigger.

4. The instrument then waits a delay time, that is, it delays taking a sample until a specified time elapses, where:

\[
\text{Delay time} = \text{Horizontal Pos.} + \text{Ch. Deskew} + N \text{ sample intervals}
\]

In the above calculation, \(N = \text{Current sample count} - 1\)

For example, if taking the 6th sample in the waveform record, 5 sample intervals are added.

5. The instrument takes one sample for each waveform record (channel) for each active (on) timebase. This instrument samples sequentially, starting with the first waveform point and continuing to the last waveform point. One sample is taken per trigger for each active channel in each displayed timebase.

6. If averaging or enveloping is on, each record becomes part of a multi-acquisition record that these modes (see page 41) produce. The process loops back to step 3 above to acquire additional records until the number of acquisitions required for the current acquisition mode are acquired, and then processing continues as for step 8 below.

7. If FrameScan mode is on, the acquisition process is modified. See FrameScan Theory of Operation (see page 84) in the FrameScan Background topic for information on how FrameScan works.

8. The instrument stores the acquisition record in channel acquisition memory and makes it available for measurement of its parameters, display, output, and so on.

9. The instrument then checks for user-specified stop condition and either returns to its idle state or continues at step 3, according to what it finds.

**User Interface Overview**

You have three ways to control the instrument:

**Front Panel Controls**

The front-panel knobs and controls perform most basic vertical, horizontal, and triggering functions. See the Front Panel Controls topics for more information on what each front-panel control does.

**Mouse and Keyboard**

Use the mouse and keyboard to access the complete functionality of the instrument. Your instrument comes with a mouse and keyboard as standard accessories.

**Touchscreen Operation**

You can control the graphical user interface using the built-in touchscreen. Push the TOUCH SCREEN front panel button to enable and disable touchscreen operation. Then touch the application user interface element on the screen to access or run that function.
The DSA8300 Main Screen

The instrument application runs full screen, providing a variety of mouse, keyboard, or touchscreen controls.
1. **Toolbar**: Access to key features, including the setup dialogs, acquisition modes, triggering modes, and applications.

2. **Menu Bar**: Access to all instrument functions and configurations.

3. **Status Bar**: Trigger status, waveform count, and conditional acquisition status.

4. **Readout Docking**: Select to undock the readout area from the application to a separate window. You can position the undocked readout window on a second monitor.

5. **Readout Area**: Displays waveform measurements. Use the arrow buttons at each end to scroll the contents.

6. **Readouts**: Displays individual waveform measurement readouts grouped by type (measurements, histogram, waveform, cursor, mask, and so on). Right-click on a readout to access readout display and setup parameters.

7. **Readout Display On/Off**: Toggles on or off the display of readout groups (measurement, waveform, and so on). This function does not turn off the measurement associated with the selected readout type, only the display of that readout type.

8. **Select Waveform and Instrument Settings**: Quick access to select Channel, Math, and Reference waveforms, as well as instrument vertical and horizontal values of the selected waveform.

9. **Waveform Handles Area**: Gray strip along the left edge of the graticule that displays selectors or “handles” for active waveforms. Select a handle to do various operations, such as drag to adjust the waveform vertical position.

10. **Display**: Shows live, reference, and math waveforms, as well as cursors, masks, and other elements used to analyze them. Use the mouse to select waveforms, define a zoom area, and move cursors and gates.

11. **Measurements Bar**: Quick access to the automated measurements by source signal-type and measurement category. Select a signal type and category using the pulldown menus, and then click a measurement button to add that measurement to the readouts area.
Graticules

Use the Display dialog box (Setup > Disp) to customize your graticule. There are four types of graticules from which to select:

- **Grid.** This type of graticule display shows the outer edge of the graticule and a dot-grid across the graticule, to help in making graticule measurements.

- **Crosshair.** This type of graticule display shows the outer edge of the graticule and X- and Y-axes, to help in making graticule measurements.

- **Full.** A combination of Grid and Crosshair graticules.

- **Frame.** This type of graticule display shows only a frame around the outer edges of the graticule, so it is easy to see waveform detail.

Touchscreen Operations

You can control much of this instrument directly from the waveform display area. Use the mouse (or your finger or a stylus if using the touchscreen) in the waveform area to do the following operations:

- Click and drag on a cursor to move it on the waveform.
- Click and drag a waveform icon to change the vertical position of a waveform.
- Click and drag a waveform ground reference to add offset to a channel.
- Click and drag a waveform label or screen text to reposition it.
- Click and drag across part of a waveform to select an area to zoom. Click the Zoom button to zoom in on the selected area.
- Click and drag an on-screen measurement gate to another horizontal position on the waveform.
Virtual Keyboard and Keypad Overview

A pop-up keyboard or keypad button opens an on-screen keyboard or keypad. The pop-up keyboard and keypad let you enter data when a keyboard is not attached to the instrument. Enter text and numbers into the field from which you opened the keyboard or keypad.

Pop-Up Keyboard

**TIP. Use the Utilities > Preferences dialog box to select either a QWERTY Keyboard or Alphabetical Keyboard keyboard display.**

QWERTY Keyboard

Alphabetical Keyboard
Pop-Up Keypad

Pop-up Keypad. Use the mouse or touchscreen to edit the value.

Pop-Up Keypad

Clicking the keyboard/keypad icon pops up the keypad for control fields that allow values to be entered directly.
Mouse and Touchscreen Operation Comparison

This instrument ships with a mouse and keyboard to give you more options for instrument control. However, for some installations, you might not have enough work space to install the mouse or keyboard. For most operations, you can use the touchscreen to perform mouse-related operations. The following table lists mouse/touchscreen operation equivalents.

Table 1: Comparison of mouse and touchscreen operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Using Mouse</th>
<th>Using Touchscreen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select waveforms</td>
<td>Click object on screen</td>
<td>Touch (tap) object on screen</td>
</tr>
<tr>
<td>Operate toolbar and dialog box</td>
<td>Clic and hold, move cursor</td>
<td>Touch and drag</td>
</tr>
<tr>
<td>Display menus</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select menu and list items</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move cursors on screen, draw a</td>
<td>Click the keyboard icon associated with the</td>
<td>Touch the keyboard icon associated</td>
</tr>
<tr>
<td>zoom box</td>
<td>field to open a virtual keyboard; click the keys</td>
<td>with the field to open a virtual keyboard;</td>
</tr>
<tr>
<td></td>
<td>to enter alphanumeric characters. Or use a</td>
<td>touch the keys to enter alphanumeric</td>
</tr>
<tr>
<td></td>
<td>keyboard if installed.</td>
<td>characters.</td>
</tr>
<tr>
<td>Open a context menu for a channel</td>
<td>Touch and hold (do not move stylus)</td>
<td></td>
</tr>
<tr>
<td>or measurement readout</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter a value in a field</td>
<td>Position cursor on a main screen button or</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td>readout</td>
<td></td>
</tr>
<tr>
<td>Display a tool tip</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The instrument ships with two styluses. Using a stylus can make it easier to perform touchscreen operations.
Channel Source Controls

Use these buttons to select the waveform source (channel, math, or reference) before selecting a specific waveform channel using the channel select controls (see page 18). If you select MATH or REF, and no math or reference waveforms are stored in memory, the instrument opens the Define Math or Recall Reference waveform dialog boxes, respectively.

CH sets the waveform source to be from an installed module.
MATH sets the waveform source to be from waveforms stored in math memory locations 1-8.
REF sets the waveform source to be from waveforms stored in reference locations 1-8.

Channel Select Controls

These buttons enable display and selection of up to eight channels of waveforms per channel source (CH, Ref, or Math).

1. Push a channel source button (see page 18) to select a channel source.
2. To turn on a channel, push an unlit button.
3. To select a channel, push a green lit button to turn it amber. The front-panel vertical controls operate on selected (amber) channels.
4. To turn off a channel, push its button once if it is amber (already selected), or twice if it is green.

NOTE. If you select MATH or REF as a channel source, and no math or reference waveform is defined, the instrument opens the Define Math or Recall Reference dialog box.
Vertical Controls

Use these controls to set the vertical attributes of a waveform.

- **MENU** opens the Vertical Setup dialog box.
- **POSITION** changes the vertical position of the selected waveform.
- **OFFSET** changes the vertical offset of the selected waveform.
- **SCALE** changes the vertical scale of the selected waveform.

**The Difference Between Vertical Position and Offset**

Vertical position is a display function. Adjust the vertical position to place the waveforms where you want to see them. The waveform baseline locations track adjustments made to their positions.

When you adjust vertical offset you see a similar effect, but it is actually quite different. Vertical offset is applied at the module sampling circuit. Use vertical offset to change the effective dynamic range of the inputs.
Timebase View Controls

Use these buttons to select a timebase view for acquisition and display of channel waveforms.

- **MAIN** is the main instrument timebase acquisition and view mode. The instrument always displays the Main timebase.
- **Mag1** and **Mag2** are magnified views of a selected region of the main timebase view. The Mag1 and Mag2 views are not zoomed or interpolated versions of the Main timebase: they each have an independent acquisition cycle. Waveforms defined in the main timebase are automatically defined and acquired in the magnified timebases.

See [Horizontal timebase selector (see page 68)](#) for more information on selecting and setting multiple timebases.

Acquisition Controls

Use these buttons for quick access to the signal acquisition controls.

- **MENU** displays the Acquisition Setup dialog box.
- **CLEAR DATA** clears all previously acquired data. This includes live data, waveform databases, display persistence data, mask count data, histogram data, and measurement statistics. When using clock trigger sources, Clear Data forces re-synchronization of the timebase to clock source and frequency changes.
- **RUN/STOP** turns on and off the instrument signal acquisition. Use this button as you would the RUN/STOP button in the toolbar.
Horizontal (Timebase) Controls

Use these controls to set the instrument horizontal timebase parameters.

- **MENU** displays the Horizontal Setup dialog box.
- **POSITION** increases or decreases the horizontal position of the selected waveform.
- **RESOLUTION** increases or decreases the sample density (resolution) of all live waveforms in the selected timebase.
- **SCALE** increases or decreases the horizontal timebase scale of the selected waveform.
Trigger Controls

Use these controls to set trigger level and access other trigger controls on screen.

- **MENU** displays the Trigger Setup dialog box.
- **LEVEL** increases or decreases the trigger level setting for the Trigger Direct Input trigger source.
- **READY** shows that the instrument is ready (waiting) to trigger.
- **TRIG’D** shows that the instrument has triggered on a waveform.
- **SET TO 50%** sets the trigger level to 50% of the signal amplitude present on the Trigger Direct Input connector.
Utility Controls

The Utility controls give you convenient access to several features and utilities.

SETUP DIALOGS displays the Setup dialog boxes.

PRINT sends the display image to a printer or to an image file.

DEFAULT SETUP loads the factory default instrument settings. See To Restore the Default Instrument Setup (see page 24)

FINE toggles the General Purpose Knob between fine and coarse adjustments.

TOUCH SCREEN toggles the touchscreen on and off.

AUTOSET performs a signal autoset operation.

CURSORS cycles through and enables the following cursor types: vertical bars, horizontal bars, waveform, and off.

SELECT toggles the selected cursor.

General Purpose Knob adjusts values or advances through selections for controls that do not have a dedicated front-panel knob.

Instrument Settings Overview

You can enter or change instrument parameter values several different ways:

- Use a keyboard or keypad (external or on-screen) to enter a specific value in a field.
- Touch or click the increment/decrement buttons on a field to change to the next standard value.
- Touch or click a control or input field and use the general-purpose knob to scroll through available settings or increment numeric values. See Utility Controls (see page 23).
Restore Default (Factory) Instrument Settings

The following steps restore the instrument to its default (factory) settings. Restoring the instrument to a known state is useful when acquiring a new signal, or multiple people use the instrument, and you need to return the instrument to a known configuration.

1. To quickly, push the **DEFAULT SETUP** front-panel button.
2. Click **Yes** in the confirmation dialog box.

After you complete a task using your instrument, you may want to initialize the settings before you apply it to your next task. This may be especially important if you share the instrument with others; previous settings may make it difficult for you to do what you need to do.

Select and Display Waveforms

**From Front Panel Controls**

To use the front panel to select and display available waveforms:

1. Select the signal source from the **Vertical** section of the front panel:
   - **CH** to display a live signal channel waveform
   - **MATH** to display a math waveform
   - **REF** to display a stored reference waveform
2. Push the numbered button (1-8) corresponding to the waveform channel to display.

For example, to display the live channel 6 waveform, push front-panel buttons **CH** and **6**.

**NOTE.** If you have no math or reference waveforms defined when you push **MATH** or **REF**, the instrument opens the Define Math dialog box or Recall Waveform dialog box.

**From Setup dialog box controls**

Use the controls in the **Setup > Vertical** or **Setup > TDR** dialog boxes to display a waveform.

**NOTE.** Selecting a channel in the TDR dialog box enables the TDR mode for that module.
From the Waveform Display Area

- Click the Select Waveform button (lower left of UI) to display a list of all available waveforms (channel, reference, and math). Waveforms that are on, but not selected, have a check mark next to their name (C1 shown left). Selected waveforms have a triangle next to their name (C5 shown).
- Use the menu to select the waveform you want to make active (selected) (example shows M1 being selected).

Changing Modules Without Powering Down the Mainframe

The View/Change Module Config function lets you remove, install, or move modules in the instrument without powering down the mainframe.

⚠️ **CAUTION.** Installing or changing modules when powered on requires TekScope software version 6.1.X or greater. For TekScope software versions earlier than 6.1.X, always power off the mainframe to remove or install modules. Failure to do so may result in damage to the module or mainframe.

Download the latest DSA8300 software from www.tek.com/software.

1. Select **Utilities > View/Change Module Config** to open the module configuration dialog box.
2. Click on all module slots that you want to change. This includes slots from which to remove a module and slots in which to install a module.
3. Click **Start.** The instrument notifies you when you can remove or install a module.
4. Remove or install modules only from the indicated slots. Wear an antistatic strap when handling modules.
5. Click **Finish.** The instrument notifies you when the selected modules are ready to use.
6. Close the dialog box.

7. Select **Utilities > Compensation** and run a compensation on each channel of all newly installed modules. All newly installed modules require compensation, even if they were moved from one slot to another on the same instrument.

Data Acquisition Overview

Before you can take signal measurements you must set the instrument to acquire and display a signal. The first topic below provides an overview of how to acquire and display a live signal. The remaining topics provide more detailed information on signal and data acquisition.

Data Acquisition Topics:

- Acquire and Display a Signal (see page 26)
- Signal Conditioning and Scaling (see page 28)
- Trigger Background (see page 141)
- Mode/Trigger Setup Dialog Box Overview (see page 129)
- Math Waveforms Overview (see page 29)
- Waveform Databases Overview (see page 29)
- Waveform Measurement Introduction (see page 30)

Acquire and Display a Signal

The following procedure describes the basic steps to acquire and display a signal. Your signal type may require additional or different settings.

1. Connect the device under test (DUT) signals to the sampling modules.

   **CAUTION.** Sampling modules are very sensitive to ESD. Follow static-safe procedures and cautions as outlined in the sampling module user manual. Discharge electrical cable conductors before connecting to modules or the instrument.

   Sampling modules are very sensitive to overdriven signals. Do not overdrive instrument or module inputs.

2. If using an external trigger signal, connect the trigger signal to the **CLOCK INPUT/PRESCALE TRIGGER** or **TRIGGER DIRECT INPUT** connectors on the front panel.

3. Push the front panel **CH** button.
4. Push the front panel 1 through 8 button to select the module signal source. Repeated button pushing cycles through the source settings. The button color indicates the source status:
   - **Amber**: The signal source is selected. Measurements are done on the selected source.
   - **Green**: The signal source is displayed but not selected.
   - **No color**: The signal source is off.

5. Push the front-panel Trigger MENU button to open the Mode/Trigger dialog box.

6. Select a trigger source (Clock, TDR, Direct, or Free Run). Free Run auto-triggers the instrument and displays a non-synchronized waveform as a quick way to view signal presence.

7. From the menu bar, select **Utilities > Autoset Properties** and choose the Autoset Mode that matches your intended autoset result. Close the dialog.

8. If using the Clock Input/Prescale Trigger connector as the trigger source, select one of the available Scope Modes appropriate for your signal (Eye, Pattern, or Other). Pattern is available only if Advanced Trigger (Option ADVTRIG) has been purchased and installed.

9. Push the front-panel **AUTOSET** button (or click the Autoset button in the toolbar). The instrument displays the waveform.

**See Also:**
- Data Acquisition Overview (see page 26)
- Signal Conditioning and Scaling (see page 28)
- Trigger Background (see page 141)
- Mode/Trigger Setup Dialog Box Overview (see page 129)
- Math Waveforms Overview (see page 29)
- Waveform Databases Overview (see page 29)
- Waveform Measurement Tools (see page 30)
Signal Conditioning and Scaling Overview

Use **signal conditioning and scaling controls** to ensure that the instrument acquires the data that you want to display, measure, or otherwise process.

- Use the front-panel **VERTICAL** knobs to adjust the selected waveform vertical size, offset, and screen position.
- Use the front-panel **HORIZONTAL** knobs to adjust the horizontal size, resolution, and screen position of all waveforms.
- Push the Vertical or Horizontal front-panel **MENU** buttons to open the setup dialog boxes for those functions.

To ensure the best possible data for further processing, do the following:

- Set vertical scale to adjust the waveform size on screen. You can set vertical offset to shift the vertical acquisition window up or down on the signal to capture the part you want. The center of the module analog input dynamic range is shown by the channel waveform handle in the waveform handle region to the left of the graticule. For best results, use the vertical offset control to center the waveform around the waveform handle and then use vertical position control to graphically move the waveform up and down in the graticule.

- Set horizontal scale to control the time duration of the horizontal acquisition window to capture as much as you want of the input signal(s). To control where in the input signal (data stream) that the horizontal acquisition window acquires, you set horizontal position to delay the window relative to a trigger to capture the waveform part you want. To increase or decrease the resolution between sample points, change the record length.

See Also:

- Data Acquisition Introduction (see page 26)
- Acquire and Display a Signal (see page 26)
- Vertical Setup Dialog Box Overview (see page 147)
- Horizontal Setup Dialog Box Overview (see page 66)

The **Vertical Command Group** and **Horizontal Command Group** sections in the **DSA8300 Programmer Manual** (accessed from the instrument Help menu)
Math Waveforms Overview

You can create up to eight math waveforms to support the analysis of your channel and reference waveforms. By combining and transforming source waveforms and other data into math waveforms, you can derive the data view that your application requires. You can create math waveforms that result from:

- Mathematical operations on one or several waveforms or measurements: add, subtract, multiply, and divide.
- Function transforms of waveforms, such as integrating, differentiating, and so on.

Use the Define Math dialog box to create a math waveform expression. You can apply numerical constants, math operators, and functions to operands (which can be channel, waveforms, reference waveforms, measurement scalars, or fixed scalars). You can display and manipulate these derived math waveforms much like you can the channel and reference waveforms.

See Also:

- Define Math Dialog Box Overview (see page 189)
- Math Waveforms Background (see page 200)

The Math Command Group section in the DSA8300 Programmer Manual (accessed from the instrument Help menu)
- Data Acquisition Introduction (see page 26)

Waveform Database Overview

Use waveform databases to store measurements, histogram calculations, mask testing, and generating a density-style, graded display. Waveform databases may be automatically allocated for measurements, histograms, and mask testing.

In general, use the Wfm Database Setup dialog box to assign the four databases supported by the instrument to live (channel and math) waveform sources. Also, certain measurements require the uses of a waveform database and, when turned on, they will automatically set the measurement system to use a waveform database if available.

See Also:

- Waveform Database Background (see page 176)
- Wfm Database Setup Dialog Box Overview (see page 171)
- The Waveform Database Command Group section in the DSA8300 Programmer Manual (accessed from the instrument Help menu)
- Data Acquisition Introduction (see page 26)
Waveform Measurement Tools

This instrument offers several tools for measuring and characterizing waveform data. Measurement tools include:

- **Automatic Measurements (see page 30)**
- **Cursors (see page 31)**
- **Histograms (see page 33)**
- **Masks (see page 34)**
- **Optimize Measurement Accuracy (see page 35)**

Automatic Measurements

Auto measurements provide automatic extraction of various waveform parameters. Automated measurements quickly give you immediate, continuously updating measurement results such as rise time or extinction ratio. You can also display statistics on how the measurement results vary over time.

Most automatic measurements require both a source selection and a measurement selection. To quickly select a measurement, use the measurement toolbar to first set the signal type (NRZ, RZ, or Pulse), and then select a category (Amplitude, Timing, or Area) in the pulldown lists of the toolbar. Then click the icon of the measurement that you want to use to measure the selected waveform (or drag and drop the icon on any displayed waveform, selected or not, to measure that waveform). The results are shown in the measurements readout at the bottom of the screen.

Some features and requirements of the automatic measurement system follow:

- This instrument supports up to eight simultaneously displayed measurements.

- If the waveform parameter that is to be automatically measured cannot be acquired (incorrect control setup, out-of-range input signals), the instrument displays the indicator “???”.
  For example, if the instrument acquires less than a full waveform cycle, it cannot measure frequency or period, and, therefore, it displays “???”.
Except for Average Optical Power, all RZ and NRZ measurements must be performed on a waveform database.

The Average Optical Power measurement cannot use a waveform database as its source. The Average Optical Power measurement cannot display Annotations and cannot use gates or user-defined High/Low method.

See Also:
Automatic Measurements Overview (see page 108)
Measure Setup Dialog Box Overview (see page 98)
Automatic Measurements Reference Overview (see page 231)

Cursors

Use cursors to measure amplitude and time, distance, or bits quickly and with more accuracy than when using the graticule to take measurements. Because you position cursors wherever you want on the waveform, they are easier to localize to a waveform segment or feature than automatic measurements. The following table summarizes each cursor type.

<table>
<thead>
<tr>
<th>Cursor Type and readout</th>
<th>Description</th>
<th>Cursor readout</th>
</tr>
</thead>
</table>
| **Horizontal Cursors**  | - **Horizontal cursors** measure amplitude (volts, watts, ohms, rho). Each cursor measures with respect to:  
  - $v_1 =$ Level at Cursor 1 with respect to its source ground level  
  - $v_2 =$ Level at Cursor 2 with respect to its source ground level  
  - $\Delta v =$ Level at Cursor 2 - Level at Cursor 1  
  Level is cursor displacement from the source ground times the source scale (volts/div, watts/div, ohms/div, or rho/div). Note that the two cursors may have different sources and therefore can have different volts/div settings. |
|                         | **Cursors (Mn C5)** | $v_1=$ 204.9mV  
$v_2=$ 216.4mV  
$\Delta v=$ 4213mV |
**Vertical cursors** measure horizontal displacement (time in seconds or bits or distance in meters, feet, or inches). Each cursor measures with respect to:

- $t_1 =$ Time or distance at Cursor 1 with respect to the trigger point
- $t_2 =$ Time or distance at Cursor 2 with respect to the trigger point
- $\Delta t =$ Time or distance at Cursor 2 - Time or distance at Cursor 1

Time is divisions of displacement of the cursor from its source trigger point times the source time/div. Note that the two cursors may have different sources and, therefore, can have different time base (Main, Mag1, Mag2) settings.

**Waveform cursors** measure both amplitude and time. Each cursor is, in effect, both a vertical and horizontal cursor. As you set the horizontal position of each cursor, it measures the time with respect to the trigger point and the vertical level of the corresponding waveform point. You cannot move these cursors off the waveform.

Note that each cursor can have a different source, and, therefore, can have different vertical and horizontal scale settings.

---

**Enable cursors**

If cursors are off, first select (see page 30) the waveform on screen that you want to measure, then push the **Cursors** front-panel button:

- Once for vertical bar cursors
- Twice for horizontal bar cursors
- Three times for waveform cursors

**NOTE.** You cannot use waveform cursors on displayed waveform database signals.

Use the General-Purpose knob to adjust the cursors and the SELECT button to toggle control between the cursors. (You can also use the mouse to adjust the cursors.) Examine the cursor readout for measurement results.
The Cursor Command Group section in the DSA8300 Programmer Manual (accessed from the instrument Help menu).

Histograms

Use histograms to analyze a range of waveform data that you select. The instrument can display both vertical (voltage, watts, ohms, or rho) and horizontal (time, distance, or bits) histograms, but only one at a time.

You can use the controls in the Histogram Setup dialog box to completely specify the histogram box on the waveform, in waveform units or as a percent of the graticule. After creating the histogram box, you can use the same method to resize and reposition the box directly on the screen, or, for quick edits, you can use the mouse or touchscreen to drag the histogram box boundaries on screen to surround the data that you want to analyze.

See also:

Histogram Background (see page 64)
Histograms Setup Dialog Box Overview (see page 61)

The Histogram Command Group section in the DSA8300 Programmer Manual (accessed from the instrument Help menu).
Masks

Use **mask** testing to test your waveforms for time or amplitude violations. Mask testing detects waveform samples that occur within a specific area of the mask. These occurrences are called hits or violations.

Use the communications-standard masks that this instrument provides (SONET/SDH, Fibre Channel Optical and Electrical, Ethernet, and others) to test your signals, or you can define your own masks.

Use the Mask setup dialog box to specify your mask test. In general, you will choose a live waveform source (channel or math waveform), and then select a standard mask against which to test it. To completely specify a mask test, read the information sources below.

**See Also:**
- Mask Setup Dialog Box Overview (see page 86)
- Mask Edit Dialog Box (see page 94)

The *Masks Command Group* section in the *DSA8300 Programmer Manual* (accessed from the instrument Help menu)
Optimize Measurement Accuracy

Compensation optimizes the instrument to make accurate measurements based on the ambient temperature. Select **Utilities > Compensation** to open the Compensation dialog box.

**Guidelines**

- Instrument specifications are guaranteed after the instrument has been powered on for 20 minutes, given that the instrument has compensation data that is within the current operating temperature limits.

**NOTE.** *A soft reboot of the instrument resets the 20-minute power-on monitoring time even though the instrument has not been physically powered off.*

- Always run compensation when first installing a sampling module(s) or after moving a sampling module from one slot to another. You can run a compensation within the 20-minute warm-up time. However, the compensation status (as displayed in the compensation dialog) displays a “warm-up” status until the 20-minute warm-up time has elapsed. At that time, if the temperature at which the last compensation was performed is within limits of the current operating temperature, the status displays okay (or Pass).
- You must save the compensation results or they will be lost when the instrument is powered down.
- You can set the instrument to display the Compensation Indicator Button on screen, which tells you when the instrument or its modules require calibration and/or compensation, or when they are warming up.

**See Also:**

- **System Compensation Dialog Box Overview** (see page 211)
- The Compensation Command Group section in the **DSA8300 Programmer Manual** (accessed from the instrument Help menu)
Acquisition Setup Dialog Box Overview

Use this dialog box to set up the acquisition modes.

Key Features:
- Set acquisition mode (sample, average, or envelope)
- Set stop after event condition
- Set stop action the system takes upon completing acquisition

**TIP.** You can manually start and stop acquisition at any time by clicking the Run/Stop button in the toolbar or by pushing the front-panel Run/Stop button.

Control information:

- Acquisition Mode Settings (see page 37)
- Acquisition Stop After Settings (see page 38)
- Acquisition Stop Action Settings (see page 40)

Signal Acquisition Modes

Access this set of controls from the Acquisition Setup dialog box (**Setup > Acquire**).
The selected acquisition mode applies globally to all channels; for example, you cannot set channel 1 to Sample mode and channel 2 to Average mode.

- **Sample**: No post processing of acquired samples. Use Sample mode to see the signal in its purest form with no post processing.

- **Average**: The instrument processes the number of waveforms you specify into the acquired waveform, creating a running exponential average of the input signal. The instrument displays a point-wise running average of the n most recently completed waveform acquisitions, where you specify n. Use Average mode to reduce the uncorrelated noise and jitter in the signal to reveal fundamental waveform behavior.

- **Envelope**: Continuous acquisition; the instrument retains the running minimum (Min) and maximum (Max) values in adjacent sample intervals, creating an “envelope” of all waveforms acquired for that channel. You cannot select this mode if FrameScan is enabled (Setup > Mode/Trigger > Pattern Sync/FrameScan Setup). Use Envelope mode to show the variation of waveform extremes over time.

To average or envelope an individual waveform, use the Average or Min and Max functions to create a math waveform specific to the waveform you want to average or envelop. Click [here](#) (see page 189) to find more information on creating math waveforms.

**See Also:**
- [Acquisition Stop After Settings](#) (see page 38)
- [Acquisition Stop Action Settings](#) (see page 40)

**Acquisition Stop After Settings**

Use this control to specify when you want the instrument to stop acquisition. You can set only one active Stop After condition at a time.
Regardless of the Stop After condition selected, you can always stop acquisition with the RUN/STOP button from the front panel or toolbar.

- **Run/Stop Button Only**: Sets the instrument to stop the acquisition only when you click the Run/Stop button in the toolbar or push the RUN/STOP button on the front panel.

- **Condition**: Sets the instrument to automatically stop acquisition after the selected condition is achieved. Available stop after conditions are:
  
  - **Number of Acquisitions**: Sets the instrument to stop acquiring after some specified number of raw acquisition cycles. This setting tells the instrument to count the number of Main Timebase sweeps (Mag sweeps are not counted) and stop acquisition after the specified number of acquisitions.
  
  - **Average Complete**: Sets the instrument to stop acquisition after the specified number of waveforms to be averaged is acquired.
  
  - **Histogram Waveforms**: Sets the instrument to stop acquisition after a specified number of Histogram source waveforms is acquired.
  
  - **Histogram Hits**: Sets the instrument to stop acquisition after it acquires a specified number of valid hits (that is, non-null samples) in the histogram region. This is a $\geq$ condition.¹
  
  - **Mask Waveforms**: Sets the instrument to stop acquisition after a specified number of waveforms is acquired of the Mask source waveform.
  
  - **Mask Samples**: Sets the instrument to stop acquisition after a specified number of valid (that is, non-null) waveform samples are acquired of the Mask source waveform. This is a $\geq$ condition.¹
  
  - **Mask (n) Hits**: Sets the instrument to stop acquisition after a specified number of mask hits occur in mask number (n). This is a $\geq$ condition.¹
  
  - **Mask Total Hits**: Sets the instrument to stop acquisition after a specified number of total mask hits occurs in all masks combined. This is a $\geq$ condition.¹
  
  - **FrameScan Cycle**: Sets the instrument to stop after it has acquired the number of bits specified in the Scan Bits control in the FrameScan section of the Horizontal Setup dialog box (that is, stop after one FrameScan cycle).

¹ Histogram hits, Mask Samples, Mask (N) Hits, and Mask Total Hits are $\geq$ (greater than or equal to) conditions because only complete records are processed. Therefore, the number of actual samples or hits will not necessarily match your requested number of samples or hits, as the acquisition will stop when the number of samples or hits is greater than the number specified.

**See Also:**

*Acquisition Stop Action Settings (see page 40)*
Acquisition Stop Action Settings

Use these controls to direct the instrument to print the display or to save waveforms upon stopping acquisition, and to specify directories and files in which to save. All selections remain in effect until you change them.

The instrument takes the selected action only when the Stop After condition is met or when you stop the acquisition by pressing the RUN/STOP control or front-panel button. It does not take action when acquisition stops due to other factors, such as loss of a trigger.

The Stop After actions are:

- **None**: Specifies that the instrument stops acquisition with no further action.
- **Print screen to file**: Prints the screen image as a bitmap (.BMP) file to a specified file location. Enter the filename you want in the Filename field. Click Browse to display the Open dialog box in which you can select a file location.
- **Print screen to printer**: Sends the screen image to the default printer. Use the Print dialog box to set the default printer.
- **Save all waveforms**: Saves all waveforms to a specified file.
- **Ring Bell**: Sets the instrument to emit a tone (beep) when the Stop After action completes. You must connect a speaker to the Line Out connector on the back of the instrument to hear the tone.

Acquisition Background

Use the **acquisition** features to optimize and tailor the acquisition of your waveforms. The acquisition modes described here operate on the data as the instrument acquires it—perhaps to reduce noise in the waveform record, or to capture a record of min/max values for each data point in the waveform record. The acquisition features also let you start and stop acquisition, and take certain actions after acquisition stops, such as to print the acquired waveform.
Acquisition modes include:

- **Stop After options**: You can set the condition upon which acquisition stops, such as after several acquisitions or a specified number of mask hits. You can set the Stop After action to have the instrument save waveforms or print the screen to a file or printer.

- **FrameScan acquisition**: You can change the normal acquisition cycle to produce a waveform record suitable for acquiring and analyzing repetitive patterns that are contained within a repeating data frame. See FrameScan Overview (see page 82) for more information on FrameScan acquisitions.

- **FrameScan and Envelope modes**: You cannot use Envelope acquisition mode with FrameScan acquisitions; you must use Sample or Average modes.

See Also:

- Acquisition Key Points (see page 41)
- Acquisition Sampling Process (see page 43)

**Acquisition Key Points**

Consider the acquisition mode that you want to use to acquire data:

- **Sample**: the instrument does no post-processing of acquired samples.

- **Average**: the instrument processes the number of waveforms you specify into the acquired waveform, creating a running exponential average of the input signal.

- **Envelope**: the instrument retains the running minimum (Min) and maximum (Max) values in adjacent sample intervals continuously, as subsequent waveforms are acquired, creating an envelope of all waveforms acquired for that channel.

Acquiring and displaying a noisy square wave signal shows the difference between the three modes. Note how Average reduces the noise while Envelope captures its extremes:
Controls-specific help

Acquisition Key Points

Once the waveform record exists (regardless of mode in which acquired), you can use the post-processing capabilities of the instrument to further process that record: perform measurements, waveform math, mask tests, and so on. Also, consider how you want to control acquisition; you have two main options, either settable from the Acquisition Setup dialog box (push Acquisition MENU to display):

- **Run/Stop Button Only**: Sets the instrument to start and stop the acquisition only when you use the Run/Stop button, which is available on the front panel or in the application toolbar. If toggled to Run, acquisition starts when a valid trigger occurs. If toggled to Stop, acquisition stops immediately.

- **Condition**: The stop-after control provides additional conditions you can select to stop an acquisition.

**Global controls**

Like the horizontal controls, the acquisition controls apply to all active channels. For example, channel 1 cannot acquire in Sample mode while channel 2 acquires in Envelope mode; you cannot stop channel 8 from acquiring (if turned on) while other channels continue to acquire. Unlike horizontal controls, acquisition settings extend across time bases: you cannot set a different sample mode for channels acquired in the Mag1 time base; the sample mode you set extends across the Main, Mag1 and Mag2 time bases.

**Preventing aliasing**

Under certain conditions, a waveform may be aliased on screen. When a waveform aliases, it appears on screen with a frequency lower than that of the input signal or it appears unstable even though the TRIGD light is lit. Aliasing occurs because the instrument sample interval is too long to construct an accurate waveform record (see the following figure).

To quickly check for aliasing, adjust the horizontal scale to a faster time per division setting. If the shape of the displayed waveform changes drastically or becomes stable at a faster time base setting, your waveform was probably aliased. You can also try pressing the AUTOSET button to eliminate aliasing.
To avoid aliasing, be sure to set resolution so that the instrument samples the input signal at a rate more than twice as fast as the highest frequency component. For example, a signal with frequency components of 500 MHz would need to be sampled with a sample interval less than 1 nanosecond to represent it accurately and to avoid aliasing.

**Acquisition Sampling Process**

Before a signal is acquired, it must pass through the input channel where it is sampled and digitized. Each channel has a dedicated sampler and digitizer as shown in the following figure; each channel produces a stream of digital data from which you can extract waveform records. See [Vertical controls background](#) for a discussion of waveform scaling, positioning, and DC offsetting of channels.

**Acquisition Hardware**

Number of channels depends on sampling modules installed

![Diagram of acquisition hardware](image)

**Sampling**

Acquisition is the process of sampling an analog input signal of an input channel, converting it into digital data, and assembling it into a waveform record, which is then stored in acquisition memory. Sampling, then, is the process that provides one sample per trigger event and, when taken from repeated trigger events, also provides the digitized signal data from which the instrument assembles the waveform record (described below). The signal parts within the vertical range of the sampler are digitized. See the following figure.
Waveform Record

While sampling the input signal provides the data that makes up the waveform record for any given channel, the instrument builds the waveform record through use of some common parameters (“common” means they affect the waveforms in all channels).

The following figure shows how these common parameters define the waveform record; as shown in the figure, they define where in the data stream data is taken and how much data is taken. Locate the following parameters in the figure:

- **Sample Interval.** The precise time between sample points taken during acquisition.
- **Record Length.** The number of samples required to fill a waveform record.
- **Trigger Point.** The trigger point marks the time zero in a waveform record. All waveform samples are located in time with respect to the trigger point.
- **Horizontal Delay.** The time lapse from the trigger point to the first sample taken (first point in the waveform record). It is set indirectly by setting the horizontal position (see Horizontal timebase position (see page 71))

As the figure shows, the instrument acquires points in order from left to right, with each point from a separate trigger event, and delayed from that event by:

\[
\text{horizontal delay} + (\text{sample interval} \times (\text{sample number} - 1))
\]

When all the points in the waveform record have been sampled and digitized, the waveform record is placed in acquisition memory and becomes available for display (or for use in math waveforms, storing, exporting, and elsewhere). See Acquisition Cycle, which follows.
Acquisition Cycle

The process of building a record is a subpart the acquisition cycle, which describes how the instrument cycles through recognizing a trigger, taking a sample and processing it according to sample mode, and adding it to a waveform record. Note the following points regarding acquisition cycles:

- A waveform record exists, either on display or as an icon on the waveform bar, until it is replaced by a more recent acquisition or until you clear the record.

- FrameScan mode alters the normal acquisition cycle. Choose the FrameScan cycle when you want to test for anomalies in repetitive data streams.

Cursor Setup Dialog Box Overview

Use this dialog box to set up the cursor 1 and cursor 2 parameters. Access this tab from Setup > Cursor.

Key Features:

- Set cursor function
- Set individual cursor characteristics

See Also:

- Cursor function settings (see page 46)
- Cursor 1 and 2 settings (see page 47)
Cursor Function Settings

These controls set the type of cursor to use for taking measurements. Access these controls in the Setup > Cursor dialog box.

Function

- Off
- Vertical Bars
- Horizontal Bars
- Waveform

Available cursor types are:

- **Off**: Disables (turns off) the display of all cursors.
- **Vertical Bars**: Displays vertical bar cursors, which provide traditional horizontal unit readouts for Cursor 1 (bar1), Cursor 2 (bar2), the delta between them, and 1/delta (results in frequency when the horizontal unit is time).
- **Horizontal Bars**: Displays horizontal bar cursors, which provide traditional vertical unit readouts for Cursor 1 (bar1), Cursor 2 (bar2), and the delta between them.
- **Waveform**: Displays vertical bar cursors with marks where they cross a waveform, which track the waveform points, providing both vertical and horizontal coordinates for the waveform point where they cross.

See Also:

- Cursor 1 and 2 settings (see page 47)
- Cursor background (see page 47)
Cursor 1 and 2 Settings

Access these controls in the cursor setup dialog box.

**Cursor 1**

- **Source**: Selects the waveform you want associated with a cursor. All available waveforms are displayed as selections in this control.
- **Position**: Sets the position of the cursor. You can also use the front-panel general-purpose knob to adjust this setting when this dialog box is the focus and no other setup dialog boxes are displayed. You can also use the mouse to select and move the cursors.
- **Color**: Selects a color for the cursors.

Use these controls to set the source, position, and color of Cursor 1 or 2.

- **Source**: Selects the waveform you want associated with a cursor. All available waveforms are displayed as selections in this control.
- **Position**: Sets the position of the cursor. You can also use the front-panel general-purpose knob to adjust this setting when this dialog box is the focus and no other setup dialog boxes are displayed. You can also use the mouse to select and move the cursors.
- **Color**: Selects a color for the cursors.

**See Also:**
- Cursor function settings (see page 46)
- Cursor background (see page 47)
- Cursor units (see page 50)

Cursor Background

Use **cursors** to measure waveform characteristics at specific locations on a waveform. Vertical cursors measure time, bits, or distance on screen; horizontal cursors measure amplitude: voltage, watts, rho, or ohms; and waveform cursors measure both. Cursors can measure channel, reference, and math waveforms.

Cursor guidelines:
- Set the source of each cursor (which waveform it is measuring) in the Cursor Setup dialog box.
- The cursor selected for adjustment is the solid cursor.
- You cannot move a cursor off screen; they are limited to the edges of the display screen.
- Vertical and horizontal cursors do not track the waveform when you change the horizontal scale, vertical scale, signal position or vertical offset. However, waveform cursors track the waveform point vertically; they work differently than vertical and horizontal cursors.
Controls-specific help

- Cursors default to measure the selected waveform. Each cursor measures its source, defined in the Cursors Setup dialog box. Note the following behavior regarding source selection:
  - When cursors are first turned on, the instrument automatically assigns them to the selected waveform. Up to the time that you turn cursors on, you can select a waveform on screen to use it as the source for the cursors.
  - Once cursors are on, selecting a different waveform does not change the source the cursors measure. To change the source while cursors are on, you must change the source in the Cursors Setup dialog box.
  - When cursors are first turned on, the instrument automatically assigns them to the selected waveform. Up to the time that you turn cursors on, you can select a waveform on screen to use it as the source for the cursors.
  - Turning cursors off restores the default cursor source assignment so that assignment again tracks the selected waveform.

- Cursors can measure between different sources. Each cursor can measure a different, independent source, with each source having its own amplitude scale and time scale. Consider the following example:

  Cursor 1 is set to measure channel 3 (C3), which is set to 100mV/div, so the cursor readout v1 measures C3 relative to its ground as 3 divisions x 100mV/div, or about 300 mv.

  Cursor 2 is set to measure reference 1 (R1), which is set to 20 mV/div, so the cursor readout v2 measures R1 relative to its ground as 3 divisions x 20mV/div, or about 60 mv.

  Note that the value of each graticule division, relative to the delta readout, is not readily apparent because the delta-amplitude readout (v) must account for the different amplitude-scale settings of the sources. To do so, the v readout displays the results of v2 - v1 (-60 mv - 300 mv = -240 mv), automatically accounting for the different scales of the cursor sources.

- Time readouts behave similarly with regard to different sources with different time bases. Each cursor displays its time readout, t1 or t2, with respect to the time base of its source, and Δt is calculated as t2 - t1, automatically accounting for any difference in the time base of each cursor source.

- If a cursor readout does not seem correct, check the source of each cursor in the Cursor Setup dialog box. Each cursor readout relates to the amplitude and time base settings of their source.

Vertical cursors measure from the trigger point (except when horizontal units are bits)

Remember that each vertical cursor measures the time from the trigger source to itself. The following figure shows this relationship, indicating the components determining time cursor readout values.
A vertical cursor readout (t1 or t2) includes and varies directly with the time-to-first-point component, which varies directly with the horizontal position set for the time base used by the cursor-source waveform. To see the amount of time to the first point, push Horizontal Menu on the front panel and set Horizontal Ref to 0% in the dialog box that displays. Now the horizontal position readout shows the time to first point, and subtracting this value from the cursor readout yields the cursor position on screen relative to first point. (You can find the horizontal readout both in the dialog box and in the control bar at the bottom of the screen.) The following relationships are true:

- Time to First Point = Horiz Position (when Horiz Ref Position is set to zero)
- t1 or t2 readouts = Time to First Point + Additional Time to Cursor

**See Also:**

- Cursor function settings (see page 46)
- Cursor units (see page 50)
## Cursor Units

Cursor units depend on the signal being measured. A cursor that measures amplitude or time will read out in the units of its source as indicated in the Cursor Units table that follows. If the measured v1/v2 or t1/t2 units do not match, the $\Delta v/\Delta t$ readout is UNDEFINED.

<table>
<thead>
<tr>
<th>Cursor</th>
<th>Standard units</th>
<th>Readouts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal</td>
<td>volts, watts, ohms, rho</td>
<td>v1, v2, $\Delta v$</td>
</tr>
<tr>
<td>Vertical</td>
<td>seconds, bits, meters, feet, inches</td>
<td>t1, t2, $\Delta t$, 1/$\Delta t$ (time)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>b1, b2, $\Delta b$, 1/$\Delta b$ (bits)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>d1, d2, $\Delta d$, and $\Delta d/2$ (distance)</td>
</tr>
<tr>
<td>Waveform</td>
<td>volts, watts, seconds, bits, ohms, rho, meters, feet, inches</td>
<td>v1, v2, $\Delta v$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>t1, t2, $\Delta t$, 1/$\Delta t$ (time)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>b1, b2, $\Delta b$, 1/$\Delta b$ (bits)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>d1, d2, $\Delta d$, $\Delta d/2$ (distance)</td>
</tr>
</tbody>
</table>

### See Also:

[Cursor function settings (see page 46)](#)
[Cursor Background (see page 47)](#)

## Display Setup Dialog Box Overview

Use the Setup > Display dialog box to set up the waveform display and graticules type.
Key Features:
- Set waveform display style (normal or persistence mode)
- Set normal waveforms to display as dots or vectors (lines) between data points, and set the vector interpolation method
- Set graticule characteristics (style, background color, and foreground color)

See Also:
- Display style settings (see page 51)
- Display graticule settings (see page 53)

Display Style Settings

Style controls specify displaying waveforms as vectors or dots, interpolation between data points, and waveform persistence (variable persistence or infinite.) Access these controls in the Setup > Display dialog box.

The selected display mode affects all displayed waveforms, except those that are displayed in waveform database format. For example, you cannot set channel 1 to display in Normal mode and channel 2 in Variable Persistence mode.
The display modes are:

- **Normal**: Sets the instrument to replace the previously acquired waveform in the display as it acquires or processes a new waveform.

- **Variable Persistence**: Sets the instrument to accumulate samples from each waveform it collects on screen for a specific time interval (the persistence aging time). The persistence aging time (Variable Persistence Rate) ranges from 200 ms to 10 s. The control varies this setting in increments of 100 ms from 200 ms to 1 s, and in 0.5 s increments from 1 s to 10 s. You can set any value to ±0.5 ms using the keyboard.

- **Infinite Persistence**: Sets the instrument to accumulate and continue displaying indefinitely all samples it collects for each waveform over time. Sample points are not removed until you reset the acquisition in any way (including using the Clear Data front-panel control, dragging a waveform to a new position, or changing its vertical position), or you change the display style.

### Vectors and Interpolation

For Normal display mode only, you can set the instrument to draw vectors between displayed waveform points or display only sample points as dots.

For Normal display mode with record lengths < 1000, independent of the dots/vectors selection, you can set the instrument to interpolate. With interpolation on and acquisition record lengths < 1000 points, the instrument increases the sample density on the waveforms it displays by calculating intermediate points between those sampled. Choose one of the following Interpolation display algorithms:

- None (default)
- Sin (X)/X
- Linear

**NOTE.** Interpolated points are displayed dimmer than actual acquired samples.
Display Graticule Settings

Access these controls in the Display Setup dialog box. Graticule controls specify the style, background color, and foreground color of the graticule.

Use the controls in this section of the Display Setup dialog box to set the graticule style, background color, and foreground color.

The graticule settings are:

- **Style**: Selects the graticule style: Frame, Grid, Cross Hair, or Full graticules. Choose Full or Crosshair for ease in making graticule measurements; choose Frame or Grid for minimum clutter on screen.

- **Background**: Selects the graticule background color. The default color is black.

**NOTE.** Choosing a background color that matches the color of a waveform or any on-screen readout, cursor, or other on-screen element will mask (hide) the display of that element.

- **Foreground**: Selects the graticule foreground color. The default color is silver.

See Also:

Display style settings (see page 51)

Waveform Display Elements

The following figure identifies the various elements of the waveform display.
1. **Waveform display**: The area where the waveforms appear. The display comprises the time bases and graticules, the waveforms, masks, histograms, and readouts.

2. **Graticule**: The grid marking the display area of a view. Each graticule is associated with its time base.

3. **Upper and lower amplitude-limits readouts**: The upper and lower boundary level of the graticule for the selected waveform.

4. **Horizontal-scale readout**: The horizontal scale of the selected waveform.

5. **Horizontal reference**: Shows the point around which channel waveforms expand and contract horizontally on screen as you change the Horizontal Scale control.

6. **Preview**: A label that displays when all waveforms are being previewed (that is, displaying an approximation of the waveforms as they will appear when acquisition completes). This indicator may appear when you change acquisition controls.

7. **Main, Mag1, and Mag2 views**: Selectable objects displaying on screen in the display, each with its own display of any waveform that is turned on. A view is a representation of a signal on an associated time base – the Main time base with the Main view, which is always displayed, or one of the two Mag views, each with its own time base and graticule. You can enable or disable display of the Mag views. You can display up to three views on screen (Main plus Mag1 and Mag2) at the same time.

**See Also:**

- Display features (see page 61)
- Mouse and touchscreen operation comparison (see page 17)
- Waveform display key points (see page 55)
- Display settings (see page 59)
Waveform display persistence (see page 60)

Waveform Display Key Points

Waveform display

In general, the method of displaying a waveform is to define the waveform, and then turn it on.

Operations on selected waveforms

Select the waveform using the Vertical source and channel selection buttons, and then adjust it using the Vertical Scale, Offset, and Position knobs.

The following tables summarize the control operations you can perform for the three waveform control parameters.

Table 2: Vertical controls

<table>
<thead>
<tr>
<th>Control</th>
<th>CH</th>
<th>MATH</th>
<th>REF</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Scale</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>The vertical controls adjust the selected waveform.</td>
</tr>
<tr>
<td>Vertical Position</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Vertical offset is unavailable for channels with ohm or rho measurement units or for math or reference waveforms.</td>
</tr>
<tr>
<td>Vertical Offset</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Table 3: Horizontal controls

<table>
<thead>
<tr>
<th>Control</th>
<th>CH</th>
<th>MATH</th>
<th>REF</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal Scale</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>All channel waveforms are adjusted globally in the selected time base.</td>
</tr>
<tr>
<td>Horizontal Position</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Math waveforms are not adjusted because their horizontal parameters are derived from their source(s). Reference waveforms are not adjusted because they have fixed horizontal parameters determined at the time the waveform was saved.</td>
</tr>
<tr>
<td>Horizontal Resolution</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
Table 4: Other controls

<table>
<thead>
<tr>
<th>Control</th>
<th>CH</th>
<th>MATH</th>
<th>REF</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic measurement source selection</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Measurements, if selected from the Measurements toolbar, use the selected waveform as the source.</td>
</tr>
<tr>
<td>Cursor automatic target selection</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>If cursors are off, pushing the front panel CURSOR button sets the selected waveform as the cursor measurement source.</td>
</tr>
<tr>
<td>Quick horizontal scale adjust (Zoom)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Dragging a box around a portion within the Main, mag1, or mag2 timebase graticules and clicking on zoom adjusts the horizontal scale to fill the screen with the boxed portion of the graticule.</td>
</tr>
</tbody>
</table>

Graticules

One graticule is displayed for the Main time base, and an additional graticule is displayed for each Mag time base that you turn on. The elements (see page 53) of the time base graticules are the same for each time base displayed.

Using multiple views

The methods of displaying (turning on) and selecting any time base view follow:

- Turn the view on: Push the Mag1 or Mag2 front-panel button once to turn on the Mag1 or Mag2 time base. The Main view is always (displayed); you cannot turn it off. Turning on a time base makes it active (selects it for adjustment).
- Select among displayed views: Push any time base view button to make it the active, selected time base. The button of the selected view is always lit amber.
- Turn off the selected Mag view: Once selected, Push the Mag1 or Mag2 button to turn off the time base. The Main time base becomes the selected time base.

Operations on the selected time base view

The method of adjusting (horizontal scaling and positioning, setting resolution/record length, and so on) is from the front panel: select the time base using the Horizontal time base selection buttons, and then adjust it using the Horizontal Scale, Resolution, and Position knobs. Only channel waveforms can have their horizontal parameters set directly.

The table above shows how horizontal operations relate to the waveform types; the key points to remember are:

- As the table shows, horizontal operations affect all channel waveforms, but in the selected view only. For example, you can select each time base in turn and set one horizontal scale for all channel waveforms in the Main view, another horizontal scale for those in the Mag1 view, and a third for those in the Mag2 view.
- The instrument displays a reference waveform using the horizontal settings in effect at the time it was saved. You cannot change these settings.
- The instrument displays a math waveform using the horizontal settings derived from its math expression. You cannot change these settings.

- All waveforms in each time base are displayed fit-to-screen; that is, within the full 10 horizontal divisions that the graticule provides.

**Waveform operations that cross time base views**

Unlike the horizontal controls just described, some controls apply to all time base views:

- Turning a waveform on or off in any view displays or removes it from all views.
- Selecting a waveform in any view makes it the selected waveform in all views; for example, select C1 in Main, and then select Mag1. C1 is the selected waveform in Mag1. Turn on Mag2, and Mag2 displays on screen with C1 selected
- Vertical adjustments on a waveform in any time base adjust the waveform in all time bases.

**Display controls versus acquisition controls**

For channel waveforms, the vertical offset control and the horizontal controls adjust the instrument acquisition parameters as well as affect the display. See the following descriptions for more information about acquisition:

- **Vertical Acquisition Window Considerations (see page 163)**
- **The Horizontal Acquisition Window (see page 79)**

**Mag1 and Mag2 are magnifying timebases**

The Mag1 and Mag2 time bases are so named because they magnify a segment of the Main time base. Mag1 and Mag2 timebases cannot be set to a slower horizontal scale than that of the Main timebase.

- Each Mag time base scale sets the size of an aperture on the Main time base
- Each Mag time base position setting locates the aperture within the Main time base.
- Each Mag time base graticule displays the selected area across the full horizontal display width (10 divisions).

**Horizontal position and the horizontal reference**

The horizontal position that is set and read from the user interface is measured from one of two points in time:

- If the horizontal units are time or distance (meters, feet, or inches), horizontal position is measured from the trigger point to the horizontal reference point.
- If the horizontal units are bits, horizontal position is measured from the Time of First Point to the horizontal reference point (i.e. the time of first point is set to bit 0.0).
In either case, the horizontal position is not equal to the Time of First Point unless you set the horizontal reference to 0%. See the following figure.

**Horizontal units**

You can specify the time values in seconds, bits or distance from the Horizontal Setup dialog box. When you select Bits or Distance as the timebase units, the timebase scale and position controls and the readouts show bits or distance units. You can select from meters, feet, or inches as your distance unit. The timing measurement results remain as seconds.

The Units Setup dialog box also provides Dielectric Const(ant) and Prop(agation) Velocity controls with which you can select either the effective dielectric constant of the device under test or its propagation velocity (they interact, so set one or the other). Distance units and these other two controls are useful when doing TDR measurements and testing. You may want to turn on distance units and set the dielectric constant or propagation velocity when making such measurements. The formula is:

\[ D = V_p T \]

where:

- \( V_p = \) propagation velocity
- \( T = \frac{C_o}{\text{Square root of Dielectric Constant}} \)

Velocity of propagation (\( V_p \)) is a measure of how fast a signal travels in that transmission line. Dielectric Constant is the relative effective dielectric constant of the propagation media.
## Display Settings

Use the display customizing functions to set display color, graticule style, waveform representation, and so on. The table that follows lists display attributes that you can set and where they are accessed.

<table>
<thead>
<tr>
<th>Display attribute</th>
<th>Menu path</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graticule style</td>
<td>Setup &gt; Display</td>
<td>Full, Grid, Cross-hair, Frame</td>
</tr>
<tr>
<td>Display mode</td>
<td>Setup &gt; Display</td>
<td>Normal, Infinite, Variable</td>
</tr>
<tr>
<td>Show vectors (normal display mode only)</td>
<td>Setup &gt; Display</td>
<td>Enable/Disable drawing vectors (lines) between sample points</td>
</tr>
<tr>
<td>Waveform labels</td>
<td>Utilities &gt; Waveform Properties</td>
<td>Create a label for the selected waveform</td>
</tr>
<tr>
<td></td>
<td>Right-click on waveform (or the waveform handle) &gt; Properties</td>
<td></td>
</tr>
<tr>
<td>Waveform colors</td>
<td>Utilities &gt; Waveform Properties</td>
<td>Select colors for waveforms</td>
</tr>
<tr>
<td></td>
<td>Right-click on waveform (or the waveform handle) &gt; Properties</td>
<td></td>
</tr>
<tr>
<td>Hide / Show Waveform</td>
<td>Right-click on waveform (or waveform handle) &gt; Properties</td>
<td>Select (or unselect) Show to display (or hide) the selected waveform in the current graticule (Main, Mag1 or Mag2)</td>
</tr>
<tr>
<td>Cursor color</td>
<td>Setup &gt; Cursors</td>
<td>Select colors for cursors</td>
</tr>
<tr>
<td>Graticule color</td>
<td>Setup &gt; Graticule</td>
<td>Select colors for graticules</td>
</tr>
<tr>
<td>Histogram color</td>
<td>Setup &gt; Histogram</td>
<td>Select colors for histograms</td>
</tr>
<tr>
<td>Mask color</td>
<td>Setup &gt; Mask Tests</td>
<td>Select colors for masks</td>
</tr>
<tr>
<td>Waveform color grading</td>
<td>Right-click on waveform &gt; Color Grade</td>
<td>Display waveform with color gradation based on frequency of occurrence</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Waveform Display Persistence

Use display persistence to control how the waveform data decays over time. Persistence style applies to all waveforms except for reference waveforms and channel waveforms set to display with color or intensity grading.

- **Normal style**: Displays waveforms without persistence. Each new waveform record replaces the previously acquired record for a channel. You can choose to display normal waveforms as vectors, which displays lines between the record points, or dots (vectors off) which displays the record points only. You can also choose an interpolation mode. See Interpolation below.

- **Variable Persistence**: Accumulates the waveform-record points on screen and displays them for a specific time interval. The oldest waveform data continuously fades from the display as new waveform records acquire.

- **Infinite Persistence**: Accumulates the data record points until you change some control (such as scale factor) or explicitly clear the data, causing the display to be erased. Waveform data builds up as new data records acquire.

See Also:

[Waveform Display Data Point Interpolation (see page 60)]

Waveform Display Data Point Interpolation

For record lengths of less than 1000 points, you can choose to have the instrument interpolate between the sampled points it acquires. Interpolation affects the display only; mask testing, histograms, and automatic measurement results are based on acquired, not interpolated, data. There are three options for interpolation:

- **Sin(x)/x interpolation**: Calculates record points using a curve-fit between the actual values acquired. The curve-fit assumes all the interpolated points fall along that curve. Sin(x)/x interpolation is particularly useful when acquiring more rounded waveforms, such as sine waves. Sin(x)/x interpolation may introduce apparent overshoot or undershoot in signals with fast rise times.

- **Linear interpolation**: Calculates record points between actual acquired samples by using a straight-line-fit. The straight-line-fit assumes all the interpolated points fall in their appropriate point in time on that straight line. Linear interpolation is useful for many waveforms such as pulse trains.

- **None**: Turns interpolation off. Only points actually sampled appear in the displays of waveform records.

See Also:

[Waveform Display Persistence (see page 60)]
Display Features

- **Flexible display control**: Front-panel knobs and buttons support quick access to the most often used adjustments; those that display, position, and scale waveforms. Mouse, keyboard, and touchscreen interfaces support complete setup of all the display parameters.

- **Multiple timebase views**: Three views, Main, plus Mag1 and Mag2, can be displayed simultaneously, each with its own time base. Live waveforms are acquired independently in each time base (C1 in Main is a different waveform than C1 in Mag1 or Mag2).

- **All displayed waveforms are shown in all views**: If C1 and M1 are displayed in Main, they also appear in Mag1 and Mag2 if you display those views. Reference waveforms will appear in all views as well, but since they have a static time base setting (the time base setting with which they were saved), they will be identical in all views. You can hide individual waveforms in a time base view by right-clicking on the waveform or waveform handle in that view and clearing the “show” field. Similarly, you can un-hide a hidden signal in any time base view by right-clicking on a waveform handle in that view and selecting the “show” field.

- **Fast Zoom capability**: Waveform inspection has never been easier. Just click and drag a box around the feature of interest and it zooms horizontally to fill the screen, reacquired at a higher resolution.

- **Preview mode**: The instrument automatically uses a preview display when control changes initiate reacquisition of waveform data. A preview display shows how the waveforms will look when acquisition completes. When the instrument finishes the processing of state changes, it removes the preview and displays the actual waveforms.

- **Waveform color grading**: You can select color grading of a waveform so that its data color or intensity reflects the frequency of occurrence of the data.

---

**NOTE.** When the acquisition system is stopped, the data will not update on screen until acquisition is restarted

---

Histograms Setup Dialog Box Overview

Use this dialog box to set up and display a histogram from an acquired waveform. Access these controls from **Setup > Histogram**.
Key features:

- Display a histogram of vertical or horizontal values for any channel, math, or reference waveform
- Adjust the limits of the box that defines the area on the display to compute the histogram
- Create a linear or logarithmic plot of histogram data
- Set the histogram plot size and color

The instrument displays a box around the waveform segment from which the histogram is created. It then displays results as two components:

- An on-screen plot of the distribution, or binning, of accumulated waveform data
- A readout of the statistical measurements for the histogram data

See Also:

- Histogram statistics (see page 66)
- Histogram source settings (see page 62)
- Histogram display options (see page 63)
- Histogram limit controls (see page 64)

Histogram Source Settings

Use these controls to select a histogram source, set the mode, and set waveform database usage settings. Access these controls from Setup > Histogram.

You can use any waveform entity as the source of waveform data for a histogram.

- **Source**: Use the Source pulldown list to select a waveform source.
- **Enable Histogram**: Displays the histogram.
**Controls-specific help**

- **Vertical/Horizontal**: Display a vertical or horizontal histogram.

- **Use Wfm Database**: Specify whether you want to take histograms on live data (check box not selected) or on a waveform database (check box selected).

- **Clear Data**: Resets all histogram results and restarts histogram data acquisition.

**NOTE.** If you select a waveform source that already has a waveform database associated and displayed with it, the instrument immediately creates the histogram data and statistics from the existing waveform database.

**See Also:**
- Histogram display options (see page 63)
- Histogram limit controls (see page 64)
- Histogram statistics (see page 66)

---

**Histogram Display Options**

Use the histogram display options to set histogram display options, including size, color, and whether the histogram display is set to be linear, logarithmic, or off. Access these controls from **Setup > Histogram**.

![Histogram Display Options](image)

- **Histogram**: Enables or disables displaying the histogram on the graticule. Histogram measurements (in the readouts area) will continue to update while the histogram is not displayed.

- **Color**: Selects a color for the displayed histogram data and boundary area.

- **Linear**: Specifies that bin counts smaller than the maximum be scaled linearly by dividing the bin count by the maximum bin count.

- **Logarithmic**: Specifies that bin counts smaller than the maximum be scaled logarithmically (log (bin-count)) with log(0) staying at 0 baseline). The base of the log does not matter since logs to different bases differ only by a constant multiplier. Logarithmic scaling provides better visual detail for bins with low counts.

- **Size**: Scales the size of the displayed histogram data by the selected multiplier value.

**See Also:**
- Histogram source settings (see page 62)
- Histogram limit controls (see page 64)
- Histogram statistics (see page 66)
Histogram Limit Controls

Use these controls to set the histogram boundary limits (area being measured). Access these controls from Setup > Histogram.

The boundary region is delimited by the four boundaries: Top, Bottom, Left, and Right.

You can set histogram boundaries in either units based on the source waveform (Absolute) or in display percent units (%). The display percent unit coordinate system is based on 0,0 as upper left, and 100,100 as lower right.

Vertical and horizontal controls do not change the histogram boundary area. Instead, control changes determine the relationship between the internal coordinate system and the absolute unit values you specified. Therefore, you see the values of the histogram boundaries change as corresponding vertical and horizontal changes are made.

TIP. You can resize the histogram boundary area in one or both directions using standard drag-and-drop operations.

See Also:
- Histogram source settings (see page 62)
- Histogram display options (see page 63)
- Histogram statistics (see page 66)

Histogram Background

The instrument can display histograms from waveform data. You can display both vertical (voltage, watts, ohms or rho) and horizontal (time, bits, or distance) histograms, but only one at a time. The figure shows a vertical histogram view with readouts.
**Key Features**

- **Flexible histogram editing:** You can use the controls in Hist Setup dialog box to completely specify the histogram box on the waveform, in waveform units or as a percent of the graticule. For quick edits, you can use can use the mouse or touchscreen to drag to resize and reposition the box directly on the screen.

- **Use any waveform as a source:** You can acquire Histograms from all channel, math, and reference waveforms. If the waveform selected as the source for the histogram has an associated waveform database, the histogram take measurements using the waveform database.

- **Continuous operation:** The histogram that you set up can run, and its results can be displayed even if you turn off the display of the histogram or of the waveform selected as its source. Histogram data is continuously accumulated and displayed until you explicitly turn it off or clear the waveform data of the histogram source.

- **One histogram at a time:** One histogram can be displayed on one source at a time. The source can be any waveform in any of the three Views, Main, Mag1, or Mag2.

- **Histogram counting:** Once you check Enable Histogram in the Histogram Setup dialog, histogram counting starts and continues until you disable the histogram or clear the histogram counts. If the histogram is not displayed on the graticule but histogram statistics still appear on the display, histogram counting is still running. To clear histogram counts push CLEAR DATA on the front panel or click the Clear button in the Hist Setup dialog box. Also, changing any acquisition control clears all acquired data and the histogram count as well.

- **Histogram size:** The maximum vertical histogram size is 400 bins. The maximum horizontal size is 1000 bins.

- **Recalling setups:** The histogram state is restored to what it was when the setup was saved.
See Also:

Histogram statistics (see page 66)
Histograms Setup dialog box overview (see page 61)

Histogram Statistics

Histogram statistics are displayed in the readout area. The following table describes the histogram statistics.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean</td>
<td>The average of all acquired points within and on the histogram box</td>
</tr>
<tr>
<td>Median</td>
<td>The middle number that separates the highest half of all acquired points from the lowest half.</td>
</tr>
<tr>
<td>Std Dev</td>
<td>Standard Deviation. The root mean square deviation of all points within or on the histogram box.</td>
</tr>
<tr>
<td>Pk-Pk</td>
<td>The peak-to-peak value of the histogram. Vertical histograms display the amplitude of the highest nonzero bin minus the amplitude of the lowest nonzero bin. Horizontal histograms display the time of the right-most nonzero bin minus the time of the left-most nonzero bin.</td>
</tr>
<tr>
<td>Hits</td>
<td>The number of hits within and on the histogram box.</td>
</tr>
<tr>
<td>$\mu \pm 1\sigma$</td>
<td>The percentage of points in the histogram that are within 1 standard deviation of the histogram mean.</td>
</tr>
<tr>
<td>$\mu \pm 2\sigma$</td>
<td>The percentage of points in the histogram that are within 2 standard deviations of the histogram mean.</td>
</tr>
<tr>
<td>$\mu \pm 3\sigma$</td>
<td>The percentage of points in the histogram that are within 3 standard deviations of the histogram mean.</td>
</tr>
<tr>
<td>Peak</td>
<td>The number of points in the largest bin of the histogram.</td>
</tr>
<tr>
<td>#Wfms</td>
<td>The number of waveforms that have contributed to the histogram</td>
</tr>
</tbody>
</table>

See Also:

Histogram Background (see page 64)
Histograms Setup Dialog Box Overview (see page 61)

Horizontal Setup Dialog Box Overview

Use this dialog box to set up horizontal timebase-related parameters. Access these controls from Setup > Horizontal.
Key Features:

- Select and set up timebases to acquire and display channel waveforms
- Display horizontal parameters for individual timebases associated with stored reference waveforms
- Select horizontal units to apply globally to all timebases
- Set bit rate manually or automatically to a standard communication rate
- Select and set up Pattern Sync and FrameScan acquisition parameters

See Also:

Horizontal Timebase Controls Overview (see page 67)
All Timebases Controls Overview (see page 76)

Horizontal Timebase Controls Overview

Key Features:

- Set the horizontal timebase, scale, position, resolution, data record length, and horizontal reference parameters

See Also:

Horizontal Timebase selection (see page 68)
Horizontal Scale Control (see page 69)
Horizontal Position Control (see page 71)
Horizontal Timebase Selection

This control selects the measurement timebase to set up (Main, Mag1, Mag2, Math, and Reference). Access this control from Setup > Horizontal.

Select from the three channel waveform timebases. Ref and Math timebases are set by their sources. They are read-only, and you cannot edit these directly. The remaining settings change to match the timebase you select.

When acquiring waveforms, the instrument uses the timebase settings for Main, Mag1, and Mag2, with the trigger conditions defined in the Trigger settings, to define the horizontal acquisition windows (see page 68).

**Acquisition Window**

This window defines what data is included from the input signal to form a waveform record. The vertical offset sets the vertical center of this window independently for each channel; the horizontal scale and position set the horizontal size and position for all channels in parallel (with some minor delay adjustment allowed, per channel, with deskew).

**Behavior**

The instrument provides three timebases for acquisition and display of channel waveforms: the Main, and two magnified timebases, Mag1 and Mag2. The instrument always displays the Main timebase; you can toggle each Mag timebase on and off.
All channel waveforms displayed in a given timebase share the same timebase and its settings. You cannot display channel 1 at 100 ps and channel 2 at 200 ps in the same timebase.

The instrument acquires data for each channel independently for each timebase. The Mag1 and Mag2 views are not zoomed or interpolated versions of the Main timebase. Each one has an independent acquisition cycle.

Waveforms defined in the main timebase are automatically defined and acquired in the magnified timebases.

**TIP.** You can only set up the three timebases here. To turn them on and off, use the front-panel buttons, MAIN, MAG1, and MAG 2, in the Horizontal Control block, the equivalent controls at the bottom of the display screen, or the Mag1 and Mag2 menu commands in the View menu.

**Math and Reference Timebases**

Math and Reference waveforms retain their own timebase settings and display accordingly. Each Reference waveform uses the timebase settings it was saved with; for example, a REF 1 waveform saved at 100 ps/div always displays at 100 ps/div no matter at what horizontal scale the channel timebases display. Math waveforms act the same, deriving their timebase settings from the waveform sources that define them.

**TIP.** Because there are eight reference waveforms allowed, you can select the Main, Mag1 or Mag2 timebase for each reference waveform. If a reference waveform is displayed, it displays the same data for each timebase view (there is no separate magnified data for a reference waveform as there is for a channel waveform). You can also select timebases for each of the eight math waveforms. However, there is separate data for each Mag view of a math waveform if the expression for that math waveform includes a channel waveform.

**See Also:**

Horizontal Timebase Controls Overview (see page 67)
Horizontal Scale Control (see page 69)
Horizontal Position Control (see page 71)
Horizontal Resolution Control (see page 73)
Horizontal Record Length Control (see page 74)
Horizontal Reference Point Control (see page 75)

**Horizontal Scale Control**

Use this control to set the horizontal scale for the selected timebase. Access this control from the Horizontal MENU front panel button or from Setup > Horizontal.
**TIP.** You can also adjust the horizontal scale of the selected timebase using the front-panel knob or the scale control at the bottom of the display.

Operation differs for the timebase display of channel waveforms and the display of individual timebases associated with individual Math or Ref waveforms.

**Main, Mag1, and Mag2.** Channel waveforms display in these timebases with the horizontal scale set for the timebase. Each channel timebase, Main, Mag1, and Mag2, uses its own horizontal scale. All channel waveforms in an individual timebase share the timebase scale. The horizontal scale, together with the record length setting, determines the sample interval or resolution (that is, the time between sample points).

**TIP.** Main, Mag1, and Mag2 timebase scales, positions, and record lengths (resolution) are independent of one another; however, Mag1 and Mag2 must be totally contained within the Main timebase.

**TIP.** Mag views are useful when you want to zoom in on a particular area of interest in the signal.

**Math and Ref Timebases.** Timebases for Math and Ref waveforms are individually associated, derived either from the source waveform for a Math waveform or from the source waveform for a Ref waveform. You can display the settings for math and reference waveforms (for Main, Mag1, or Mag2 timebases), but you cannot change them.

**TIP.** To see the scale on screen of a Math or Ref waveform, click the waveform to select it. The scale readout changes to match that of the selected waveform.
Horizontal Calculations for Bits

Horizontal scale calculation for bit units:

bits/div = scale in time/div \* bit rate

Horizontal position calculation for bit units:

bits = (horizontal position in time) \* bit rate (for bits units, the horizontal time reference ‘0’ is the time of the first acquired point)

Scale Calculation

Click here (see page 71) for calculations for bit units.

See Also:

Horizontal Timebase Controls Overview (see page 67)
Horizontal Timebase selection (see page 68)
Horizontal Position Control (see page 71)
Horizontal Resolution Control (see page 73)
Horizontal Record Length Control (see page 74)
Horizontal Reference Point Control (see page 75)

Horizontal Position Control

Use this control to set the horizontal position for the selected timebase. Access this control from the Horizontal MENU front panel button or from Setup > Horizontal.

TIP. You can also adjust the horizontal position of the selected timebase using the front-panel POSITION knob or the position control along the bottom of the graticule display.

The horizontal position value sets a global delay time, for all channel waveforms in the selected timebase, between the trigger event and the horizontal reference for that timebase.
The minimum position you can set is limited to one of two settings, depending on the current hardware configuration:

- If there are no sampling modules on extender cables, the minimum horizontal position is set to 19ns. This is the typical value, not the actual hardware minimum value (insertion delay, or the minimum time from an external trigger event to the first acquired sample).
- If there are one or more sampling modules on extender cables, then the minimum horizontal position is set to 19ns + max (Extender-Cable-Delays). Remote sampling modules such as the 80E07, 80E08, 80E09, and 80E10 have the same effect as placing non-remote sampling modules on extenders. These modules also affect the available minimum horizontal position values.

The minimum horizontal position governs the smallest horizontal position you can set. If you specify too small of a value, the instrument will automatically set its position to the minimum position attainable.

When horizontal units = bits, the minimum horizontal position is 0 bits, which is set to equal the time of the first acquired bit, independent of any extenders or remote samplers.

**TIP.** The position of each Mag timebase is constrained to be in the domain of the main timebase. Changing the main timebase position can affect the position of each Mag timebase, but the position of a Mag timebase cannot affect the main timebase position.

**Position Calculations**

Click [here](#) for position calculations for bit units.

**See Also:**

- Horizontal Timebase Controls Overview
- Horizontal Timebase Selection
- Horizontal Scale Control
- Horizontal Resolution Control
- Horizontal Record Length Control
- Horizontal Reference Point Control
Horizontal Resolution Control

Use this field to view the resolution (the sample interval between points) of the selected timebase. Access this field from the Horizontal MENU front panel button or from Setup > Horizontal.

You cannot adjust the resolution from this field; use the Resolution knob on the front panel to change the value. Changing the horizontal Scale or Record Length fields also changes the resolution value.

Horizontal resolution is defined as:

Resolution = (10 * horizontal scale) / record length

See Also:

- Horizontal Timebase Controls Overview (see page 67)
- Horizontal Timebase Selection (see page 68)
- Horizontal Scale Control (see page 69)
- Horizontal Position Control (see page 71)
- Horizontal Record Length Control (see page 74)
- Horizontal Reference Point Control (see page 75)
Horizontal Record Length Control

Use this control to set the record length of the selected timebase. Access this control from the Horizontal MENU front panel button or from Setup > Horizontal.

Valid record lengths for the main timebase are 50, 100, 250, 500, 1000, 2000, 4000, 8000, and 16000 samples. Valid record lengths for the Mag1 and Mag2 timebases are 50, 100, 250, 500, 1000, 2000, and 4000. The record lengths of MainTB, Mag1, and Mag2 timebases can be set independently.

See Also:

Horizontal Timebase Controls Overview (see page 67)
Horizontal Timebase Selection (see page 68)
Horizontal Scale Control (see page 69)
Horizontal Position Control (see page 71)
Horizontal Resolution Control (see page 73)
Horizontal Reference Point Control (see page 75)
Horizontal Reference Point Control

This control sets the horizontal reference point for the selected timebase in terms of percentage of record. Access this control from the Horizontal MENU front panel button or from Setup > Horizontal.

Horizontal reference values range from 0-100% with a default setting of 50%. When changing the horizontal scale for any timebase, all live waveforms are scaled about the reference point.

**TIP.** Percentage of record and percentage of screen coincide since the entire record is displayed in the graticule.

See Also:

- Horizontal Timebase Controls Overview (see page 67)
- Horizontal timebase selection (see page 68)
- Horizontal Scale Control (see page 69)
- Horizontal Position Control (see page 71)
- Horizontal Resolution Control (see page 73)
- Horizontal Record Length Control (see page 74)
All Timebases Controls Overview

Key Features:
- Set comm standard, bit rate, measurement units, and display scale parameters
- Set timebase units
- Set test cable properties (propagation velocity or dielectric constant)
- Set PatternSync and FrameScan parameters

See Also:
- Timebase Comm Standard Control (see page 76)
- Timebase Units Control (see page 77)
- Display Scale Control (see page 78)
- Pattern Sync/FrameScan Setup (see page 79)

Timebase Comm Standard Control

This control sets the communication standard bit rate that you want to test. Access this control from the Horizontal MENU front panel button or from Setup > Horizontal.

Selecting a Comm Standard automatically enters the bit rate for that standard into the Bit Rate field. Manually entering a value in the Bit Rate field changes the Comm Standard field label to User.
Timebase Units Control

This control sets the type of units to use for the horizontal axis for all timebases. Select from seconds, bits, or distance. The timebase scale and position controls use the units you select. Access this control from the Horizontal MENU front panel button or from Setup > Horizontal.

![Control Settings Image](image)

The timebase scale and position controls will use the units specified by this control. In addition, all measurement results will be in the specified units.

Units Setup

Select the Units Setup button to open the Units Setup dialog box, where you set distance units, dielectric constant, and propagation velocity parameters when operating the instrument in TDR mode.

![Units Setup Dialog Box](image)

When you select Distance as the timebase units, the timebase scale and position controls use distance units. The Distance field shown above contains a units control for choosing meters, feet, or inches as your distance unit. The Dielectric Const(ant) field and Propagation Velocity controls interact; you can select...
either the dielectric constant of the device under test or its propagation velocity (each varies with the other). TDR measurements frequently use distance units.

See Also:

All Timebases Controls Overview (see page 76)
Timebase Comm Standard Setting (see page 76)
Display Scale Settings (see page 78)
Pattern Sync/FrameScan Setup (see page 79)

Display Scale Control

This control sets the horizontal display scale units type to per division (with 10 divisions per screen) or per screen (10x the per division value). For example, 200 ps/div = 2 ns/screen. Access this control from the Horizontal MENU front panel button or from Setup > Horizontal.

A common example of using the Per Screen setting is when you are examining a serial data signal with the horizontal units set to bits. Knowing how many bits per division is of little use, where the Per Screen setting shows how many bit times (or unit intervals) are displayed in the entire waveform graticule.

See Also:

All Timebases Controls Overview (see page 76)
Timebase Comm Standard Control (see page 76)
Timebase Units Control (see page 77)
Pattern Sync/FrameScan Setup (see page 79)
The Pattern Sync/FrameScan Setup

The Pattern Sync/FrameScan button opens the Pattern Sync/FrameScan Setup dialog box, which contains controls for setting pattern sync and FrameScan parameters. Access this control from the Horizontal MENU front panel button or from Setup > Horizontal > Pattern Sync/FrameScan.

See Also:

Pattern Sync/FrameScan Setup Dialog Box (see page 134)
FrameScan Overview (see page 82)

The Horizontal Acquisition Window Overview

You define the horizontal acquisition window, that is, you set several parameters that determine the segment of an incoming signal that becomes the waveform record when acquired. For background, see Waveform Record (see page 44). These common parameters specify a common horizontal acquisition window that is applied to all channels in parallel. (See Independent versus Shared Window (see page 82).) These parameters are:

- The external trigger signal that you input and set the trigger system to recognize determines the point relative to the input waveform that triggers the instrument.

- The horizontal position you set determines the horizontal delay from the trigger point to the first sample point in the acquisition window.

- The horizontal scale you set, and the requirement that all waveforms fit within the 10 horizontal-division display, determines the horizontal duration of the window relative to any waveform, allowing you to scale it to contain a waveform edge, a cycle, or several cycles.
The record length (with the horizontal scale) you set for the 10-division window determines the sample interval (horizontal point spacing or resolution) on the waveform.

The horizontal position controls the distance to the Horizontal Reference to indirectly set the time to the first sampled point.

**See Also:**

- Horizontal Scale Versus Record Length Versus Sample Interval Versus Resolution (see page 81)
- Horizontal Position Control (see page 71)
- Horizontal Reference Point Control (see page 75)
Horizontal Scale versus Record Length versus Sample Interval versus Resolution

These parameters all relate to each other and specify the horizontal acquisition window. Because the horizontal acquisition window must fit in the 10 horizontal division display, for most cases, you just set the duration of the horizontal acquisition window (10 divs x the scale setting) as described in (1) below. By also setting a record length in samples, you indirectly set the resolution/sample interval/sample rate for the horizontal acquisition window (waveform record). The relationships between these horizontal elements are:

1. Time Duration (seconds) = 10 divs (window size) x Horizontal Scale (seconds/div)
2. Time Duration (seconds) = Sample Interval (seconds/sample) x Record Length (samples), where:
   Time Duration is the horizontal acquisition window time duration
3. Sample Interval (seconds/sample) = Resolution (seconds/sample) = 1/Effective Sample Rate (samples/seconds)

In (2) above, note that it is Sample Interval that varies indirectly to accommodate the window time duration (and its scale setting) and the Record Length setting as these later two elements are user settable.

If Record Length or Time Duration vary, Sample Interval varies to accommodate, up to the highest sample rate/lowest sample interval/highest resolution.

You cannot directly set resolution and the equivalent elements (sample interval and effective sample rate (see equation 3 above)); they are derived values. You can, however, check the resolution at anytime in the resolution readout (push the Horizontal Menu button).

**NOTE.** The Resolution knob adjusts the record length to increase sample density (detail).
Independent versus Shared Window

For a given time base, the instrument applies the same horizontal acquisition window to all channels from which it acquires data. Unlike the vertical acquisition window that you set independently for each channel, the same time/division, resolution (record length), and horizontal delay (from the same trigger point) that you set for a time base, apply to all channels in that time base. In other words, one trigger, from a single trigger source, will locate a common horizontal acquisition window on all active channels, which you can shift by setting the horizontal position control.

The horizontal acquisition window determines the waveform records extracted from all signals present at all active channels and math waveforms. You can think of the horizontal acquisition window as cutting across any input signals present in the input channels to extract the same slice of time into waveform records. See the figure that follows, which shows a common trigger, record length and acquisition rate are common for all channels.

FrameScan Overview

FrameScan acquisitions help you analyze pattern-dependent failures in high bit-rate communications signals, as well as provide detailed display and analysis of individual, complete waveforms or of the bit sequences leading up to a failure. The ability to identify the specific patterns that caused the failures makes using FrameScan mode superior to traditional methods.

Using FrameScan along with magnification views and mask testing can help you quickly locate and debug pattern dependent serial data compliance test failures. The following image shows how FrameScan identified the location in a data stream where an invalid signal transition occurs. The serial data pattern signal is in the upper Main view; the lower Mag1 view shows the magnified view of the specified Main view area. You can also view the signal before and after the invalid signal transition.
FrameScan acquisition mode offers the following advantages:

- **Superior time base stability**: When using the internal pattern sync capability, timing accuracy typically varies no more than 0.1 ps, providing the stability needed to examine signals of almost any length for pattern-dependent failures.

- **Flexible setup support**: Set bit rates manually or set a bit rate based on a communication standard. Then set the horizontal scale manually or invoke a custom autoset: Bit/Eye-Pattern Autoset, if you have set an independent bit rate, or Standard-Mask Autoset, if you set bit rate based on a communication standard.

- **Identification and analysis of pattern-dependent failures**: FrameScan acquisition, when used with mask testing and Stop After condition acquisition, can automatically determine the bit at which a pattern-dependent failure occurred.

- **Ability to acquire and display correlated eye diagrams**: FrameScan mode acquires data synchronously with respect to the pattern. This makes it possible to acquire averaged waveforms which minimizes uncorrelated (random) noise and jitter. This capability lowers the effective instrument noise floor, enabling the examination of very low power optical signals. Since FrameScan scans through the pattern one bit at a time, it is possible to overlay all of the bits in the pattern to construct an averaged (correlated) eye diagram and to do mask testing on the signal (see above figure).

- The instrument must be in Average or Sample acquisition modes; FrameScan excludes Envelope acquisition mode.

- FrameScan is most useful when used with the Pattern scope mode (Clock trigger source), which requires the ADVTRIG Advanced Triggers with Pattern Sync option. However, it may also be used in the other scope modes (Eye and Other) to acquire multiple phases of a data pattern when using subdivided clocks.

- **Determine scan bits**: You need to know the total number of bits for the desired FrameScan cycle, as well as the appropriate horizontal scale.
FrameScan Theory of Operation

FrameScan mode alters the normal acquisition sequence to scan a repetitive data pattern or a sub-portion of the bit sequence or pattern. The steps in the FrameScan acquisition are as follows:

1. The horizontal position is set to acquire the first bit, which the acquisition system acquires as a subframe (see the figure that follows).

2. The horizontal position is incremented one-bit period (1/bit rate), and then the acquisition system acquires the second bit as a subframe. The duration of each subframe acquisition is determined by the horizontal scale.

3. This sequence of incrementing, and then acquiring the next bit, continues until the instrument acquires the number of bits you specify for the frame, or until acquisition stops due to a specific test condition, such as the failure of a mask test.

4. The resulting horizontally skewed FrameScan acquisitions display successive individual bits acquired in increasing time order. FrameScan acquisitions can continue through an entire frame of data if needed to help you to uncover faulty bit sequences leading up to pattern-dependent failures.

**NOTE.** You must supply a data or clock signal that is synchronous to the signal data pattern. Examples include inputting an optical serial data signal into an optical module with clock recovery, or inputting a clock into the front panel Clock Input/Prescale Trigger input that is synchronous to a serial data signal connected to the input of a sampling module.
FrameScan acquisition example

**NOTE.** \( \Delta h \) is the horizontal position change = one bit period (1/bit rate).

The acquisition duration is determined by the horizontal scale. For example, if the scale is set to acquire 5 bits, then each subframe acquired is 5 bits in duration, shifted by one bit duration for each subframe.
FrameScan Enable and Scan Bits

Use these controls to enable FrameScan mode and set the scan bit value. Access this control from Setup > Horizontal > Pattern Sync/FrameScan.

- **Enabled**: Enables or disables FrameScan. Scanning starts as soon as you enable FrameScan.
- **Scan Bits**: Sets the number of bits or subframes to acquire. The range of Scan Bits is from 2 to 8,388,608 ($2^{23}$).
- **Reset**: Restart FrameScan acquisition.

FrameScan lets you acquire and analyze repeating digital data patterns (typically Pseudo-Random Bit Streams, or PRBSs) that are contained within a data “frame”. FrameScan is an acquisition technique that controls how successive acquisitions occur. It can be used with any trigger source that provides a clock signal that is synchronous to the serial data stream.

FrameScan automatically sequences or skews the timebase such that each bit, or unit interval, of the data stream is acquired in increasing time order. The acquisition of each sample of each bit, and of each bit of the desired bit stream, is based on the trigger events derived from an externally provided clock signal (or internally provided when using clock recovery capable modules). Because the sequencing or “scanning” of the timebase occurs automatically within the instrument, there is no need to interact with the external signal source or the instrument once they are appropriately set up. For more information on how FrameScan acquires data, see FrameScan Theory of Operation (see page 84).

FrameScan displays bit 0 of the data stream at the left edge of the graticule.

A primary use of FrameScan is to locate pattern-dependent anomalies. This is accomplished by using FrameScan with the Mask Testing and Acquisition Stop After features (specifically the Stop After mask hits condition). You can also refer to a technical brief on this topic titled Finding and Examining Pattern-Dependent Failures with the FrameScan® Acquisition Technology. Visit the Tektronix Website at http://www.tektronix.com to find this brief.

See Also:

- Acquisition Background (see page 40)

Mask Setup Dialog Box Overview

Use this dialog box to select (or edit) masks and run mask tests on incoming waveforms.
Key Features:

- Select signal source and communications standard (see page 87)
- Enable/disable waveform database
- Enable/disable mask testing (see page 87) display and color
- Enable and set mask margin percent (see page 88)
- Autoset Data to Mask (see page 88)
- Autofit Mask to Data (see page 88)
- Create or edit (see page 88) a mask

See Also:

Mask Source Controls (see page 88)
Mask Display Controls (see page 89)
Mask Margin Controls (see page 90)
Autoset Data to Mask Controls (see page 91)
Autofit Mask to Data Overview (see page 92)
Mask Edit Dialog Box Overview (see page 94)

Mask Testing Communication Standards

This instrument includes many industry-standard masks to support common electrical and optical communication physical layer standards.

Mask Testing

A mask contains one or more mask polygon shapes that, when applied against the waveform type for which it is intended, tests the waveform for violations of that mask. Waveform samples that fall within the mask polygon areas are called mask violations, failures, or hits.

The list of hits per polygon mask is called the Mask Statistics or Results. Mask testing, like histograms, can operate on either live data or data accumulated in a waveform database.
### Mask Margin Percent
Mask margins let you shrink or expand an existing set of polygons by a specified percentage.

### Autoset Data to Mask
Autoset Data to Mask changes the acquisition control parameters (vertical and horizontal scale, position and offset) to align the waveform data to the selected mask.

### Autofit Mask to Data
Autoset Mask to Data aligns the mask to fit the acquired data for the selected waveform database.

### Mask Edit Dialog Box
Click the Mask Edit button to modify a mask or create your own custom mask, either from scratch or by using a standard mask as a starting point.

## Mask Source Controls

These controls set the source waveform for mask testing, enables mask counts, selects a communication standard, and turns the use of waveform databases on and off. Access this control from **Setup > Mask**.

![Mask Source Controls](Image)

- **Source**: Select a signal source from the drop-down menu.
- **Enable Mask Counts**: Enables or disables mask hit counting.
- **Comm Standard**: Select a communication standard from the drop-down menu on which to perform a mask test.
- **Use Wfm Database**: Enables or disables the use of waveform databases for mask sources. When Use Wfm Database is checked, the instrument attempts to associate a waveform database resource to the live waveform source. If the source for mask testing is displayed as a waveform database at the time you enable mask testing, the Use Wfm Database control is turned on by default.
- **Clear Data**: Resets (clears) all mask hit counts.
**Mask Display Controls**

These controls enable or disable displaying the mask and sets the mask display color. Access this control from **Setup > Mask**.

- **Mask**: Enables or disables displaying the mask. Clear the check box to remove the mask from the screen.
- **Color**: Select the color of the displayed mask.

**See Also:**

- Mask Source Controls (see page 88)
- Mask Margins Controls (see page 90)
- Autoset Data to Mask Controls (see page 91)
- Autofit Mask to Data Overview (see page 92)
- Mask Hit Count Readout (see page 98)
- Mask Edit Dialog Box Overview (see page 94)
Mask Margins Controls

These controls set the percentage by which an existing set of mask polygons will expand or shrink when mask margins are On. Access this control from Setup > Mask.

- **On**: Enables or disables the mask margin control.
- **Margin**: Sets the percentage by which an existing set of mask polygons will expand or shrink when mask margins are On. If you select a positive mask margin percentage, the polygon expands, making the mask test more difficult to pass due to the expanded mask violation area. If you select a negative mask margin percentage, the polygon shrinks, making the mask test easier to pass due to the smaller area.

The margin limits are ±100%. If you enter a margin percentage that would cause the modified masks to either go off screen or cross one another, the entered value is not allowed, the last valid margin is restored, and a warning message is displayed.

See Also:

- Mask Source Controls (see page 88)
- Mask Display Controls (see page 89)
- Autoset Data to Mask Controls (see page 91)
- Autofit Mask to Data Overview (see page 92)
- Mask Hit Count Readout (see page 98)
- Mask Edit Dialog Box Overview (see page 94)
**Autoset Data to Mask Controls**

Autoset Data to Mask changes the acquisition control parameters (vertical and horizontal scale, position and offset) to align the waveform data with the selected mask, based on algorithms associated with each mask. These controls are active only when you select a communications standard. Access these controls from **Setup > Mask**.

Custom masks *derived* from a standard mask retain the autoset algorithm specific to that parent mask standard.

- **Automatic/Manual**: Sets the autoset behavior. When set to Auto, the instrument automatically performs a standard mask-specific autoset whenever you select a standard mask. When set to Manual, no autoset operation occurs unless you click the Autoset button or invoke an autoset operation using the front panel AUTOSET button or the toolbar AUTOSET button.

- **HiLow Method**: Selects the method used for determining the High and Low values when aligning the input signal to the masks (all supported masks are based on NRZ signals). The methods are:
  - **Mean** sets Mask Autoset to use the means of the histograms of the High level (topline) and Low level (baseline) within the existing fixed eye aperture (center 20% of the eye) to align the input signal to the NRZ mask. Mean is the default setting.
  - **Mode** sets Mask Autoset to use the modes of the histograms of the High level (topline) and Low level (baseline) across one unit interval of the eye diagram to align the input signal to the NRZ mask. This selection forces the Comm. Standard setting to USER.

- **Autoset**: Runs the autoset for the current mask.

**See Also:**

- Mask Source Controls (see page 88)
- Mask Display Controls (see page 89)
- Mask Margins Controls (see page 90)
- Mask Hit Count Readout (see page 98)
- Autofit Mask to Data Overview (see page 92)
- Mask Edit Dialog Box Overview (see page 94)
Autofit Mask to Data Overview

The Autofit Mask function adjusts the selected mask (standard or user) to the data acquired in the specified source waveform database such that the left edge of the mask aligns with the left-most displayed eye crossing and the mask width is the standard's UI at the selected horizontal scale. When mask Autofit Mask to Data runs successfully, the instrument moves the horizontal reference point to line up with the left edge of the mask.

For relative masks (such as those for optical signals), the instrument adjusts the mask vertically so that the mask high and low positions align with the measured high and low of the waveform.

For absolute masks (such as most masks for electrical signals), the instrument adjusts the mask vertically so that the mask high and low positions are based on the vertical scale, offset, and position of the mask source waveform.

Guidelines

- Autofit Mask to Data only operates on waveform database data. Enable a waveform database for each signal being mask tested on which to run an autofit.
- To ensure that the mask is fit to the currently accumulated data, stop the oscilloscope signal acquisition before running Autofit Mask to Data.
- Running Autofit Mask to Data turns off the Mask Margin function (if it is on), but does not change the percentage value entered in the Mask Margin field.
- When saving the instrument setup, the original mask points are saved (not the autofit points).
- Implicit or explicit Clear Data events (any event that erases waveform database values) resets the autofit status.
- Autofit Mask to Data does not track (dynamically rescale) the mask position to match changes in the instrument vertical or horizontal settings.
- The Auto Mask to Data function is only available for masks with three polygons.

See Also:

Autofit Mask to Data Procedure (see page 93)
Autoset Data to Mask Controls (see page 91)
Mask Display Controls (see page 89)
Mask Source Controls (see page 88)
Mask Margins Controls (see page 90)
Mask Hit Count Readout (see page 98)
Mask Edit Dialog Box Overview (see page 94)

Autofit Mask to Data Procedure

1. Push the **Default Setup** front-panel button to return the instrument settings to a default state.
2. Select the channel(s) to test.
3. Set the instrument measurement mode to **Eye**.
4. Select **Setup > Horiz > Comm Std** and select the communication standard.
5. Select **Setup > Vert > Filter** (if available for the sampling module) and select the Optical Reference Receiver filter associated with the communication standard.
6. Click the waveform database button for each channel being acquired.
7. Select **Setup > Mask > Source** and select the active channel source.
8. Click **Enable Mask Counts** (automatically selects Use Wfm Dbase and Display Mask)
9. Click **Comm Standard** and verify or set the communication standard.
10. Click the **Autoset Data** button.

**NOTE.** If you are acquiring more than one signal, display all signals and change the horizontal scale such that all signals display at least one complete eye (two clear eye crossings). Do not click the Autoset Data button for each channel.

11. Click the **Run/Stop** toolbar button to begin signal acquisition.
12. Acquire the desired number of waveforms in the waveform databases.
13. Click the **Run/Stop** toolbar button to stop signal acquisition.
14. Click the **Autofit Mask** button in the Mask tab. The instrument displays a message at the top of the screen that the mask has been adjusted to the current data.
15. Observe the mask test results in the Mask Readout. You can also print out a screen shot showing the mask test results.
16. If you are doing an Autofit Mask on multiple signals:
   a. Select the next channel on the front panel (unselect all other channels).
   b. In the Mask tab, click the Source button and select the active channel.
   c. Click the **Autofit Mask** button.
   d. Repeat for all signals to be tested.
Mask Edit Dialog Box Overview

Use this dialog box to manually create and edit masks. Access these controls from Setup > Mask > Mask Edit.

Key Features:
- Create masks from scratch
- Use existing masks as a starting point
- Set horizontal and vertical values for selected vertices
- Add or delete mask polygons and vertices to masks to create custom masks
- Use the mouse cursor and right-click context menu to edit a mask on the display (see page 95) (select a mask, add or delete vertices, and move vertices)

- **Mask**: Indicates or selects the current mask polygon. A mask test can have up to 8 mask polygons. To create a new mask, select an undefined mask and add vertices to the mask.

- **Vertex Number**: Displays the selected vertex number of the current mask polygon. Use the field controls, or enter a value in the field, to select a vertex. You can also use the mouse to select a mask vertex.

- **Horizontal**: Displays the current vertex horizontal position. Use the field controls, or enter a value in the field, to define the horizontal position of the selected vertex.

- **Vertical**: Displays the current vertex vertical position. Use the fields controls, or enter a value in the field, to define the vertical position of the selected vertex.

- **Add**: Adds a vertex to the selected mask. Position the cursor at the location to insert the new vertex and click Add.

- **Delete**: Deletes the current vertex. You cannot undo this action. To delete a polygon, delete all the vertices in the polygon.

**NOTE.** You cannot edit a mask remotely using GPIB commands.
Mask Usage Guidelines

- **GPIB and masks**: You cannot edit masks through the programmable interface (GPIB). You can create and/or delete entire masks through the interface.

- **Concurrent mask tests**: Only one mask standard (or user defined set) is active at any time. If you have a mask selected and then select a new mask, the new mask replaces the previous mask. You cannot test to multiple standards simultaneously.

- **Saving masks**: Masks are saved as part of instrument setup files, so you can save sets of masks by defining the masks and then storing the instrument setup. Displayed masks are overwritten when you recall a stored setup, select a standard mask, or initialize the instrument.

- **Importing masks**: Use the File > Import Custom Mask dialog box to import a custom mask. Once imported, you can select the custom mask from the Communication Standard list. Contact Tektronix to request a custom-designed mask for your testing needs.

Mask Editing Guidelines

- Masks are saved as part of instrument setup files, so you can save sets of masks by defining them, and then storing the instrument setup. Displayed masks are overwritten when you recall a stored setup, select a standard mask, or initialize the instrument.

- When you edit a mask (such as an existing communication standard mask), that mask becomes a User mask.

- When editing, locate one point along the left edge or right edge of the mask further left or further right than any other point. You can still create straight lines along the edge; just place one point further left or right than the others on the edge.

- The vertices numbers increase according to their order from left to right. The instrument reassigns numbers to vertices during mask creation or editing to hold to this rule.
When adding new points to a mask, the instrument determines their location in the mask as follows (see figure that follows):

- Defines an imaginary line between the left-most vertex and right-most vertex in the mask.
- Defines all points above the imaginary line as the top of the mask; all points below as the bottom of the mask.
- Inserts new user-added points above the imaginary line into the top of the mask; inserts new user-added points below the imaginary line into the bottom.

To create a mask with a concave area, create several masks to cover the same area. Data falling into two overlapping masks is counted only once as part of the total mask hits.

Note in the following figure that a new vertex was added to the mask shown in the preceding figure. Since the point is added above the line, it was added to the top of the mask.
Mask Hit Count Readout

The instrument displays mask hit statistics in the Mask measurement readout area. The mask statistics readout is displayed as soon as you enable a mask, and stays visible even if the mask is not displayed on screen.

If mask counting is turned on, read the results as follows:

- **Mask (n)**: Each mask in the standard is listed by number (Mask 1 for example) adjacent to the number of hits in that mask.
- **Total**: Displays the total of all hits in all masks.
- **#Wfms**: Displays the number of waveforms that have been tested against the masks.
- **Margin**: Displays the percent deviation in the current mask polygon size (margins) from the default mask polygons. The Margin field shows Off if mask margins are turned off.

**NOTE.** Mask margining is only available for masks with 3 polygons

To zero the counts for all masks, click **Clear** in the Mask Setup dialog box. Executing Clear will clear the mask counts and the underlying waveform data. For example, if mask testing on a waveform database the database data is cleared and accumulation is restarted, and if mask testing on a waveform being averaged or enveloped, Clear restarts the averaging or enveloping.

Measure Setup Dialog Box Overview

Use this dialog box to set up an automated measurement. Access this dialog box from **Setup > Measurement**.
Key Features:
- Take up to eight measurements (total) on the three waveform sources (Channel, Math, or Reference)
- Select measurement type
- Define measurement source(s), regions (gates) and region characteristics
- Display measurement statistics, annotations, and weighting

Use Overview

Select the measurement (Meas 1 – Meas 8).
Select the signal source and type in the Source 1 tab.
Select the signal type (Pulse, RZ, or NRZ). The signal type defines the available measurements from which you can choose. These measurements are also available as buttons in the Measurement Bar.
Click the Select Meas button and select a measurement.
The instrument displays the measurement results in the Value field of the dialog box and in the application Readout area.

Other Measurement Features
- Click Set to Default to force the measurement Region settings, the HiLo tracking methods and values, and the RefLevel methods and references to their factory settings for the current source and signal type.

TIP. Because the defaults are for the currently selected source, clicking Set to Default does not change the source definition, signal type, or waveform database settings.
Click **Show Stats** to open a readout of the Min, Max, Mean, and StdDev with full resolution. Check the Statistics box to enable the Show Stats button.

Click **Clear Stats** to clear all statistical data and restart the statistical analysis.

Click the **Statistics** box to add minimum, maximum, mean, and standard deviation statistics to the measurement readout area.

Use the spinbox buttons (or click the keypad button) to set the **Weighting** (number of waveforms) to use when calculating statistics.

Click the **Annotations** box to have the measurement display annotations that indicate which part of the waveform is being measured as well as reference levels for that measurement.

**See Also:**
Measurement Parameters Tabs. (see page 100)

**Measurement Parameters Tabs Overview**

Use these controls to define the measurement parameters for the current measurement. Access these controls from **Setup > Measurement**.

**Key Features:**
- Select the signal source
- Define multiple signal sources for measurements that require two inputs (such as for gain measurements)
- Specify further measurement characteristics (regions, signal high/low tracking, and reference level calculation)
- Enable or clear the Waveform database
- Select the signal type

**See Also:**
- Measurement Source Tab (see page 101)
- Measurement Region Tab (Pulse selected) (see page 102)
- Measurement Region Tab (RZ or NRZ selected) (see page 103)
- Measurement Hi/Low Tab (see page 105)
**Measurement Source Tab**

This control sets the waveform source and type for measurements. Access this tab from **Setup > Measurement**.

- **Source1/Source2**: Sets the waveform source to assign as **Source1** or **Source2**.
- **Source channel**: Sets the measurement source waveform. Single waveform measurements require only Source 1. Set signal sources for both Source1 and Source2 only when making two-waveform measurements (such as gain or phase).
- **Use Wfm Database**: Enables performing the measurement on a waveform database.
- **Clear**: Clears (erases) the database contents.
- **Signal Type**: Sets the signal type as **NRZ** (Non-Return-to-Zero), **RZ** (Return-to-Zero), or **Pulse**. The signal type defines the controls available in the Region tab.

**See Also:**

- Measurement Parameters Tabs Overview (see page 100)
- Measurement Region Tab (Pulse selected) (see page 102)
- Measurement Region Tab (RZ or NRZ selected) (see page 103)
- Measurement Hi/Low Tab (see page 105)
- Measurement Reference Level Tab (see page 106)
Measurement Region Tab (Pulse Selected)

These controls set the measurement region using gates, for Pulse measurements. Access this tab from Setup > Measurement.

These Region tab controls are displayed only when the measurement signal type is Pulse.

The Region tab gathers all controls for setting measurement regions using gates. You can:

- Set percentage values for the start gate (G1) and stop gate (G2).
- select On to enable measurement gating.
- Set slope and direction. This sets the instrument to look for positive, negative, or either- slope crossings. For some timing measurements, setting the Direction forces the measurement to behave as follows:
  → the measurement looks for the first crossing forward from the first gate.
  ← the measurement looks for the first crossing backward from the second gate.
- For the delay measurement, the +/-, +, and - controls set which slope to use for measuring delay. For jitter measurements the +/-, +, and - controls specify the polarity of edge on which to make the measurement.

See Also:

Measurement Parameters Tabs Overview (see page 100)
Measurement Source Tab (see page 101)
Measurement Region Tab (RZ or NRZ selected) (see page 103)
Measurement Hi/Low Tab (see page 105)
Measurement Reference Level Tab (see page 106)
Measurement Region Tab (RZ or NRZ Selected)

This control sets the measurement region using gates, for RZ or NRZ measurements. Access this tab from Setup > Measurement.

- Set G1 and G2 percentage values.
- Enable gates to define measurement region.
- Define the Eye Aperture to be used for certain eye measurements (such as Extinction Ratio). The eye aperture defines how wide this region is as a percentage of the eye unit interval.
- Define whether noise measurements are taken at the High or Low level on the eye.
- Define whether jitter measurements are taken at the eye crossing or at the mid ref level.
- Select other measurement setups by clicking one of the other tabs.

See Also:

To Set a Measurement Region (Gates) (see page 104)
Measurement Parameters Tabs Overview (see page 100)
Measurement Source Tab (see page 101)
Measurement Region Tab (Pulse selected) (see page 102)
Measurement Hi/Low Tab (see page 105)
Measurement Reference Level Tab (see page 106)
To Set a Measurement Region (Gates)

Gates are generic, nondirectional markers that define the area of waveform data over which measurements are performed. There is no distinction in gates of stop or start, so they can cross just as cursors can.

1. After selecting Region, check On to enable the gates.

2. Set the waveform as either the Source 1 or Source 2 waveform.

3. Use the G1 and G2 field controls, click the keypad icon to display the online keypad, or drag the gates to set the gate values. Gate settings are shown as a percent of the graticule (0% at the left side and 100% at the right side), accompanied to the right by the corresponding readout in waveform horizontal units.

4. For the delay measurement, set the slope to +, -, or +/- . This tells the instrument to look for positive, negative, or either slope crossings.

5. For some timing measurements, set the Direction to either ← or → . This sets the instrument to have the measurement look for the first crossing forward from the first gate or sets the instrument to have the measurement look for the first crossing backward from the second gate.

6. When you are finished entering Setup values, close the dialog box by clicking the X in the upper right corner of the dialog box.
Measurement Hi/Low Tab

These controls set the measurement waveform high/low level tracking method and enable high/low tracking. Access this tab from Setup > Measurement.

Hi/Low values are the outermost amplitude values that you can use to derive other measurement reference parameters. If the instrument automatically calculates these values, it is said to be “tracking.” You can disable tracking for either high or low values (or both) by manually entering a value in the Track High/Track Low fields.

- **Auto, Mode, Min/Max, Mean**: Sets the measurement signal high/low level tracking algorithm. See High/Low Level Tracking Algorithms (see page 276) for more information.

- **Track High**: When checked, sets the instrument to automatically track the waveform high level using the selected tracking method. When disabled, this setting disables automatic tracking; manually enter a waveform high level value in the High field

- **Track Low**: When checked, sets the instrument to automatically track the waveform low level using the selected tracking method. When disabled, this setting disables automatic tracking; manually enter a waveform low level value in the High field

**See Also:**
- Measurement Parameters Tabs Overview (see page 100)
- Measurement Source Tab (see page 101)
- Measurement Region Tab (Pulse selected) (see page 102)
- Measurement Region Tab (RZ or NRZ selected) (see page 103)
- Measurement Reference Level Tab (see page 106)
Measurement Reference Level Tab

The RefLevel controls set the algorithm used to calculate measurement reference levels. Access this tab from Setup > Measurement.

Use these controls to select a reference level calculation method relative to the Hi/Low attributes of the waveform, and set Hi, Mid, and Low reference percent or absolute values depending on the reference level calculation method.

See Also:

- To Set a Measurement Ref Level Method (see page 107)
- Measurement Parameters Tabs Overview (see page 100)
- Measurement Source Tab (see page 101)
- Measurement Region Tab (Pulse selected) (see page 102)
- Measurement Region Tab (RZ or NRZ selected) (see page 103)
- Measurement Hi/Low Tab (see page 105)
To Set a Measurement Ref Level Method

1. Select a reference level calculation method:
   - Relative Reference: Calculated as a percentage of the High/Low range
   - Absolute Reference: Calculated as absolute values in user-specified units.
   - Low Delta Reference: Calculated as absolute values from the Low level.
   - High Delta Reference: Calculated as absolute values from the High level.
   - AOP Reference: Calculated from Average Optical Power measurement and used as Mid Ref level.
     The AOP is available only on live optical waveforms. Selecting AOP Reference on any other waveform will return either a “???” measurement result or cause the instrument to silently override the AOP Reference selection.

2. Set the percent or absolute Hi value using the up and down arrows or by clicking the keypad icon and using the mouse or touchscreen to enter a new value on the pop-up keypad.

3. Set the Mid value using the up and down arrows or by clicking the keypad icon and using the mouse or touchscreen to enter a new value on the pop-up keypad.

4. Set the Low value using the up and down arrows or by clicking the keypad icon and using the mouse or touchscreen to enter a new value on the pop-up keypad.

5. When you are finished entering Setup values, close the dialog box by clicking the X in the upper right corner of the dialog box.
Automatic Measurements Overview

Automatic measurements quickly give you immediate, continuously updating, measurement results for a wide set of waveform parameters, such as rise time or extinction ratio. You also can display statistics on how the measurement results vary as they continuously update.

Most automatic measurements require both a source selection and a measurement selection. To quickly select a measurement, use the measurement toolbar to first set the waveform type, Pulse, RZ, or NRZ, and then select a category, Amplitude, Timing, or Area, in the pulldown lists of the toolbar. Next, click the icon of the measurement that you want to use to measure the selected waveform (or drag the icon to any waveform, selected or not, on screen to measure that waveform). The results appear in the measurement readout.

Select from the extensive range of parameters this instrument can measure; for a list, see Automatic Measurements Reference, which defines the supported measurements (selections) for each category.

Feed the entire waveform to a measurement or limit the measurement to a segment of the waveform. By default, the instrument takes each automatic measurement over the entire waveform record, but you can use measurement gates to confine each measurement to the section of a waveform (see Measurement region).

The automatic measurement signal sources are channel, reference, and math waveforms.

See Also:
Automatic Measurements Guidelines (see page 108)

Automatic Measurements Guidelines

This instrument implements a robust automatic measurement system. Some of the features adding value to this system follow.

- **Annotate waveforms on screen**: You can turn on annotations that mark characterization levels that each measurement uses to compute results.
Using a source with a database: If you define the source you want and it has a database associated with it, or if you turn on a waveform database by checking the Use Wfm Database button, the measurement you select operates on the accumulated waveform data (databases accumulate repetitive instances of a source waveform over time).

For example, consider the Max measurement. Max will capture and update the maximum (most positive) value encountered. For a source that uses a waveform database, the ongoing Max measurements can only result in a higher max value as the database accumulates ongoing acquisitions. This process causes the Max measurement readout to track max up but not down. In contrast, the Max measurement for a waveform source that does not have a database will track variation up and down as new waveforms are acquired.

Characterize measurements independently: To allow you control over how your waveform data is characterized by each measurement, the instrument lets you set the methods used independently for each measurement.

See statistics on measurement results: To see how any automatic measurement varies statistically, you can display a readout of the Min, Max, Mean, and Standard Deviation the measurement results.

The following exclusions apply when using automatic measurements:

- Except for Average Optical Power, all measurements of the category RZ or NRZ must be performed on a source using a waveform database. The Average Optical Power measurement must use an optical channel as its source.

- The Average Optical Power measurement cannot display Annotations and cannot use gates or user-defined High/Low methods.

- If the waveform parameter that is to be automatically measured cannot be acquired (incorrect control setup, out-of-range input signals), this instrument displays the indicator “???.” For example, if the instrument acquires less than a full waveform cycle, it cannot measure frequency or period and displays “???.”

The key points that follow describe operating considerations for setting up automatic measurements to obtain the best measurement results.
■ **Measurement selection**: The instrument takes automatic measurements of the following categories: Amplitude, Timing, and Area. See Automatic Measurements Reference, which defines the supported measurements (selections) for each category.

■ **Number of measurements**: The instrument can take and update up to eight measurements at one time. You can apply measurements to any combination of sources (described below). You can take all eight measurements on C1, for example, or one measurement each on C1 - C8.

■ **Measurement sources**: All channel, reference, and math waveforms can serve as sources for automatic measurements. You can specify a waveform as source in the Meas Setup dialog box even if the waveform is not displayed.

Some measurements, such as Gain, Delay, and Phase, require two sources. For example, Gain measures an input from one measurement source (such as C1) with respect to an output in another source (such as C2).

■ **Databases as sources behavior**: Consider the following operating behaviors regarding measurements and databases:

  ■ When enabling a measurement, it will always measure the waveform database if the measurement source you choose is displayed as a waveform database. You can measure the waveform instead of its database if you turn off Use Wfm Database in the Meas setup dialog box.

  ■ If you assign a database to a waveform already being used as a source for an automatic measurement, it will not automatically measure the waveform database; you must explicitly specify its use by turning on Use Wfm Database in the Meas Setup dialog box.

■ **High/Low tracking**: The levels that the automatic measurement system derives as the High (Top) or Low (Bottom) for a waveform influence the fidelity of amplitude and aberration measurements. For many of the automatic measurements supported, the instrument automatically determines these levels and disables all or some of the High/Low tracking method controls (for example, RMS). If the measurement you select has High/Low methods that are appropriate to adjust (for example, RISE time), the instrument automatically enables the method controls for your adjustment; see Tracking Methods for more information.

■ **Reference levels and calculation methods**: You can choose the method that the instrument uses to determine a second group of levels when taking time-related measurements. These levels are the High, Mid, and Low references. For example, the measurement system takes rise time from the waveform-edge segment that transitions from the Low to the High reference levels; see Measurement Reference Parameters and Methods for more information.

### Phase Reference Setup Dialog Box Overview

Use the Phase Ref dialog box to set up the instrument to use a phase-correction timebase. Access these controls from **Setup > Phase Reference**.
A phase reference clock provides additional timing information (based on a user-supplied clock) to the timebase. This additional timing information enables extremely low jitter operation (less than 200 fs, typical) or acquisition of signals with Spread Spectrum Clocking (SSC).

The instrument disables the controls in this setup dialog box if there are no phase reference clock sources available or if a Phase Correction Mode is incompatible with the Trigger Source or Scope mode (selectable in Mode/Trigger setup dialog).

**TIP.** You can quickly access some of the controls for setting up phase correction without displaying this setup dialog box. Click [here](#) (see page 112) for details.
### Characterization Status Readout

This readout appears in the readouts area when a phase reference clock source is available. The readout:

- Shows the current Phase Ref characterization status, which is either Off, Required, Pass, or Fail
- Provides convenient, one-click access to run characterization (left-click the readout to immediately run characterization)
- Provides convenient, right-click access to a context menu:
  - **Off** turns off the phase-correction timebase
  - **Untriggered** turns on the phase-correction timebase in untriggered mode
  - **Triggered** turns on the phase-correction timebase in Triggered mode
  - **Triggered (SSC)** turns on the phase-correction timebase in Triggered mode and enables Spread Spectrum Clocking support
- **Setup** opens the Phase Reference setup dialog box

**TIP.** You can quickly determine if you need to characterize the selected phase reference clock source, such as is needed when the last characterization failed or you have changed the clock signal connected to the instrument. Click here (see page 112) for details.

### Dynamic Status Indicator

While the phase-correction timebase is on, the Dynamic Status Indicator displays in the readouts area. It behaves as follows:

If the last time that the characterization executed was successful, the instrument monitors the phase reference clock to detect any subsequent changes in its amplitude, offset, or shape. Upon detecting a change, the instrument displays the Dynamic Status Indicator with the notice “Reference Clock Change Detected; Recharacterize.” You should run a new Phase Reference characterization from the Phase Reference Setup dialog box to accommodate the new clock signal. You can also click the Characterization Status Readout in the readout area to run characterization.

If the last characterization failed, the indicator displays a characterization failure error message indicating the type of failure.

**Control Information:**

- Phase Correction Settings (see page 113)
- Phase Reference Clock Source Settings (see page 113)
Phase Correction Settings

Use these controls to turn the phase-correction timebase off or to enable it in Untriggered or Triggered modes. Access these controls from **Setup > Phase Reference**.

- **Off**: Turns off the phase correction timebase, so that the instrument uses its internal timebase.
- **Untriggered**: Enables the phase correction timebase, but runs it in an untriggered mode in which the trigger is ignored for purposes of determining the horizontal acquisition window (for example, when displaying a signal as an eye diagram or for signals with a phase reference clock > 15 GHz).
- **Triggered**: Enables phase correction where the clock trigger source is used to determine the horizontal acquisition window.
- **Spread Spectrum Clocking (SSC)**: When operating in Triggered phase correction mode, selecting SSC enables the instrument to accommodate up to 5000 ppm of SSC (Spread Spectrum Clocking) applied to the Phase Reference input clock.

See Also:

- Phase Reference Clock Source Settings (see page 113)
- Phase Reference Setup Process (see page 116)
- Phase Reference Background (see page 117)

Phase Reference Clock Source Settings

Use these controls to set the phase reference clock source and frequency. Access these controls from **Setup > Phase Reference**.
Source: Sets the phase reference clock source. The instrument uses one Phase Reference Module at a time, although more than one source can be available (installed in the instrument).

Input Freq: Sets the phase reference clock signal frequency. The selected phase reference source must be synchronous to the input signal you are acquiring. You can use the Input Freq control to manually set the frequency value, or use the Standard Freq Table control to set the frequency based on communication standards that are available in the current instrument configuration. The value entered must be within 1% of the actual frequency of the clock.

The guaranteed and allowable frequencies for the Input Freq control depend on the characteristics of the selected phase reference clock source. For 820A4 modules:

- The standard 82A04 supports a guaranteed range of phase reference signals from 8 GHz to 25 GHz (the minimum/maximum allowable values are 2 GHz to 25 GHz).
- The Option 60G equipped 82A04 supports a guaranteed range of phase reference signals from 8 GHz to 60 GHz (the minimum/maximum allowable values are 2 GHz to 110 GHz).

Enter increments as fine as 1 MHz; the coarse-adjustment increment value is 100 MHz. The default frequency value is 10.3125 GHz, and out-of-range entries are coerced to the minimum/maximum allowable values stated above. For clock rates < 8 GHz it may be necessary to filter the phase reference clock signal to minimize clock harmonics in the clock signal.

NOTE. When there are multiple phase reference clock sources available (such as when multiple Phase Reference modules are installed), you can set the Input Frequency control independently for each clock source. The instrument stores and uses the values independently, depending on the selected reference clock source.

Standard Freq Table: Sets the frequency from a communications standard in the drop-down menu. Selecting a standard sets the Input Frequency control to that frequency. If you manually change the Input Frequency control, it overrides this control.
- **Characterize**: Runs the clock characterization process. You must run a characterization before using the phase reference clock for measurements. This button is selectable when the phase correction mode is Untriggered or Triggered.

- **Characterization status readout**: Displays the status of the phase reference clock characterization. The status messages are:
  - **Pass**: The phase reference clock signal has been successfully characterized and is stable.
  - **Fail**: Characterization failed. Make sure that you have a stable, valid clock connected, have set a correct input frequency, and then rerun characterization. If Fail status still results, you may be providing a faulty or an out-of-range clock.
  - **Required**: This status indicates that you need to characterize the selected phase reference clock source. Either you have not run a successful characterization since you connected the clock and turned phase correction on, or you have changed the clock input, or the clock has varied in amplitude, offset, or shape since the last characterization. In any of these cases, make sure that you have a stable, valid clock connected and the correct input frequency specified, and then use the Characterization button to run characterization.

**See Also:**

Phase Correction Settings (see page 113)
Phase Reference Setup Process (see page 116)
Phase Reference Background (see page 117)
Phase Reference Setup Process

⚠️ **CAUTION.** To avoid input connector damage, you must use the proper adapter to connect a K (2.92mm), a 3.5mm, or a SMA cable to the 82A04 input, which is a 1.85mm interface (V-connector). All 82A04 Phase Reference Modules are shipped with such an adapter installed on their inputs, and capped with a 50 Ω termination.

1. Connect the input signal to a sampling module channel.

2. To use Triggered Phase Correction, connect an appropriate trigger signal to the CLOCK INPUT/PRESCALE TRIGGER front panel input and set up the trigger controls to trigger on that signal. See Mode/Trigger Setup Dialog Box Overview (see page 129).

3. Connect a clock to the **Phase Clock** input of the 82A04 module.

**NOTE.** The phase reference clock must be synchronous to the input signal.

4. Click **Setup > Phase Reference** to display the Phase Reference dialog box.

5. If more than one 82A04 module is installed, click the **Source** control and select the module to which you connected the phase reference clock signal.

6. Do either of the following:
   - Use the **Input Freq** control to enter the frequency of the phase reference clock signal connected to the module. The value entered must be within 1% of the actual frequency of the clock.
   - Click **Select Freq Table** and select the communications standard that is appropriate for the phase reference clock signal connected to the module.
     Setting one of these controls overrides the other; the last value set determines the frequency that is used.

7. Turn Phase Correction on by checking the **Triggered** box.
Phase Reference Background

Use phase reference correction when you need to acquire signals with ultra low jitter. Using a phase correction reference clock effectively reduces trigger jitter in the instrument, which lets you measure clock and other noise (jitter) with more fidelity.

See Also:

- Phase Reference Keys Points (see page 117)
- Phase Reference Caveats (see page 119)
- Phase Reference Characterization Status (see page 120)

Phase Reference Keys Points

The following key points describe operating considerations for setting up and using phase correction modes and clock sources.

- **When to use**: Use Phase Correction when you need the highest timing fidelity for measurements on input signals. Phase correction, when on, uses a phase-reference clock you supply to change the timebase (thereby altering the sampling and acquisition process) of the main instrument so that jitter measured using this “phase-corrected” timebase is the jitter between the data and your clock. With little instrument trigger jitter present, the phase-corrected acquisitions increases the timing fidelity of your measurements.

- **Untriggered mode**: Select the Untriggered Mode when you want acquired waveforms that are phase corrected, but not acquired relative to a trigger, such as when displaying communication signals as eye diagrams, or when the frequency of your phase correction clock signal is higher than the frequency at which the CLOCK INPUT/PRESCALE TRIGGER front panel input can operate.

- **Triggered mode**: Select Triggered mode when you want acquired waveforms that are phase corrected and acquired relative to a trigger event or reference. Sampling is still random around the trigger event. Use this mode when in Pattern Clock triggered mode to examine serial data patterns with very low jitter or for multi-phase eye diagrams when in Eye Clock triggered mode.

- **Spread Spectrum Clocking (SSC)**: Enable SSC support when you want acquired waveforms that are phase corrected, but acquired relative to a trigger event that is using a Spread Spectrum Clocking signal. Sampling is still random around the trigger event.

- **Phase Reference requires a clock**: You must connect a phase-reference clock to the selected phase reference clock input source. The instrument then measures the phase reference clock signal to derive the timebase, which is one period of the reference clock. Whenever samples are taken on any (or all) of the acquisition-module channels, the Phase Reference Module simultaneously measures the phase of the supplied reference clock. The instrument uses the phase information to horizontally position the associated data properly in the waveform record.
Clock frequency required: Because time is now measured as periods of the reference clock, you must also enter the frequency of the reference clock so that the instrument can translate period intervals back to time intervals for display and measurement purposes.

Characterization required: Once you have connected a clock and entered its frequency, you must have the instrument characterize it. After running the characterization, you can determine its results by reading the status in the Phase Reference Setup dialog box. See Characterization Status for status definitions.

Horizontal position and scaling: The phase-corrected timebase treats horizontal position and scale changes differently for Untriggered versus Triggered phase-correction settings. See the Untriggered and Triggered Modes descriptions for more information.

See Also:

Phase Reference Caveats (see page 119)
Phase Reference Characterization Status (see page 120)
Phase Reference Caveats

- **Save/Recall settings**: All settings related to the phase-reference timebase mode will be saved and recalled with other instrument settings. These include the reference clock frequency, the phase horizontal position, whether phase-reference mode is turned on, whether Triggered or Untriggered mode is selected, and whether SSC support is enabled.

- **Extender cable usage**: The Phase Reference Module meets all of its specified requirements when operating with an extender cable.

- **Distance units**: When turned on (Untriggered or Triggered mode), phase correction disables selection of horizontal units of distance (inches, feet, or meters). Attempting such a selection displays an error message, and the instrument ignores the units change.

- **Simultaneous operation**: You can only use one module at a time as a phase reference clock source. You can install multiple phase reference modules and select which one to use.

- **Mag views**: In Untriggered mode, Mag views are not separate from main acquisitions, as they are in normal timebase mode. Instead, the data displayed in a Mag view is placed in the Mag view acquisition record with the precision specified by the horizontal scale and record length of the Mag view.

- **Clock characterization**: Characterization data is not saved during a save setup operation.

- **TDR**: When phase-reference mode is enabled, TDR steps are turned off. Turning on a TDR step when the phase-reference timebase is active displays an error message. Selecting a TDR preset in the TDR Setup dialog box coerces phase-reference mode to Off.

- **Trigger source mode changes coerce Phase Reference modes**: The following coercions apply to changing the Trigger Source:
  - Changing to TDR or Direct trigger source coerces the phase reference mode to Off
  - If phase reference is enabled, changing to Free Run / Untriggered Phase Ref trigger source coerces the phase reference mode to Untriggered.
  - If phase reference is enabled, changing to Clock trigger source coerces phase reference mode to Triggered.

- **Distance horizontal units**: Enabling phase reference coerces the units to time(s) if the current setting is distance (m, in, or ft). If the horizontal units are bits, they are not coerced.

**See Also:**

- Phase Reference Keys Points (see page 117)
- Phase Reference Characterization Status (see page 120)
Phase Reference Characterization Status

The phase-reference characterization status of the selected phase reference source is shown in the Phase Reference Module controls of the Phase Reference setup dialog box. The status is either Required, Pass, or Fail:

- **Pass**: The clock signal connected to the specified phase reference clock input source has been successfully characterized and has since been stable.

- **Required**: The clock signal connected to the specified phase reference clock input source needs to be characterized. Either you have not run a successful characterization since you connected the clock and turned phase correction on, you have changed the clock input, the clock has changed in amplitude, offset or shape, or you have changed one or more of the following settings:
  - Recalled a setup
  - Recalled the Factory/Default setup
  - Compensated the main instrument
  - Recalled a main instrument compensation
  - Changed the Trigger source
  - Changed the Clock recovery source when trigger source is clock recovery
  - Changed the Clock recovery rate, fixed selection, or user adjustable for the selected clock recovery channel when trigger source is clock recovery
  - Changed phase reference input frequency
  - Compensated the selected Phase Reference Module
  - Recalled Phase Reference Module compensation

- **Fail**: Characterization has failed. Make sure of your clock and rerun characterization. If Fail status still results, you may be providing a faulty clock or one that mismatches the clock frequency that you set in the Phase Reference Setup dialog box.

In the case of Required status, make sure that you have a stable, valid clock connected, and then run characterization again.

See Also:

- Phase Reference Keys Points (see page 117)
- Phase Reference Caveats (see page 119)

TDR Setup Dialog Box Overview

These controls set up the TDR channel parameters. Access these controls from Setup > TDR.
Use these controls to:

- Preset any TDR channel individually or as a differential pair. Presetting a single channel turns on the TDR step generator for the selected channel and positions the signal to see the incident edge of the TDR step signal. The Diff(erential) Preset button automatically sets the two steps of the two channels to opposite polarities.

**TIP.** Presetting any TDR channel changes the Trigger Source to the internal TDR clock.

- Select the polarity and turn on TDR steps for all valid TDR-capable channels.
- Turn on the acquisition and display of any channel.
- Deskew TDR steps in dual channel TDR modules.
- Use the TDR Autoset to automatically adjust instrument settings to display the reflected TDR edge on screen.
Control Information:

- **TDR Preset Settings** (see page 122)
- **TDR Step Settings** (see page 124)
- **TDR Acquisition Settings** (see page 125)
- **TDR Step Deskew Settings** (see page 126)
- **TDR Turn Off All Steps** (see page 127)
- **Advanced TDR Setup** (see page 127)

## TDR Preset Settings

Use this control to preset values for TDR operation. Access these controls from **Setup > TDR**.

Click the button corresponding to the channel for which you would like the instrument to do a TDR preset. A TDR preset on any channel makes the following changes:

- Turns the acquisition and display on for the selected channel.
- Turns the TDR step on for the selected channel (with the selected step polarity).
- Sets the vertical scale, offset, and position for the selected channel such that the vertical region corresponding to the front-panel connector is placed approximately at center screen (vertically). The actual settings vary based on the selected TDR units (Volts, Rho, or Ohms).
- Sets the horizontal scale and position such that the incident TDR step is on screen.
- Sets the trigger source to TDR. The internal TDR clock rate is not changed.
Sets the channel bandwidth to the maximum capability of the module. You can reset the bandwidth (from the Vertical setup tab) after the preset.

Channels that are not TDR-capable or that have external accessories attached (for example, probes) cannot be preset.

To preset a pair of channels for a differential measurement, click the Diff button between the pair. In addition to presetting the individual setting changes described above, clicking Diff presets the steps to be of opposite polarity. The odd channel has a positive-going step, while the even channel has a negative-going step. The channel pair must be two channels present in a single TDR-capable module.

**TIP.** If TDR is the selected Trigger Source and a TDR capable channel is selected, you can perform a single or differential TDR preset from the buttons that appear on the main Toolbar.

See Also:
- TDR Setup Dialog Box Overview (see page 120)
- TDR Step Settings (see page 124)
- TDR Acquisition Settings (see page 125)
- TDR Step Deskew Settings (see page 126)
- TDR Turn Off All Steps Settings (see page 127)
- Advanced TDR Setup (see page 127)
**TDR Step Settings**

Use these controls to turn on channels for TDR steps and set step polarities. Access these controls from **Setup > TDR.**

- **On**: Sets or clears the TDR step generator for a particular channel. Click the On box to the right of the selected channel. A check mark in the box means the step generator is on for that channel. To turn the step generator off, clear the check box.

- **Polarity**: Sets the polarity (rising or falling edge) of the step generator for the selected channel. Click the Polarity button (昇).

**See Also:**
- TDR Setup Dialog Box Overview (see page 120)
- TDR Preset Settings (see page 122)
- TDR Acquisition Settings (see page 125)
- TDR Step Deskew Settings (see page 126)
- TDR Turn Off All Steps Settings (see page 127)
- Advanced TDR Setup (see page 127)
TDR Acquisition Settings

Use these controls to turn channels on and off and set units for active TDR steps. Access these controls from Setup > TDR.

- **On**: Enables or disables a channel. Click the On box to the right of the selected channel- a check mark in the box indicates the channel is selected. To disable a channel, clear the check box.

- **Units**: Set the measurement units of the selected channel acquisition. Use the pulldown list to select the units. These units apply only when the channels TDR step is On (that is, the channels vertical units setting is overridden).

**See Also:**

- TDR Setup Dialog Box Overview (see page 120)
- TDR Preset Settings (see page 122)
- TDR Step Settings (see page 124)
- TDR Step Deskew Settings (see page 126)
- TDR Turn Off All Steps Settings (see page 127)
- Advanced TDR Setup (see page 127)
TDR Step Deskew Settings

Use these controls to manually adjust TDR step skews between channels in a sampling module. Access these controls from Setup > TDR.

Select the channel from the pulldown list.

A TDR module with single channel adjustment allows you to adjust the step of the even numbered channel (of the channel pair). A TDR module with dual channel adjustment allows you to adjust the step of both channels of the module.

Use the field arrows (or click the keypad icon to display the pop-up keypad) to set the deskew percent value. Increasing the value skews the edge out further in time, while decreasing the value does the opposite.

You can modify the resolution of the increment/decrement operation by selecting the front panel Fine button.

See Also:
- TDR Setup Dialog Box Overview (see page 120)
- TDR Preset Settings (see page 122)
- TDR Step Settings (see page 124)
- TDR Acquisition Settings (see page 125)
- TDR Turn Off All Steps Settings (see page 127)
- Advanced TDR Setup (see page 127)
TDR Turn Off All Steps Settings

Use this control to turn off all TDR step generators. Access these controls from Setup > TDR.

To Use
Click the Turn Off All Steps button to automatically turn off all TDR steps at once.

See Also:
- TDR Setup Dialog Box Overview (see page 120)
- TDR Preset Settings (see page 122)
- TDR Step Settings (see page 124)
- TDR Acquisition Settings (see page 125)
- TDR Step Deskew Settings (see page 126)
- Advanced TDR Setup (see page 127)

Advanced TDR Setup

These controls set up the TDR step signal rate, define the source for the TDR reference clock, and enable/disable display of the incident edge on the screen. Access these controls from Setup > TDR > Advanced TDR Setup.
- **TDR Step Rate**: Sets the TDR step signal rate. You can select 25 kHz, 50 kHz, 100 kHz, 200 kHz, or 300 kHz, or enter any value between 25 and 300 kHz in 1 kHz increments. The actual TDR step rate may vary by up to 4% from the specified value. Use a lower TDR step rate to take measurements on long cables.

- **TDR 10MHz Reference**: Sets the TDR 10 MHz reference clock source to internal (default) or external.

- **TDR Autoset Option**: Enable or disable the display of the incident edge portion of the TDR waveform.

### TDR Autoset Overview

A TDR autoset automatically changes the instrument settings to show the reflected or incident TDR edge on screen. A TDR Autoset also makes the following setting changes:

- Trigger Source to internal TDR clock
- FrameScan to OFF
- Phase Correction to OFF
- Acquisition mode to Average (count=16)
- Display Style to Show Vectors
- TDR Step to ON (for the selected channel)
- TDR rho units
  - Vertical Scale to 500 mRho/div
  - Vertical Position to 0 divisions
Controls-specific help

Mode/Trigger Setup Dialog Box Overview

- TDR volts units
  - Vertical Scale to 100 mV/div
  - Vertical Position to 0 divisions
  - Vertical Offset to 250 mV

- TDR ohms units
  - Vertical Scale to 10 ohms/div
  - Vertical Position to -5 divisions

See Also:

TDR Setup Dialog Box Overview (see page 120)
TDR Preset Settings (see page 122)
TDR Step Settings (see page 124)
TDR Acquisition Settings (see page 125)
TDR Step Deskew Settings (see page 126)
TDR Turn Off All Steps Settings (see page 127)

Mode/Trigger Setup Dialog Box Overview

Use these controls to set up data acquisition mode/trigger parameters. Access these controls from Setup > Mode/Trigger or by pushing the Trigger MENU front panel button. You can also use the front-panel knobs to set the most often-used trigger parameters.
These controls do the following:

- Select the trigger source (clock, TDR, Direct, or Free Run).
- Select the Scope mode (when the trigger source is Clock).
- Set synchronous pattern and FrameScan trigger parameters.
- Set advanced trigger parameters.

Triggering is global, with each trigger initiating the acquisition of all active channels simultaneously.

The trigger event is the absolute time reference for each sample and, therefore, the entire waveform. Each recognized trigger event causes the acquisition system to take one waveform sample. Since only one sample is acquired per trigger, a complete waveform record requires as many triggers as the number of samples in the record.

See Also:

- Trigger Source Settings (see page 131)
- Scope Mode (Clock Trigger Source) (see page 133)
- Clock Recovery Outputs (see page 133)
- Pattern Sync/FrameScan Setup Dialog Box (see page 134)
Trigger Source Settings

The trigger source sets the trigger source signal type. Access these controls from Setup > Mode/Trigger or by pushing the Trigger MENU front panel button. You can also use the Trig control in the toolbar to select from these trigger sources.

- **Clock**: Sets the instrument to trigger from a specified clock signal:
  - A clock signal connected to the CLOCK INPUT / PRESCALE TRIGGER connector on the front panel of the instrument. The input coupling mode is AC and the Level and Slope controls are disabled. Triggering is guaranteed with signals up to 15 GHz (and will typically work with signals up to 20 GHz).
  - A clock signal derived from an installed optical or accessory module with clock recovery capability. Select both the channel to trigger on (if more than one module contains clock recovery) and the desired clock recovery rate (for the selected channel). By default, when Clock Recovery is selected as the trigger source, the instrument automatically selects its highest rate.

- **TDR**: Sets the instrument to trigger on an internally-generated clock signal for TDR measurements. Selectable clock rates are 25 kHz, 50 kHz, 100 kHz, 200 kHz, and 300 kHz. In addition, you can set the TDR step rate to any value from 25 kHz to 300 kHz in 1 kHz steps. The actual TDR step rate may vary by as much as 4% from the requested rate. Use this type of trigger source with TDR to synchronize the generation of TDR step pulses with the subsequent acquisition. The front panel TDR Clock Out connector provides a sample of the internal TDR clock.
- **Direct**: Sets the instrument to trigger on an external signal that is connected to the TRIGGER DIRECT INPUT connector on the front panel. The input coupling mode is DC and triggering is usable with signals up to at least 3.0 GHz. The Direct trigger source trigger signal must:
  - Transition through the voltage threshold level set by the trigger level control.
  - Transition in the direction (positive or negative) set by the Slope setting.
  - Be External Direct; the trigger level setting only affects this trigger source. With any other trigger source selected, the instrument sets the trigger level automatically, depending upon the source selected.
  - Trigger level settings outside the trigger signal range cause the instrument to lose triggering (see Trigger mode).

- **Free Run/Untriggered Phase Ref**: Sets the instrument to free run (untriggered) acquisition mode. Use Free Run to quickly validate signal presence and amplitude of input signals. Select this Trigger Source to operate in Untriggered Phase Reference mode. See **Phase Reference Setup Dialog Box Overview** (see page 110) for more information.

  Click [here (see page 132)](#) for information on probe usage.

---

### Trigger Setup and Probes

There is an input connector that allows you to attach a TekProbe™ compatible probe (Level 1 or 2 only) to the external direct trigger source input. It acts as a pre-conditioner for the trigger circuit just as other probes do for the vertical inputs. As a result, the trigger probe may affect the trigger behavior of the trigger level range, resolution, and units. The probe can have the same basic capabilities as probes on channel inputs such as probe offset. As a result, treatment of parameters that apply to the trigger input is the same as those for channel inputs:

- Trigger level is adjusted through the offset of the trigger probe instead of the acquisition trigger level (if the probe has offset capability).
- On probe changes of different types, the instrument attempts to keep the same absolute trigger level.

---

**See Also:**

[Mode/Trigger Setup Dialog Box Overview (see page 129)](#)
[Scope Mode (Clock Trigger Source) (see page 133)](#)
[Clock Recovery Outputs (see page 133)](#)
[Pattern Sync/FrameScan Setup Dialog Box (see page 134)](#)
[Advanced Trigger Setup (see page 139)](#)
**Scope Mode (Clock Trigger Source)**

These controls set the instrument trigger algorithm based on the target signal type to measure (if the trigger source is a front panel CLOCK INPUT / PRESCALE TRIGGER input or internal clock recovery). The acquired signal must be synchronous to the selected clock source for all of these scope trigger modes. Access these controls from **Setup > Mode/Trigger** or by pushing the Trigger **MENU** front panel button.

- **Eye**: Sets the triggering to display the acquired data as an eye diagram overlaying all of the acquired data bits with minimal clock to data jitter.
- **Pattern**: Sets the triggering to display the individual bits as a bit stream, with minimal clock to data jitter. Pattern mode is only available if the DSA8300 has the ADVTRIG option enabled.
- **Other**: Sets the triggering to display the acquired data showing the effects of any clock modulation (such as Spread Spectrum Clocking).

The Eye and Pattern clock trigger modes provide the lowest intrinsic instrument jitter (typically 400 fsec) on up to eight channels simultaneously. This low intrinsic jitter is accomplished by acquiring clock synchronous data relative to each nearest preceding clock edge. This technique avoids jitter accumulation that is typical from acquiring the data relative to a distant trigger edge.

**See Also:**
- Mode/Trigger Setup Dialog Box Overview (see page 129)
- Trigger Source Settings (see page 131)
- Clock Recovery Outputs (see page 133)
- Pattern Sync/FrameScan Setup Dialog Box (see page 134)
- Advanced Trigger Setup (see page 139)

**Clock Recovery Outputs**

These controls set the instrument to trigger on a recovered clock signal from an optical sampling module that supports clock recovery. Access these controls from **Setup > Mode/Trigger** or by pushing the Trigger **MENU** front panel button.
Clock Recovery Outputs: Sets the instrument to trigger on a recovered clock signal from an optical sampling module. This trigger source requires an optical sampling module or accessory module with clock recovery capability. Click the button for the channel to trigger on (if more than one module contains clock recovery) and select the clock recovery rate. By default, when Clock Recovery Output is selected as the trigger source, the instrument automatically selects the lowest channel with clock recovery and selects its highest rate.

You may be able to set a custom clock recovery rate. If the Define button is selectable, then the optical sampling module(s) providing the C1 or C2 channel input supports custom clock-recovery rate selection. Select USER from the clock-recovery rate selector and then click the Define button to open a dialog box for specifying a custom clock-recovery rate. Click here (see page 134) for more information.

Whenever a channel’s clock recovery rate is set to something other than None, the recovered clock signal is enabled for output on the front-panel connectors of the module. However, when the trigger source is changed from Clock Recovery to another source, the clock recovery rate for all channels is set to None (which disables the clock signals to the front-panel connectors). You may re-enable the clock signals to the front panel of the module by re-selecting a rate other than None (even though Clock Recovery is no longer the trigger source).

User Clock Recovery Rate

Click the Define button to open the User Clock Recovery Rate dialog box, which lets you select a clock recovery rate within the limits of the range specified on the control. The range available depends on the module installed.

The Define button is disabled if the module installed does not support User Clock Recovery Rate selection.

See Also:

Mode/Trigger Setup Dialog Box Overview (see page 129)
Trigger Source Settings (see page 131)
Scope Mode (Clock Trigger Source) (see page 133)
Pattern Sync/FrameScan Setup Dialog Box (see page 134)
Advanced Trigger Setup (see page 139)

Pattern Sync/FrameScan Setup Dialog Box

The Pattern Sync/FrameScan Setup dialog box contains the controls for setting data pattern synchronization data autosynchronization, and FrameScan parameters. These controls are accessed from Setup > Mode/Trigger > Pattern Sync/FrameScan Setup.
See Also:

- FrameScan Overview (see page 82)
- Pattern Sync Controls (see page 135)
- AutoSync Options (see page 137)
- FrameScan Controls (see page 138)

**Pattern Sync Controls**

These controls are accessed from **Setup > Mode/trigger > Pattern Sync/FrameScan Setup**. Pattern Sync functions require Opt ADVTRIG

- **Data Rate**: Sets the data rate of the signal. Enter a value in the field or click the List button and select a data rate based on a communication standard. If the list does not contain an exact match for your
signal data rate, enter your data rate manually in the field. An incorrect data rate value can adversely affect trigger bit movement and FrameScan operations.

- **Pattern Length**: Sets the pattern length for the frame rate of the signal. Enter a value in the field or click the List button and select a value based on pattern type (PRBS, K28.5, CJPAT, and so on).

- **Data:Clock Ratio**: Sets the ratio between the measurement signal data to the clock signal applied to the CLOCK INPUT/PRESCALE TRIGGER connector. Use the up/down arrows on the field to select a ratio or click the Edit button and enter the ratio values in the dialog box.

- **Main Position**: This control provides you easy access to the horizontal delay position for the Main Timebase. See Horizontal Setup Dialog Box Overview (see page 66).

- **Clock Source**: Sets the signal clock source from available sources.

---

⚠️ **CAUTION.** Entering the incorrect value for Data Rate or Data:Clock Ratio can result in the loss of triggering.

---

**NOTE.** For highest reliability and acquisition speed, manually enter as many control values as possible. Unselect (uncheck) the associated check box in the AutoSync Options area to allow manual value entry.

---

**See Also:**

- Pattern Sync/FrameScan Setup Dialog Box (see page 134)
- AutoSync Options (see page 137)
- FrameScan Controls (see page 138)
AutoSync Options

The AutoSync Options let you select which pattern data characteristics (Data Rate, Pattern Length, and Data:Clock Ratio) the instrument uses to automatically detect and use for acquisition and measurements. The default value is all AutoSync Options enabled.

These controls are accessed from **Setup > Mode/trigger > Pattern Sync/FrameScan Setup**.

The AutoSync options are linked to the associated fields in the Pattern Sync Control area. Unselecting an AutoSync option enables the associated Pattern Sync Control field for entering values. See the Pattern Sync Controls topic for more information.

**NOTE.** *Pattern Sync functions require Opt ADVTRIG.*

The **AutoSync to Selected Waveform** button attempts to automatically detect and fill in the Data Rate, Pattern Length, and Data Clock Ratio control values for the selected options. For example, the figure shows that Data Rate and Data:Clock Ratio options are selected, and the Pattern Length option as unselected. Clicking AutoSync to Selected Waveform causes the instrument to attempt to determine the Data Rate and Data:Clock ratio values based on the CLOCK INPUT/PRESCALE TRIGGER clock signal and the selected waveform. Since the Pattern Length option is not checked, the manual control determines that setting.

**See Also:**
- Pattern Sync/FrameScan Setup Dialog Box (see page 134)
- Pattern Sync Controls (see page 135)
- FrameScan Controls (see page 138)
FrameScan Controls

The FrameScan controls enable FrameScan functionality and setting the scan bit parameter. These controls are accessed from Setup > Mode/trigger > Pattern Sync/FrameScan Setup.

- **Enabled**: Starts scanning as soon as you select this check box.
- **Scan Bits**: Sets the number of bits or subframes to acquire.
- **Reset**: Restarts the FrameScan acquisition.

FrameScan acquisitions provide detailed display and analysis of individual, complete waveforms or of the bit sequences leading up to a failure. This ability to identify the specific patterns that caused the failures makes FrameScan mode superior to traditional methods. Traditional methods, such as eye diagrams and bit-error testing to find the total number of errors in a frame, are time consuming to use and neither can examine in detail the pattern driving the failure.

FrameScan enables you to acquire and analyze repeating digital data streams that are contained within a repeating data “frame.” FrameScan is an acquisition technique that controls how successive acquisitions occur. It can be used with any trigger source that provides a “framing” signal (a signal synchronized to one location within the repetitive data stream) sometimes called Frame Sync or Frame Trigger.

FrameScan acquisition automatically sequences or skews the timebase such that each bit, or unit interval, of the data stream is acquired in increasing time order. The acquisition of each sample of each bit, and of each bit of the desired bit stream, is based on the trigger events derived from an externally provided Frame Sync or Frame Trigger signal, such as that provided by a pattern generator or a bit error rate tester (BERT). Because the sequencing or “scanning” of the timebase occurs automatically within the instrument, there is no need to interact with the external signal source or the instrument once they are appropriately set up.

One of the primary uses of FrameScan is in finding pattern-dependent anomalies. This is done by using FrameScan in conjunction with the Mask Testing and Acquisition Stop After features (specifically the Stop After mask hits condition).

See Also:

- FrameScan Overview (see page 82)
- Pattern Sync/FrameScan Setup Dialog Box (see page 134)
- Pattern Sync Controls (see page 135)
- AutoSync Options (see page 137)
- Mask Setup Dialog Box Overview (see page 86)
Advanced Trigger Setup Controls

These controls refine instrument trigger conditions. These controls are accessed from Setup > Mode/Trigger > Advanced Trigger Setup.

- **Set to 50%**: Sets the trigger level to 50% of the trigger signal on the TRIGGER DIRECT INPUT connector. This function is also available from the SET TO 50% front panel button.

- **Slope**: Sets the instrument to trigger on either positive (rising edge) or negative (falling edge) of the signal present on the TRIGGER DIRECT INPUT connector. This instrument provides edge-based triggering, in which the edge of a trigger source signal must pass through the trigger level threshold to generate a trigger event for acquiring a waveform sample. The slope setting is only available for Direct trigger sources.

- **Enhanced Triggering**: Noise Reject sets the effective trigger hysteresis band. Enabling Noise Reject increases the hysteresis band and is typically better for triggering on lower frequency or noisy signals. Disabling Noise Reject reduces the hysteresis band and is typically better for triggering on higher frequency signals. This setting is only available for the TRIGGER DIRECT INPUT.

- **Holdoff**: Sets the trigger holdoff, which is the time the instrument waits before arming the trigger system to recognize the next trigger event. Holdoff can help achieve stable triggering. See Trigger Holdoff Reference (see page 140) for more information.

- **TDR 10MHz Reference** Sets the reference clock source for TDR measurements to either internal (instrument) or external (EXTERNAL 10MHz REFERENCE INPUT connector).
See Also:

Trigger Background (see page 141)

Trigger Holdoff Reference Guidelines

The holdoff control/readout indicates the trigger holdoff value in use by the instrument.

The instrument maintains two holdoff settings: the requested holdoff value and the actual holdoff value. For a variety of reasons, the holdoff value you enter (that is, your requested holdoff) may not be a valid operational value. Under these conditions, the instrument automatically calculates and uses a minimum valid actual holdoff value while retaining your requested holdoff value for use if it becomes a valid operational value.

There are two factors that determine the minimum acceptable holdoff value at any given time:

- **Hardware restrictions**: There is a minimum time required from the acceptance of one trigger event until the next due to both trigger rearm time and maximum sample rate requirements. These result in an absolute minimum holdoff setting of 5 μs (given appropriate instrument settings).

- **Time of last sample**: The instrument must use a holdoff setting that is at least greater than the time from the trigger event to the farthest sample in any waveform acquisition. For example, if you have the time/div set to 1 us/div with the horizontal timebase position set to minimum (about 19 ns), the operational (actual) holdoff must be greater than: 19 ns + 1 μs/div*10 div = 10.019 μs (the previously mentioned hardware restrictions cause the instrument to increase this value).

Instrument settings that affect the instrument’s determination of the minimum actual holdoff include:

- Horizontal scale (time/div)
- Horizontal position
- Horizontal FrameScan settings (when FrameScan is enabled)
- User (Channel) deskew

See Also:

Advanced Trigger Setup (see page 139)

Trigger Background (see page 141)
Trigger Background

This topic contains reference information about the triggering setup dialog box features. This information can help you more effectively use these controls and features.

To properly acquire waveforms (to sample a signal and assemble it into a waveform record) you need to set up the instrument trigger conditions. This instrument supports a number of triggering modes as described in the topics that follow. You must provide an external trigger source, except when using clock-recovery triggering from an optical or accessory sampling module equipped with the clock-recovery option, or when using the internal clock (such as for TDR measurements or when doing asynchronous “free-run” acquisitions).

Purpose

Use triggering controls to control the acquisition window, so that the instrument acquires the waveform data you want. The trigger event, when synchronized to the input signal, defines the horizontal acquisition window. By choosing the trigger event and adjusting the horizontal position (delay between trigger event and the horizontal reference point), you control the location in the data stream (the input signal) from which the waveform record is taken.

See Also:

- Triggering Key Points (see page 141)
- Trigger Sources (see page 143)
- Triggering Process Overview (see page 145)

Triggering Key Points

These key points describe operating considerations for setting up to trigger on your waveforms.

- Clock recovery: If you use optical or accessory sampling modules that include a clock-recovery option, you can use this recovered clock to trigger the instrument for specific DATA rates and
formats that are compatible with the specific CR option in the module. Also, if you use modules that support continuous-rate clock recovery, you can specify any custom clock-recovery rate within the range supported by the module. Refer to the Tektronix catalog to see those modules that support continuous-rate clock recovery.

- **Triggering is global**: The instrument uses the trigger event to acquire across all active channels. This same trigger is also common across all time bases currently active (one or more of Main, Mag1, and Mag2).

- **Edge-Trigger type**: This instrument supports edge triggering only, in which edge triggers gate a series of acquisitions.

The slope control determines whether the instrument recognizes the trigger point on the rising or the falling edge of a signal edge. See the following figure. You can set the trigger slope from the toolbar at the top of the display or in the Trigger Setup dialog box.

The level control determines where on that edge the trigger point occurs. The instrument lets you set the trigger level from the front panel with the Trigger LEVEL knob.

Slope and Level Define the Trigger Event

![Slope and Level Diagram](image)

Triggered Versus Untriggered Displays

![Triggered vs Untriggered Waveforms](image)
Trigger Sources and Modes

Trigger Sources

The trigger source specifies the signal that the trigger system monitors. The source can be:

- A clock signal used for acquiring optical or electrical serial data streams. The clock source can be internal or external to the instrument:
  - An internal clock-recovery trigger is provided by either an optical sampling module that is equipped with a clock-recovery option, or a dedicated electrical clock recovery module. Available clock recovery triggering rates depend on the sampling module. For example, the 80C08C Optical Sampling Module with option CR4 provides internal clock-recovered triggers for any (standard or custom) data rate from 8.5 Gb/s to 12.5 Gb/s.
  - An external clock-recovery trigger is provided by a clock signal connected to the Clock Input/Prescale Trigger front panel connector. Triggering is guaranteed for clocks from 150 Mb/s up to 15 Gb/s (and will typically work up to 20 Gb/s).

- The instrument TDR clock, with selectable TDR step repetition rates. The TDR CLOCK OUT connector on the instrument front panel supplies a replica of the TDR clock.

- A low-repetition rate signal (DC to 3 GHz) connected to the External Trigger Direct input. While this trigger source can be used to acquire serial data signals at rates up to 3 Gb/s, its primary use is for low repetition rate (<150 MHz) signals or for signals where you need additional conditioning of the input trigger signal (such as trigger level, slope, and so on). This flexibility comes at the cost of increased instrumentation jitter.

- An internal clock for Free Run acquisition of signals. Since the acquired signals are not synchronous with the trigger, this trigger source is useful primarily for locating a signal or clock and applying the appropriate offset to the data or trigger for proper synchronous waveform acquisition.

Clock Trigger Modes

When the selected trigger source is Clock (Internal Clock recovery or external Clock Input/Prescale Trigger input), you must select a Trigger Mode: Eye; Pattern; or Other.

- Select Eye mode if the signal you are acquiring is synchronous with the selected clock source and you wish to display the acquired data as an “eye diagram” overlaying all of the acquired data bits with minimal clock to data jitter.

- Select Pattern mode if the signal you are acquiring is synchronous with the selected clock source and you wish to display the individual bits as a “bit stream”, with minimal clock to data jitter.
Controls-specific help

**NOTE.** Pattern mode is only available if the ADVTRIG option is enabled on your instrument.

- Select **Other** mode if the signal you are acquiring is synchronous with the selected clock source and you want to display the acquired data showing the effects of any clock modulation (such as Spread Spectrum Clocking).

### Trigger Inputs

Use a trigger source that is synchronized with the signal you are sampling.

**Trigger source and ESD.** Observe static precautions when connecting trigger sources to this instrument.

**CAUTION.** Electrostatic-static damage can permanently degrade and damage the inputs to this instrument, its sampling modules, and accessory probes. You must take proper precautions; please read your sampling module user manual for more information.

### Trigger source connectors.

External triggers can be connected to either the TRIGGER DIRECT INPUT or CLOCK INPUT/PRESCALE TRIGGER connectors on the front panel:

- Signals connected to the CLOCK INPUT/PRESCALE TRIGGER connector may be pre-scaled (divided) by factors from 1 to 8 and then fed to the trigger circuits.
- Signals connected to the TRIGGER DIRECT INPUT connector are fed directly to the trigger circuitry. The signal is DC coupled and can be up to 3.0 GHz.

When using a given trigger source, you should disconnect any other trigger source from the front panel to ensure specified performance. Specifically:

- Do not connect a signal to the TRIGGER DIRECT INPUT or CLOCK INPUT/PRESCALE TRIGGER front-panel connectors unless you have selected that input as the trigger source.
- Do not connect a signal to the External 10 MHz Reference front-panel connector unless you have selected that input as the timebase mode in the Horizontal setup dialog box.
**Probe-to-Trigger source connection.** You can connect probes, such as the P6207 and P6209, to the TRIGGER DIRECT INPUT connector of the instrument. Observe all static precautions outlined in the documentation for the probe you choose while following these steps:

- Connect the probe-power connector to the TEKPROBE-SMA compatible probe (Level 1 or 2 only).
- Connect the probe signal connector (probe must have an SMA connector) to the TRIGGER DIRECT INPUT connector (not the CLOCK INPUT/PRESCALE TRIGGER connector).
- Connect the probe input to the signal that is to supply the trigger source.

The probe you attach preconditions the trigger signal for its input just as other probes do for the vertical inputs. More specifically, a probe attached to the TRIGGER DIRECT INPUT connector may affect trigger-level range, resolution, and units as follows:

- Trigger-level units will match those of the probe.
- The trigger level for probes that have offset control is adjusted by changing the offset of the connected probe and is limited by the range, resolution, and offset characteristics of the probe.
- When a connected probe is removed and a different probe installed, the instrument attempts to keep the same absolute trigger level as the current trigger-level setting.

Note that the probe parameters (range, resolution, offset scale, and units) that are relevant to the trigger circuit affect the Trigger Level control.

**Trigger Process Overview**

When a trigger event occurs, the instrument acquires a sample in the process of building a waveform record. The trigger event establishes the time-zero point in the waveform record and all samples are measured with respect to that event.

The trigger event starts waveform acquisition. A trigger event occurs when the trigger source (the signal that the trigger circuit monitors) passes through a specified voltage level in a specified direction (the trigger slope). When a trigger event occurs, the instrument acquires one sample of the input signal. When the next trigger event occurs, the instrument acquires the next sample. This process continues until the entire record is filled with acquired samples. Without a trigger, the instrument does not acquire any samples. This behavior differs from that of real-time acquisition systems, which can acquire a complete waveform record from a single trigger event.

**Holdoff**

Trigger holdoff can help stabilize triggering. When you adjust holdoff, the instrument changes the time it waits before rearming its trigger circuit after acquiring a sample. Before rearming, trigger circuitry cannot recognize when the next trigger conditions are satisfied and cannot generate the next trigger event. When instrument is triggering on undesired events (top waveform in the figure that follows), you adjust holdoff to obtain stable triggering.
At the longer holdoff time for the top waveform, triggering occurs at valid, but undesired, trigger events. With a shorter holdoff set for the bottom waveform, triggers all occur on the first pulse in the burst, which results in a stable display.

**Holdoff Adjustment Can Prevent False Triggers**

![Diagram showing holdoff adjustments]

**Usable holdoff limits:** The holdoff time the instrument can use varies within limits. The maximum holdoff the instrument can achieve is the 50 ms specified in instrument Specification.

The minimum holdoff used depends on hardware constraints, which do not change, and certain control settings, which you can control:

- The instrument hardware constrains the minimum usable holdoff time to the greater of the trigger-to-end-of-record time or 5 ms.
- The trigger-to-end-of-record time (EORT) is the time from the trigger event to the last sample in the waveform record and is calculated as:

  \[ EORT = \text{Horiz. Position} + (1-0.01 \times \text{Horiz. Ref.}) \times \text{Time/Div} \times 10 \text{ divisions})+ \text{ChannelDeskew} \]

  For example:

  \[ EORT = 6 \text{ ms} +(1-0.1(0.5) \times 1 \text{ ms/div} \times 10 \text{ div} +0 = 6 \text{ ms} + 5 \text{ m} =11 \text{ ms}, \text{ when} \]

  Horizontal position = 6 ms

  Horizontal Ref = 50% Time/Division = 1 ms/div Channel Deskew = 0 (set to minimum)

  In this example, because 11 ms is greater than 5 ms, the current control settings determine the minimum usable holdoff the instrument can use.
Requested versus actual holdoff: The instrument operates with two holdoff values:

- Requested - the last value requested in the Trigger Setup dialog box. You can set times from 5 ms to 50 ms, but the time requested becomes the actual time used only if it meets the requirements just described for Actual. Otherwise, the holdoff-time value requested is held for later use as described for Actual.

- Actual - in effect the holdoff time; that is, the time the instrument is using or will use when acquiring data. The instrument uses it when the minimum usable holdoff (determined as described in Usable Holdoff, above) is greater than the requested value. The instrument retains and changes to the requested value if the user changes control settings such that the requested value exceeds the minimum usable holdoff. Actual values can range from 5 ms to 55 ms.

Vertical Setup (Basic) Dialog Box Overview

Use this dialog box to set up the vertical acquisition parameters for acquiring signal channel waveforms and to set up the vertical display parameters for all waveforms. Access this control from Setup > Vertical or the front panel Vertical area MENU button.
This dialog box contains the controls for vertical setup of all live (channel) waveforms for acquisition display. It can set up vertical parameters for electrical or optical signals, depending on the module in use. This information addresses basic signal setup; refer to for information on setting up optical channels. To access the Vertical Optical Setup dialog box, click the Optical button at the bottom of the dialog box.

**TIP.** Push the Vertical MENU front panel button to quickly access this dialog box. You can also use the front-panel knobs to set the most often used vertical parameters.

**Control Information:**

- Waveform Selector Setting (see page 149)
- Vertical Scale Setting (see page 149)
- Vertical Position Setting (see page 151)
- Vertical Offset Setting (see page 151)
- Vertical Channel Deskew and Delay Settings (see page 153)
- Vertical Bandwidth Units Settings (see page 155)
- Vertical External Attenuation Setting (see page 156)
- Vertical DC Cal Setting (see page 157)
- Setup Optical Dialog Box Overview (see page 168)
Controls-specific help

Waveform Selector Setting

Access this control from **Setup > Vertical** or the front panel Vertical area MENU button.

Select a waveform for which you want to change the vertical settings. The list contains all available channel, reference, and math waveforms. You can also use the front-panel buttons to select a waveform.

After selecting a waveform, use the other dialog box elements to set the vertical parameters. Then check the On box to turn on the display of the waveform.

**TIP.** If you select a math waveform, the Define button is enabled. Click Define to define a new math waveform or edit an existing waveform.

Dependencies/Limitations

This control can also be used to select channel waveforms from optical sampling modules. This information covers basic signal setups; see **Vertical Setup (Optical)** for information on setting up optical channels.

See Also:

- Vertical Scale Setting (see page 149)
- Vertical Setup Basic Dialog Box Overview (see page 147)

Vertical Scale Setting

Access this control from **Setup > Vertical** or the front panel Vertical area MENU button.
Use the **Scale** field to set the scale value (per division) in a 1-2-5 pattern of increments. Selecting “fine” causes the control to increase or decrease the value by 1. You can also use the front-panel Scale knob to adjust the settings.

Each waveform (channel, math, and reference) has its own vertical scale parameter, expressed as a per division setting, that adjusts the display size of the selected waveform. The scale control provides graphical scaling *only*, even for the channel waveforms; it has no effect on the input vertical acquisition hardware. Increasing the scale causes the waveform to be displayed smaller. Decreasing the scale causes the waveform to be displayed larger.

Scale parameters apply to all waveforms, but affect channel waveforms differently from other waveforms. The range and resolution of scale values for a given channel waveform are dependent on the following factors:

- Sampling module type (specifically its input dynamic range)
- Probe type (if attached)
- External attenuation factor
- Selected units (if TDR is active)

Other behaviors might include:

- The offset range varies depending on the module type and the vertical scale setting.
- If the linear external attenuation factor is set to 10, the dynamic range (at the implied user’s signal input) and resulting maximum vertical scale becomes 10 times larger, that is, ±5 V and 1 V/div, respectively.
- If a passive 10X probe is attached, the dynamic range (at the probe tip) and resulting maximum vertical scale again become 10 times larger, that is, ±5 V and 1 V/div, respectively.
- If an active probe with a ±4 V input dynamic range is attached, the resulting maximum vertical scale is 800 mV/div.
- If TDR is active (80E04, 80E08, or 80E10) and Rho or Ohms units is selected, the instrument automatically performs a scaling conversion from the underlying volts scale to the selected unit.

The minimum vertical scale value is that value which allows a sensitivity increase of 100 times. For instance, for the above electrical modules, the minimum scale value allowed is 1 mV/div (that is, coarse settings of 100 mV, 50 mV, 20 mV, 10 mV, 5 mV, 2 mV, 1 mV). This generally results in seven coarse scale settings for the spin control increment/decrement. However, more coarse settings may be available if the maximum scale setting is something other than a 1-2-5 based setting.

Channel waveform scale changes affect the allowable offset range for the channel. In general, as the vertical scale value is reduced, the amount of allowable offset increases.

**See Also:**

Waveform Selector Setting (see page 149)
Vertical Position Setting (see page 151)
Vertical Setup Basic Dialog Box Overview (see page 147)
**Vertical Position Setting**

Access this control from **Setup > Vertical** or the front panel Vertical area MENU button.

Use the Position field to set the vertical position of the selected waveform on the display. You can also use the front-panel vertical position knob.

The Position field increments and decrements the waveform position by ½ minor graticule divisions, or 1/10 minor division when “fine” is on. Increasing the position value of a waveform causes the waveform to move up, and decreasing the position causes the waveform to move down.

*TIP. Position adjusts only the display position of a waveform, whether a channel, a math, or a reference waveform.*

**See Also:**

Vertical Scale Setting (see page 149)
Vertical Offset Setting (see page 151)
Learn about how vertical scale, position, and offset affect acquisition and display. (see page 159)
Vertical Setup Basic Dialog Box Overview (see page 147)

**Vertical Offset Setting**

This control sets the vertical offset value to shift the vertical acquisition ‘window’ view. Access this control from **Setup > Vertical** or the front panel Vertical area MENU button.

Use the Offset field to set the offset value, to shift the vertical acquisition window to match the waveform data you want to acquire. You can also use the front-panel vertical offset knob to set this value.

The offset control adjusts the vertical acquisition window – the DC level around which the signal is sampled – for the selected channel. Visualize offset as scrolling the acquisition window toward the top of a large signal (or one with a positive DC bias) for increased offset values and scrolling toward the bottom for decreased offset values. Optimal vertical accuracy (of the entire signal) is obtained when offset is set to the average DC bias of the input signal (that is, centers the signal around the input dynamic range of the sampling module).
The range of offset values for a given channel is dependent on multiple factors: the sampling module type (specifically, its offset and operating ranges), the probe type (if attached), the external attenuation factor, the selected units (if TDR is active), and the scale.

- The offset range varies depending on the module type and the vertical scale setting.
- If the linear external attenuation factor is set to 10, the offset range (at the implied user’s signal input) becomes 10 times larger.
- If a passive 10X probe is attached, the offset range (at the probe tip) again becomes 10 times larger.
- If an active, offsettable probe with a ±5 V input offset range is attached, the offset range (for all scale settings) is ±5 V – it does not change with scale due to the use of probe offset control instead of sampling module offset control.
- If TDR is active (80E04, 80E08, or 80E10) and Rho or Ohms units are selected, the offset control is disabled (the instrument automatically uses offset to obtain the desired results).

See Also:

Vertical Position Setting (see page 151)
Vertical Channel Deskew and Delay Settings

Use the Deskew and Delay fields to set the values to compensate for skew (signal delay) between channels. Access these controls from Setup > Vertical or the front panel Vertical area MENU button.

Adjust deskew and delay times to add an independent, channel-based delay time to the horizontal position. (For the left position indicator, this is the common trigger point to the first sample taken for each channel). While both deskew and delay let you compensate individual channels for skew differences introduced externally from the instrument, they are implemented differently. Deskew is applied to the strobe drive and is common to both channels in the module. It is therefore necessary to operate in a double-pass acquire on alternate triggers (whenever the deskew values differ within channels in a module) to satisfy the requested deskew difference.

Delay is a channel-specific time delay capability that is available with some sampling modules, such as the 80E06, 80E07, 80E08, 80E09, and 80E10.

**NOTE.** If the selected module supports adjustable delay, adjust the Delay before adjusting Deskew.

**TIP.** To retain maximum performance, keep the deskew values for both channels in such sampling modules the same and use delay.

**See Also:**
- Channel Deskew and Channel Delay Overview (see page 154)
- Vertical Offset Setting (see page 151)
- Vertical Bandwidth, Units Settings (see page 155)
- Vertical Setup Basic Dialog Box Overview (see page 147)
The DSA8300 provides two different methods for input signal deskewing (correcting signal timing differences that are external to the instrument): channel deskew and channel delay. While both channel deskew and channel delay let you compensate individual channels for external signal path timing differences, they have different impacts on acquisition performance.

Channel deskew (available for all 8000 series sampling modules) adds a specified delay to the trigger-initiated acquisition strobe signal that is sent to all module channels simultaneously. Using channel deskew requires separate acquisitions (on sequential triggers) to acquire data for each channel with a different channel deskew value.

Channel deskew works best for repetitive signals. Data is captured over sequential triggers, with the instrument changing the channel deskew value for each channel per acquisition. The number of acquisitions needed to display the waveforms increases linearly as a function of the number of different channel deskew settings for actively acquired channels. To get the best performance when using channel deskew, keep the number of unique deskew values to a minimum.

Channel delay (available with 80E06, 80E07, 80E08, 80E09, and 80E10 electrical sampling modules) is a hardware-based signal delay that can be set on individual channels. Channel deskew enables acquiring multiple adjusted channels on a common set of triggers, assuring that the signals acquired are properly time correlated. This is particularly important when acquiring multiple non-repetitive (random) signals. Random signals are signals that do not repeat on equivalent trigger events from acquisition to acquisition.

Channel delay provides the best performance for all signals including random signals, as all channels are acquired in a single acquisition pass. Use channel delay and/or phase adjusters to deskew random signals.

Your signal deskewing needs may require you to use both channel deskew and channel delay. For optimum performance, set the channel deskew parameter to be the same value for all active channels, and use the channel delay parameter (on supported modules) to make fine adjustments of the signal deskew for each channel. Setting the channel deskew parameter to the same value for all channels enables the instrument to acquire all channels in a single acquisition pass.
Vertical Bandwidth, Units Settings

Access these controls from **Setup > Vertical** or the front panel Vertical area MENU button.

- **Bandwidth**: Sets the bandwidth of the electrical module. The available bandwidths depends on the installed module.
- **Units**: Sets the waveform vertical measurement units. Auto mode (default) automatically sets the vertical units based on the signal and measurement parameters. If you set this value to any setting other than Auto (V, A, and W), the instrument applies the specified unit to the vertical axis:
  - For non-TDR waveforms, valid settings are Auto, V, A, and W. When you change the units setting, all vertical units are reported as specified and no waveform scaling transformations take place.
  - For TDR waveforms, set the TDR units in the TDR setup dialog box. When you change units of TDR waveforms, the instrument automatically performs the waveform scaling transformation appropriate for the selected units. Whenever a TDR step is turned on, the Units control in the Vertical Setup dialog box becomes disabled (and unused).

See Also:
- Vertical Channel Deskew and Delay Settings (see page 153)
- Vertical External Attenuation Setting (see page 156)
- Vertical Setup Basic Dialog Box Overview (see page 147)
Vertical External Attenuation Setting

Access this control from **Setup > Vertical** or the front panel Vertical area MENU button.

![External Attenuation Control](image)

**To Use**

Use this control to set a value matching the amount of attenuation applied externally, before the signal enters the sampling module or probe tip input.

This control is only available if the selected waveform is an acquisition channel.

**Behavior**

**TIP.** *The instrument takes into account the external attenuation you set when displaying vertical readouts, measurements, and so on.*

**NOTE.** \( \text{External Attenuation (dB)} = 20 \times \log_{10} \left( \text{External Attenuation (linear)} \right) \) for \( \text{External Attenuation (linear)} > 0 \).

External attenuation is set to 1 (linear) or 0 dB for all TDR sources and for all channels recognized as TDR sources. External attenuation is set to 1 (linear) when you attach an external real-time accessory (such as a probe) to the selected channel.

**See Also:**

- Vertical Bandwidth Units Settings (see page 155)
- Vertical DC Cal Setting (see page 157)
- Vertical Setup Basic Dialog Box Overview (see page 147)
Vertical DC Cal Setting

This control sets the voltage output applied to the front panel DC Calibration Output connector. Access this control from Setup > Vertical or the front panel Vertical area MENU button.

See Also:
- Vertical External Attenuation Setting (see page 156)
- Vertical Setup Optical Dialog Box Overview (see page 168)
- Vertical Setup Basic Dialog Box Overview (see page 147)
Vertical Controls Background

Use signal conditioning and scaling controls to make sure the instrument acquires the data that you want to display, measure, or otherwise process. To ensure the best possible data for further processing, you do the following:

- Set vertical scale to adjust the waveform size on screen. You can set vertical offset to shift the vertical acquisition window up or down on the signal to capture the part you want.
- Set horizontal scale to control the time duration of the horizontal acquisition window to capture as much as you want of the input signal(s). To control where in the input signal (data stream) that the horizontal acquisition window acquires, you set horizontal position to delay the window relative to a trigger to capture the waveform part you want. To increase or decrease the resolution between sample points, change the record length.

Terminology: The terms “vertical acquisition window” and “horizontal acquisition window” refer to the vertical and horizontal range of the acquisition window, which defines the segment of the input signal that the acquisition system captures. The terms do not refer to any windows or display windows on screen.

See Also:
- How Vertical Position Scale and Offset Affect Acquisition and Display (see page 159)
- Vertical Setting Caveats (see page 161)
- Vertical Settings Key Points (see page 162)
- Vertical Signal Conditioning (see page 163)
How Vertical Position, Scale, and Offset Affect Acquisition and Display

Clipping

The circled part of the incoming waveform is clipped, and therefore, is not acquired. The clipped part cannot be processed or displayed. Offset can move the acquisition window vertically relative to the incoming waveform.

There are three primary vertical controls: Offset, Scale, and Position. Offset affects the input vertical acquisition hardware, whereas Scale and Position do not— they are graphical controls that only affect the display of the waveforms. All of these controls visually affect the displayed waveform and its associated graticule annotations.

Offset

Offset, available only for channel waveforms, is a true analog acquisition control that establishes the reference point around which the signal is sampled. The offset control lets you add a positive or negative DC bias to the input sampling hardware before analog-to-digital conversion. This has the effect of moving the relative analog acquisition window in a more positive or negative direction, allowing you to center a signal with a nonzero DC bias into the sampling module channels input dynamic range (generally a good idea). It can also let you examine a small part of interest on a larger waveform (using smaller scale settings) without inducing acquisition clipping behavior in the region of interest. Note that increasing offset in the positive direction (such as moving the acquisition window in a positive direction) as the visual affect of moving the displayed waveform downward with respect to the graticule (and vice versa for negative offset values).
Scale

Scale, a graphical control available for all waveforms, enlarges or reduces the displayed size of the waveform about the vertical reference indicator of the waveform (as set by the Position control).

Position

Position, a graphical control available for all waveforms, allows you to move the displayed waveform without using the Offset control, thereby making it unnecessary to change the optimal (or desired) input sampling bias. Channel waveforms are allowed 5 divisions of position control, math and reference waveforms many more. Position is annotated for every active waveform by a vertical reference indicator outside the left edge of the graticule.

It is useful to visualize the vertical position indicator (for channels) as the true center of the acquisition window. This is the same as saying that it is the center of the input dynamic range of the channels acquisition system. That is the reason that, as you change offset to center a signal with a DC bias, the position indicator does not move. Using offset to center the signal symmetrically around the vertical position indicator provides an easy visual mechanism to make sure that you are sampling the input signal in the center of the channels analog dynamic range.

See Also:

Vertical Setting Caveats (see page 161)
Vertical Settings Key Points (see page 162)
Vertical Signal Conditioning (see page 163)
Vertical Setting Caveats

**Vertical offset considerations**: The vertical offset cannot be adjusted for reference waveforms, because a reference waveform is a static, saved waveform, and offset adjusts the acquisition hardware for acquiring live waveforms. Also, TDR waveforms, if displayed in rho or ohm units, cannot be adjusted for vertical offset.

The vertical offset of a math waveform cannot be adjusted directly. You can adjust the offset of the waveform sources (waveforms included in the math expression) for the math waveform if the sources are live waveforms.

**Autoset considerations**: Autoset can be defined to set up for a waveform edge, period, or an eye/bit pattern. Pushing the Autoset button automatically sets up the instrument controls for a usable display based on the property you choose and the characteristics of the input signal. Autoset is much faster and easier than a manual control-by-control setup. You can also reset the instrument to its factory default settings by pushing the Default Setup button.

Autoset acquires samples from the input signal and attempts to take the following actions based on the input data:

- Evaluate the amplitude range of the input signals and offset of the vertical acquisition window to acquire the signal without clipping.
- Set the trigger level to the approximate midlevel of the trigger signal being applied (either an external trigger or a clock-recovery trigger).
- Evaluate the signal transitions and set the horizontal scale to produce a waveform display based on the Autoset mode selected: Edge, Period, or Bit/Eye Pattern.

Sometimes Autoset cannot produce a correct display due to the nature of the input signal; if so, you may have to adjust the scale, trigger, and acquisition controls manually. Some conditions that can cause Autoset to fail are:

- No signal present.
- Signals with extreme or variable duty cycles.
- Signals with multiple or unstable signal periods.
- Signals with too low amplitude.
- No recognizable trigger signal.
- No eye diagram waveform present when autosetting in Bit/Eye Pattern autoset mode.

**See Also**:

- How Vertical Position Scale and Offset Affect Acquisition and Display (see page 159)
- Vertical Settings Key Points (see page 162)
- Vertical Signal Conditioning (see page 163)
Controls-specific help

Vertical Settings Key Points

CAUTION. Sampling modules are inherently vulnerable to static damage. Always observe static-safe procedures and cautions as outlined in your sampling-module user manual.

Coupling concerns

Electrical sampling modules provide only straight-DC coupling to their sampling circuits, with no protection. All modules specify a maximum vertical nondestructive range that limits signals to small levels, typically about 2 to 3 volts (DC + ACp-p). (See the specifications in your sampling module in its user manual for exact limits.) Do not exceed the limits, even momentarily, as the input channel may be damaged.

All modules also specify a dynamic range that, if exceeded, could cause acquisition and measurement errors due to nonlinearity. Do not exceed this limit. (See the specifications for your sampling module in its user manual for exact limits.)

Optical sampling modules may have dynamic range exceeded without obvious visual indications onscreen because the photo detector and/or filters used may not necessarily be able to pass through overloaded signals to the sampler.

Use external attenuators if necessary to prevent exceeding the limits just described. Note that there are no hardware bandwidth filters in most sampling modules or in the instrument. (Some optical sampling modules have bandwidth filters settable from the Vertical Setup menu of the instrument. See the user manual for your optical sampling module for more information.)

Scaling, offset, and positioning considerations

These key controls determine the part of the input signal presented to the acquisition system:

- Set the vertical offset to display the features of interest on your waveform and avoid clipping. (See Note that follows.) Adjust the display control Vertical Scale to control the part of the vertical window displayed on screen; adjust the display control Vertical Position to position the waveform on screen. Note that vertical offset affects the vertical acquisition window, but vertical scale and position do not. These last two controls are display controls only. Vertical Acquisition Window Considerations describes the vertical acquisition window.
Set horizontal scale, position, and resolution (record length) so that the acquired waveform record includes the signal attributes of interest with good sampling density on the waveform. The settings you make define the horizontal acquisition window, described in Horizontal Acquisition Window. (“Good sample density” might be at least five samples on each waveform transition when acquiring for timing measurements. The trade off for increased sample density is increased time to acquire.)

Waveform data outside the vertical acquisition window is clipped; that is, the data is limited to the minimum and/or maximum boundaries of the vertical acquisition window. This limiting can cause inaccuracies in amplitude-related measurements. See Vertical Acquisition Window Considerations.

**Trigger and display**

Set basic trigger controls to gate waveform acquisition, and use the display to interactively set scale, position, and offset waveforms. See the topics on Triggering and Displays.

**Selected waveform**

Many of the controls of this instrument, especially the vertical controls, operate on the selected waveform. The instrument applies all actions that only affect one waveform at a time, such as applying a changes to the vertical control settings, to the selected waveform. You can select a channel waveform, a math waveform, or a reference waveform.

**See Also:**

- How Vertical Position Scale and Offset Affect Acquisition and Display (see page 159)
- Vertical Setting Caveats (see page 161)
- Vertical Signal Conditioning (see page 163)

**Vertical Signal Conditioning**

This section contains background information that can help you more effectively set up the acquisition window of each channel.

**Input**

This instrument samples sequentially, which provides superior bandwidth and time resolution. Sequential sampling systems sample the input without scaling it (they have a fixed dynamic range); therefore, input protection and dynamic range are necessarily limited.

**CAUTION.** Do not overdrive the inputs. Also, observe static-safe procedures and cautions as outlined in the sampling-module user manual. Sampling modules are very sensitive to ESD.
**Vertical acquisition window considerations**

The size of the vertical acquisition window is determined by the operating range of the sampling module and any probe connected to it. The vertical offset determines where the vertical window is positioned relative to ground. Parts of the signal amplitude that fall within the vertical window are acquired; parts outside (if any) are not (they are clipped).

As an example, consider that a basic 80E00-series sampling module, with a maximum 100mV/div scale, covers 1 volt over 10 divisions. Changing the vertical scale setting only changes how much of the vertical window displays on screen; changing vertical position simply changes the space on the screen where the data is displayed.

You can set the vertical scale, position, and offset of each channel independently of other channels.

The vertical scale and position controls do not affect the vertical acquisition window, rather they adjust the display system to display the waveform as follows:

- The vertical scale (per division) setting determines the part of the vertical acquisition window that appears in the graticule, allowing you to scale it to contain all of the window or only part. Figure
Controls-specific help

Vertical Signal Conditioning

3-2 shows two vertical acquisition windows that contain the entire waveform, but only one window contains the entire waveform in the graticule on screen.

Setting Vertical Scale and Position of Input Channels

a. Volts/Div setting determines the size of the display graticule within the vertical acquisition window (scale set to 50 mV/div.)

![Diagram showing vertical window and graticule](image)

b. Vertical position can change location of display graticule within ±5 divisions (position set to -4 divisions)

![Diagram showing vertical window and graticule](image)

Amplitude-related automatic measurements (for example, peak-to-peak and RMS) will be accurate for vertical windows like those shown in preceding figure because neither waveform is clipped (that is, both waveforms are acquired). But if the signal amplitude were to extend outside the vertical acquisition window, the data acquired becomes clipped. Clipped data causes inaccurate results if used
in amplitude-related automatic measurements. Clipping also causes inaccurate amplitude values in waveforms that are stored or exported for use in other programs.

- The vertical position adjusts the display of the graticule relative to the vertical acquisition window (position is a display control). The bottom window in the preceding figure shows how vertical position moves the waveform graticule vertically in the vertical acquisition window to place the acquired waveform in the graticule display. Position does not determine what data is acquired as does vertical offset.

The vertical offset control affects the vertical acquisition window and the displayed waveform as follows:

- The vertical range (window) is always centered around the offset value that is set. Vertical offset is the voltage level at middle of the vertical acquisition window. With no (zero) offset (see the figure that follows), that voltage level is zero (ground).

- As you vary vertical offset, the middle voltage level moves relative to zero. This moves the vertical acquisition window up and down on the waveform. With input signals that are smaller than the window, it appears the waveform moves in the window. Actually, a larger signal shows what really happens: the offset moves the middle of the vertical acquisition window up and down on input signal. The figure that follows shows how offset moves the acquisition window to control the part of the waveform amplitude the window captured.

- Applying a negative offset moves the vertical range down relative to the DC level of the input signal, moving the waveform up on the display. Likewise, applying a positive offset moves the vertical range up, moving the waveform down on the display. See the figure that follows.

On screen, the channel icon in the waveform bar points to the offset value around which the vertical acquisition window is centered. The offset value pointed to is relative to the ground reference icon. Both icons are shown in the figure.
Varying Offset Positions Vertical Acquisition Window on Waveform Amplitude

Vertical window = 1 V peak-to-peak (fixed by sampling module used)

Offset +300 mV
Near waveform top level

Offset 0.0 V
At waveform ground reference

Offset -300 mV
Waveform bottom level

Acquisition window shifts positive to capture overshoot
Acquisition window shifts negative to capture preshoot

Measurements use the entire part of the waveform that the vertical window captures, not only the part displayed on screen. Also, waveforms exported or saved (from the File menu or over the GPIB) contain data from the entire vertical window, not just the on-screen part.

See Also:

How Vertical Position Scale and Offset Affect Acquisition and Display (see page 159)
Vertical Setting Caveats (see page 161)
Vertical Settings Key Points (see page 162)
Vertical Setup (Optical) Dialog Box Overview

This dialog box controls the vertical optical settings of all live (channel) waveforms. Access this control from Setup > Vertical or the front panel Vertical area MENU button. The optical settings are available only when you have an optical module installed.

![Vertical Setup (Optical) Dialog Box](image)

This information describes optical signal vertical setups; see Vertical Setup (Basic) (see page 147) for information on basic signal vertical setup parameters.

See Also:

- Vertical acquisition controls and vertical display controls. (see page 159)
- Optical Waveform Selector (see page 169)
- Optical Wavelength Setting (see page 170)
- Optical Filter Setting (see page 170)
- Optical Bandwidth (see page 171)
Optical Waveform Selector

Access this control from **Setup > Vertical** or the front panel Vertical area MENU button. The optical settings are available only when you have an optical module installed.

![Waveform Selector](image)

### To Use

Use this pulldown list to select the optical channel for which you want to change the vertical settings. The list contains all available channel, reference, and math waveforms.

After selecting a waveform, use the dialog box elements to set the vertical controls. Then check the On box to turn on the display of the waveform.

**TIP.** If you select a channel that does not have optical capabilities, the remaining part of the dialog box reverts to the **Vertical Setup (Basic) (see page 147)** page.

**TIP.** If you select a math waveform, the Define button is enabled. You can click Define to create a new math waveform (or edit an existing one).

**TIP.** If you select a math waveform, the Define button is enabled. Click Define to create a new math waveform or edit an existing math waveform.

**TIP.** You can also use the front-panel buttons to select a waveform.

### See Also:

- Optical Wavelength Setting (see page 170)
Optical Wavelength Setting

Access this control from **Setup > Vertical** or the front panel Vertical area MENU button. The optical settings are available only when you have an optical module installed.

![Wavelength](#)

Use this pulldown list to select the wavelength of the optical signal you are using.

**See Also:**

[Optical Filter Setting (see page 170)](#)

Optical Filter Setting

This control allows you to select from the reference receivers available in the optical module selected by the waveform selector. Optical settings are available only when you have an optical module installed.

Access this control from **Setup > Vertical** or the front panel Vertical area MENU button.

![Signal Conditioning](#)

Use the Filter list to select what type of filtering, if any, you want performed on the selected optical channel. Select **None** to enable an unfiltered path and activate the Bandwidth control.

**See Also:**

[Optical Bandwidth (see page 171)](#)
Optical Bandwidth

Use this control to set the bandwidth of the channel in an unfiltered operation. Access this control from **Setup > Vertical** or the front panel Vertical area MENU button. The optical settings are available only when you have an optical module installed.

This control is disabled if a reference receiver filter is selected or set to a value other than None.

**See Also:**

[Optical Compensation and Calibration (see page 171)]

Optical Compensation and Calibration

Access this control from **Setup > Vertical** or the front panel Vertical area MENU button. The optical settings are available only when you have an optical module installed.

Select one of the two buttons and follow the instructions to perform the selected type of compensation or calibration.

Waveform Database Setup Dialog Box Overview

Use this dialog box to view and set up waveform databases. A waveform database is a collection of sequentially acquired waveforms. There are four waveform database storage areas available. Access these controls from **Setup > Wfm Database.**
A waveform database is a three-dimensional array that adds a count dimension to the standard vertical and horizontal dimensions. The count reflects the number of times a specific waveform point was acquired or generated at each vertical and horizontal position.

**TIP.** Waveform database accumulation is always a “dot mode” accumulation (that is, no interpolation or vectoring is performed).

Waveform database count values, as stored in the waveform database array, are unitless with respect to absolute user units (for example, volts or seconds). They are described by the attributes of the source waveform and the waveform counts.

**Waveform Database Dimensions**

The dimensions definitions follow:

- **Horizontal (columns):** Value is 1000, which is the maximum horizontal graticule view size.
- **Vertical (rows):** Value is 402, which is the maximum vertical graticule view size in pixels, plus one row each for overrange (OR) and underrange (UR) counts for each column.
**TIP.** At a minimum, single OR and UR flags for each WfmDB are useful for flagging questionable analysis results.

- Count (weights or density) – Value is 32 bits.

**Uses**

Use waveform databases for measurements, histogram calculations, mask testing, and generating a density-style graded display. Waveform databases may be automatically allocated for measurements, histograms, and mask testing.

**See Also:**

- Waveform Database 1 - 4 Settings (see page 173)
- Waveform Database Persistence Settings (see page 174)
- Waveform Database Display Options Settings (see page 175)
- Waveform Database Background (see page 176)

**Waveform Database 1 - 4 Settings**

Use these controls to select a waveform database, select the source, enable data acquisition into the database, and clear the data from a database. Access these controls from **Setup > Wfm Database**.

- **WfmDB list**: Sets the waveform database in which to store the signal data. You can select each database, choose an input source for it, enable it, and display it. If you select a waveform that is not being acquired, the instrument implicitly acquires the waveform.

- **Source**: Assigns a source waveform to the selected database. All waveforms in each displayed timebase are available as selections in this control except reference waveforms.

- **On**: Enables or disables accumulation of data. The waveform database is then enabled for data accumulation whether displayed or not.

- **Display**: Check this box to display the database with all data that it has accumulated; uncheck this box to display the vector waveform selected as the source for the database. (The box is unchecked by default). Checking this box also implicitly starts accumulation of data; unchecking this box (to turn the database Display off) does not stop the accumulation of data into the database or the use of that data for measurements.
Controls-specific help
Waveform Database Persistence Settings

**See Also:**

[Waveform Database Persistence Settings (see page 174)]

---

### Waveform Database Persistence Settings

Use these controls to select either an infinite or variable persistence mode for accumulation of source waveforms into the selected database. If you select Variable Persistence mode, you can also set the waveform count that applies to Variable Persistence. Access these controls from **Setup > Wfm Database**.

You can set any database that you select (see **WfmDBase 1-4 settings**) to use the persistence mode that you choose to accumulate and display data.

You can set these controls independently for each of the four waveform databases that this instrument supports. For example, WfmDB 1 can be set for infinite persistence, while WfmDB 2 is set for variable persistence. Or you can set two or more databases for variable persistence, but with different waveform counts.

- **Infinite**: Stores and displays waveform data as they accumulate until the selected database is cleared manually or by a control change (such as switching the database to Variable persistence mode or changing any acquisition parameter).

- **Variable**: Stores and displays accumulated data in the specified database until the user-specified waveform count is surpassed. Each waveform accumulated beyond the count removes the oldest waveform data in the database.

- **Waveforms**: Sets the number of waveforms to accumulate for display in Variable persistence mode. You can enter values directly with this control using the up/down arrows, the pop-up keypad, or an externally connected keyboard.

- **Samples**: The number of samples in the current waveform database. This count is not settable: the instrument calculates the value from the product of two values: the current Waveforms setting in this dialog box and the Record Length setting in the Horizontal Setup dialog box.

**See Also:**

[Waveform Database Display Options Settings (see page 175)]
Waveform Database Display Options Settings

Use these controls to set how the instrument displays the WfmDB data. You can choose between color- and intensity-graded displays, invert the color or intensity that grading applies, and select among grading methods. Access these controls from Setup > Wfm Database.

**NOTE.** The Display Options controls apply globally to all four databases.

- **Color**: Uses different colors to indicate data-accumulation density.
- **Intensity**: Uses different shades of one color are used to indicate density.
- **Invert**: Inverts the current color or intensity display information. Inverting the colors or intensities can sometimes highlight data that occurs least in the waveform database.
- **Grading Method**: Selects the method used to determine which data level bins in the database are displayed with emphasis relative to other levels:
  - EMPH8 selects a curve-driven grading method that uses eight display colors/intensities. The curve is specified by the Emphasize Counts setting, see Emphasize Counts, below.
  - EMPH7 selects a curve-driven grading method that uses seven display colors/intensities. The curve is specified by the Emphasize Counts setting, see Emphasize Counts, below.
  - BIN8 selects a binary grading method that uses eight display colors/intensities. This method assigns ranges of counts to colors/intensities by successively halving the maximum bin count and assigning the resultant ranges in brightest-to-darkest color/intensity order. If the maximum bin count is less than the number of display colors, then a one-for-one mapping of counts to colors/intensities is used.
  - BIN7 selects a binary grading method that uses seven display colors/intensities. This method assigns ranges of counts to colors/intensities by successively halving the maximum bin count and assigning the resultant ranges in brightest-to-darkest color/intensity order. If the maximum bin count is less than the number of display colors, then a one-for-one mapping of counts to colors/intensities is used.
- **Emphasize Counts**: Sets the range of counts to emphasize when EMPH7 or EMPH8 Grading is selected. The slide bar selects a percentage value; the edit box allows direct entry of the percentage.
value, where the lowest value, 0%, emphasizes bins with low counts and the highest value (100%) emphasizes bins with high counts.

See Also:

Waveform Database Background (see page 176)

Waveform Database Background

A waveform database is a three-dimensional accumulation of a source waveform as it is repeatedly acquired. In addition to the standard vertical and horizontal dimensions, each waveform sample in a waveform database has a third dimension of count. The count reflects the number of times a specific waveform point was acquired or generated.

You use waveform databases to take measurements, run histogram calculations, and do mask testing based on a waveform accumulated in a database, rather than a single waveform stored in acquisition memory.

Normal Waveform View

The normal vector view of a waveform displays the waveform data in dot mode: the waveform display is updated with each acquisition to reflect the current data.

Waveform Database View

When the waveform database display is turned on you can see the waveform data accumulation displayed all at once, with subsequent acquisition data being “added” to the display as it is acquired.
See Also:

Waveform Database Caveats (see page 178)
Waveform Database Key Points (see page 179)
Waveform Database Caveats

- Waveform database accumulation is always a dot mode accumulation; therefore, no interpolation or vectoring is performed.

- The waveform record length is not limited to 1000 (horizontal waveform database dimension and number of horizontal display columns) when waveform databases are active. Record lengths can vary over the entire allowable range.

- To emphasize the data that occurs less frequently, toggle the Invert Color/Intensity control in the Waveform Database setup dialog box, which reverses the intensity/color assignments to each pixel in the database display.

- You can set any selected database to use a persistence mode to accumulate and display data. Infinite persistence mode continues displaying waveforms as they accumulate until the selected database is cleared manually or by a control change. Variable persistence mode keeps and displays accumulated data in the specified database until the user-specified waveform count is surpassed. Each waveform accumulated beyond the count removes the oldest waveform accumulated earlier in the database.

- Because references contain static data that does not update, they are not available as a waveform source for waveform databases.

- There are a maximum of four waveform databases. Use the Wfm Database dialog box to assign and reassign Database1 through Database4 to waveform sources.

- You can use a waveform database as a source by multiple instrument features. For example, you can use the same database as the source for a histogram, an automatic measurement, and a mask test.

- Once all databases are allocated, the only way to assign a new waveform is to change the waveform source of one of the databases in the same dialog box, which releases its existing source.

- If all four databases are assigned and you attempt to implicitly assign a waveform source to a database (for example, by right clicking a waveform icon in the Waveform bar and selecting color grading), the instrument will display a notice that no databases are available.
Waveform Database Key Points

The key points that follow describe operating considerations for setting up a waveform database.

- **Dimensions**: Waveform database dimensions match those of the database source and are described as follows:
  - Horizontal (columns): Always 1000 columns, which is the maximum horizontal graticule view size. Columns are in horizontal units that match the horizontal units of the source.
  - Vertical (rows): Always 402 rows, which is the maximum vertical graticule size plus one row each for overrange (OR) and underrange (UR). Rows are in vertical units that match the vertical units of the source.
  - Count (weights or density): up to 32 bits.

- **Display**: When you assign a waveform database to a waveform source (using the Waveform Database Setup dialog box), you must turn on the waveform database display to see it on screen; otherwise, the waveform source displays using the default (vector) display. The waveform database still accumulates in the background and can be turned on later without clearing the database.

Clear References Dialog Box

Use this dialog box to clear all data in a selected reference memory location. The instrument retains data in references until you explicitly clear it. You access this dialog box from **Edit > Clear References**.

Select one or more reference waveforms to clear. Use the Ctrl key to select multiple or noncontiguous entries. Click **Clear** to remove the reference waveforms from memory.

Export Dialog Box

Use the Export dialog box to export waveform or histogram data to a file. The instrument exports waveform data as either columns of comma separated Y,T (vertical, horizontal) text pairs (.csv), or as comma separated Y (vertical) text values (.txt). Histogram data is exported as comma separated text values only. By **exporting** a waveform or a histogram, you can use it with other analysis tools, such as spreadsheets or math-analysis applications.

Access this dialog box from **File > Export Waveform**.
The key points that describe operating considerations for setting up the exporting of waveforms and histograms are:

- Waveforms are exported as a series of values (without units) as either (.csv) or (.txt) file types. Choosing CSV exports the data as a column of Y,T pairs. Choosing .txt exports the data as a text string separated with commas. There is no timing information, but data is placed in the file in sequence from the first sample in the waveform record to the last.

- Histograms also export as a series of values (without units) but only as .csv type data. One value is present for each bin in the histogram.

- Exported waveforms cannot be imported directly. If you intend to recall a waveform later, save it (see the procedure To Save Your Waveform (see page 188)) instead of exporting it. You cannot import histograms.

- You may also choose to copy a waveform and paste directly into some applications such as Microsoft Word or Excel. If so, select your waveform, and then select Copy in the Edit menu.
Save Waveform Dialog Box

You can save waveforms, one at a time, to waveform files using the Save Waveform(s) dialog box. You have the option of saving one or more waveforms with a single action.

You access this dialog box from File > Save Waveform.

![Save Waveform Dialog Box]

Each waveform file contains the following:

- The waveform data values.
- A preamble (header) describing various attributes of the waveform.
- Any comments you enter in the Comments field of the Save Waveform dialog box.

Do not attempt to edit the waveform with an external application. To change the waveform, recall the waveform, make the changes in the application, and resave it.

What Is Not Included in a Waveform File?

Waveform files do not include relationships between the selected waveform and other waveforms (for example, Main/Mag view relationships).
Page Setup Dialog Box

Use this dialog box to specify paper size and source, portrait or landscape page orientation, and to specify margins. You can also turn Ink-saver mode on or off in this dialog box. To use Ink-saver mode, select **Ink-saver Mode** and click **OK** (or **Print**). Subsequent print jobs will use Ink-saver mode, saving ink, until you return to this dialog box and select Normal.

You access this dialog box from **File > Page Setup**.

Print Dialog Box

Use this dialog box to select a printer and send data to the printer or to capture the screen to an image file. The functions of each control in the Print dialog box are described below. You access this dialog box from **File > Print**.
**TIP.** Before printing, you can setup page parameters from the Page Setup dialog box, which you can display from the File menu. You can also select Ink-saver mode in the Page Setup dialog box (see page 182). Ink-saver mode uses less ink when producing your printouts.

- **Name:** Use the pulldown list to select a printer. Click **Properties** to view the printer properties dialog box.
- **Status:** This field tells you the status of the printer.
- **Type:** This field tells you the type of printer selected.
- **Where:** This field tells you where the printer is located, if on a network.
- **Comment:** This field lists additional printer information.
- **Print to File:** Check this control to print the data to a file instead of to a printer. When you then click the OK button to print, the Print to File dialog box displays. In this dialog box, you select the file name to print to and the file format to use: BMP (*.bmp), PNG (*.png), JPEG (*.png), TIFF (*.tif), or Targa (*.tga).
- **Print range:** Select All to print all pages of data. Select Pages (from and to) to print only a range of pages. Select Selection to print only selected pages (this setting is useful if printing pages that are not in sequential order).
- **Copies:** Set the number of copies to print in the Number of copies field. Check Collate to have the printer collate the printed pages.
Save Setup Dialog Box

Use this dialog box to save system setups to any location in the file system. File systems include hard disks, USB drives, CD-ROM drives, and network drives. Access this dialog box from File > Save Setup or File > Save Setup As.

Enter a file name in the File name field, select a location to where you want the file saved, and click Save.

**NOTE.** The number of setups you can save is limited only by the storage available in the selected file system.

**NOTE.** You cannot directly edit or modify a setup (.STP) file.

What Is Included in a Setup File?

Setups include most instrument state settings and other system information. Instrument state settings include waveform mask definition data, if masks are user-defined.

What Is Not Included in a Setup File?

Setups do not include waveform data or any forms of analysis results, such as histogram or mask statistics or measurement results. The current states of programming interfaces are not saved with the setup, nor are application-based user preferences (these are stored in the Windows Registry). Also, setups do not include standard masks because these are stored on the file system.
Recall Setup Dialog Box

Use this dialog box to recall (load) previously saved system (instrument) settings. Access this dialog box from File > Recall Setup.

**TIP.** When you select a setup file, any comments that were saved with the saved system settings file appear in the Comments field.

Save and recall different setups to switch from setup to setup without having to first manually record your settings and then manually set them. This capability is helpful when you want to:

- Save and recall a setup that optimizes the instrument for displaying and analyzing a certain signal.
- Save a series of setups to help automate a procedure through recall of a sequence of saved setups as part of performance of the procedure.
- Export a setup for sharing with a second instrument.

**See Also:**
- Save/Recall Setups Caveats (see page 186)
- Save/Recall Setups Key Points (see page 187)
Save/Recall Setups Caveats

- **Commenting:** The Save Setup and Recall Setup dialog boxes provide for including and viewing comments with your saved setups. Use the comments field to store descriptions of each setup you save and its intended application.

- **Virtual keyboarding:** If you do not have a keyboard connected, you can still enter comments and name setup files. The Save and Recall Setup dialog boxes include the Virtual Keyboard button, shown left. When you touch or click it, the instrument displays a virtual keyboard on screen that you can use with your mouse or the touch screen to enter the setup-path name, setup-file name, and comment.

- **Items excluded when saving a setup:** The instrument excludes the following items when saving setups:
  - Waveforms in channels (C1-C8) or references (R1-R8). Control settings (scale, position, and so on) are saved but not the waveform data. Upon recall of the setup, the settings are applied, but the data is not restored.
  - Waveforms in Math Waveforms (M1-M8). Control settings and the math expression are retained but not the waveform data. Upon setup recall, the recalled math waveform expressions will be applied, but there is no math waveform data to restore. Instead, a new math waveform will be generated based on the recalled expression.
  - User Options that are stored in the Windows Registry. These include all options accessed by first selecting Utilities (menu bar), and then User Preferences (Utilities menu).
  - Standard Masks. Standard masks are not stored with the setups. However, if your recalled setup includes display of a mask, recalling the setup will, in turn, display the mask. Also, masks you define are stored with the setups.
Save/Recall Setups Key Points

The following key points describe operating considerations for setting up the saving and recalling of setups.

- **All settings are retained**: The instrument includes almost all instrument settings, with a few exceptions (such as user options) in the saved setup.

- **Retaining current settings**: Recalling a setup replaces the current setup with the recalled setup. If you do not want to lose your current setup, save it to its own setup file for later recall before you recall the new setup.

- **Avoiding setup and waveform mismatches**: Saved setups may contain settings inappropriate for waveforms currently in your instrument. For example, you might have saved a setup that displayed a fiber channel mask, such as FC531, for testing channel 1. If later you display a gigabit Ethernet signal in channel 1 and recall your saved setup, the FC531 mask will display.

- **Avoiding setup and sampling module mismatches**: Recall of a setup assumes that the sampling module appropriate to the recalled setup is installed. For example, recalling a setup that saved optical vertical-control settings requires that an optical sampling module be installed. If not, the instrument substitutes default settings for the affected vertical controls settings instead of recalled settings. Other examples of such mismatches include:
  - Recalling a setup that includes TDR without the TDR-capable sampling module installed. You must have the TDR-capable module installed in the same compartment it was in when the setup was saved.
  - Recalling a setup that includes a clock-recovery setup without the appropriate clock-recovery-capable sampling module installed. You must have the clock recovery-capable module installed in the same compartment as when the setup was saved.
Save Waveform Dialog Box

Overview

Use this dialog box to save a waveform to a file in the file system. File systems include hard disks, USB drives, CD-ROM drives, and network drives. Enter a file name in the File name field, select a location to where you want the file saved, and click Save.

Access this dialog box from **File > Save Waveform**.

**TIP.** The number of waveforms you can save is limited only by the storage available in the selected file system.

You can save any active channel, math or reference waveform in one of two ways:

- Save to a file: This action saves the waveform as waveform (.WFM) file.
- Save to a reference waveform: The selected, saved waveform becomes a reference waveform.

**See Also:**

- Saving a Waveform to a File (see page 188)
- Saving a Waveform as a Reference Waveform (see page 189)
Recall Waveform Dialog Box

Use this dialog box to recall a previously saved waveform into a reference waveform location.

**TIP.** When you select a waveform, any comments that were saved with the waveform are displayed in the Comments field.

Save/Recall Waveforms Background

This background topic contains reference information about the features addressed by the controls in this dialog box. This information can help you more effectively use these controls and features.

- **Waveform storage space:** This instrument can save any number of waveforms, limited only by the available memory space. By saving a waveform, you can recall it later for comparison, evaluation, and documentation. This capability is helpful when you want to:
  - Recall a waveform for further evaluation or comparison with other waveforms.
  - Extend the waveform carrying capacity of the instrument. The instrument supports eight reference, eight channel, and eight math waveforms. If you want more than eight references, you can save the additional reference to disk for recall later.
- **Commenting:** The Save Waveform dialog box and the Recall Waveform dialog box contain a comments field for including and reading comments with your saved waveforms. That way, you can store information, readable upon recall, describing each waveform that you save.
- **You cannot recall into a channel or a math waveform:** The instrument recalls each waveform into one of the reference waveform locations (R1-R8).
- **Waveform databases:** You cannot save and recall waveform databases.

Saving a Waveform as a Reference Waveform

Use the Save Waveform dialog box to save an active channel, math, or reference waveform into a specified reference memory slot. Reference waveforms provide for easy, quick saving of channel and math waveforms. Moreover, the instrument can readily display, measure, and otherwise use reference waveforms, without requiring that you recall them from the file system (as you must do for waveforms saved to files). Reference waveforms are much easier to use.

Define Math Dialog Box Overview

Use the Define Math dialog box to specify functions and operators that transform one or more waveforms into a new viewable math waveform.
You can create and display up to eight (8) math waveforms. For example: reference waveform source R1 has the form \( \sin(t) \). To create a math waveform M1 with form \( \cos(t) \), use the Define Math dialog box to enter \( \text{diff}(R1) \) as the math expression for M1.

**See Also:**
- Math Waveform Slot Select (see page 190)
- Math Expression Field (see page 191)
- Math Functions (see page 193)
- Math Sources (see page 195)
- Math Keypad (see page 196)
- Math Syntax Controls (see page 197)
- Math Average Risetime and Mode (see page 198)
- Math Measurement Scalars (see page 199)

## Math Waveform Slot Select

![Math Waveform Slot Select](image)

Use this pulldown list to select a math waveform to define or edit. Changes you make using the Define Math dialog box controls affect the selected math waveform only.

The pulldown list contains math waveforms M1-M8, allowing you to define up to eight waveforms, which the instrument can display simultaneously.
After selecting a math waveform, use the dialog box elements to develop the expression that defines it. Then check the On box to display the waveform (or uncheck it to remove the selected waveform from the display).

**See Also:**
- Define Math Dialog Box Overview (see page 189)
- Math Expression Field (see page 191)
- Math Functions (see page 193)
- Math Sources (see page 195)
- Math Keypad (see page 196)
- Math Syntax Controls (see page 197)
- Math Average Risetime and Mode (see page 198)
- Math Measurement Scalars (see page 199)

**Math Expression Field**

The math expression for the selected math waveform appears in this field. Monitor this window as you build your math expression, which is a combination of signal sources and mathematical computation that determines the math waveform display.

You cannot edit the math expression field directly; instead, use the buttons in the dialog box to enter values or correct mistakes.

To create a math waveform, select a math waveform from the list. If the selected math waveform has been defined previously, the definition appears in the math expression field in the dialog box. If this is a new math waveform, the math expression field will be blank. Use the buttons in the dialog box to define the math expression. When you are finished entering the math expression, check the On button to display the waveform and click OK.

**TIP.** As you build the math expressions, the instrument disables dialog-box elements that are not valid entries for the current math expression.

**Example**

To define a math waveform that shows base 10 log of the algebraic sum of channels 1 and 2, enter the expression Log(C1+C2):
1. Select **Edit > Define Math** or click the toolbar button.

2. Click operators and operands in the following order:

```
Log( → C1 → + → C2 → ) → On → OK
```

3. To correct a mistake in the expression, click the **Backspace** button.

4. To completely clear the math expression field, click **Clear**.

**See Also:**

- Define Math Dialog Box Overview (see page 189)
- Math Waveform Slot Select (see page 190)
- Math Functions (see page 193)
- Math Sources (see page 195)
- Math Keypad (see page 196)
- Math Syntax Controls (see page 197)
- Math Average Risetime and Mode (see page 198)
- Math Measurement Scalars (see page 199)
Math Functions

Use the function buttons to add functions to the math expression.

The syntax is `<function(> <expression> <)>, where:

- `<function(>` is one of the provided functions plus the automatically included opening parentheses.
- `<expression>` is an expression consisting of one or more operands, a literal, and a constant.
- `<)>` is the closing parenthesis.

The `<expression>` that you apply the function to must contain at least one waveform; you cannot take functions of constants or measurement scalars. For example, the expression Log(100) is invalid, while the expression Log(100*C1) is allowed.

See Also:

- Define Math Dialog Box Overview (see page 189)
- Math Waveform Slot Select (see page 190)
- Math Expression Field (see page 191)
- Math Function Definitions (see page 193)
- Math Sources (see page 195)
- Math Keypad (see page 196)
- Math Syntax Controls (see page 197)
- Math Average Risetime and Mode (see page 198)
- Math Measurement Scalars (see page 199)

Math Function Definitions

Each button in this area of the Define Math dialog box enters a math function into the math expression. Each button and its definition are in the following table:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intg()</td>
<td>Integral of the argument. Intg(f(t)) = integral from x=0 to x=t of f(x) dx</td>
</tr>
<tr>
<td>Diff()</td>
<td>Differential of the argument. Diff (f(t))=df(t)/dt</td>
</tr>
<tr>
<td>Button</td>
<td>Function Definition</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Vmag()</td>
<td>Vertical magnitude of the argument. This is an absolute value that returns the entire vertical magnitude of the selected channel as a positive value.</td>
</tr>
<tr>
<td>Filter()</td>
<td>Filter of the argument. There are two additional parameters that control the filter functions: filter rise time and filter mode. These parameters are used with the record length and time per division to determine the number of points in the filter. Filter ((f(t), \text{risetime})) applies a low pass filter whose cutoff frequency is specified by the rise time. The second argument is filter mode. Centered: the filter centers around each point. Shifted: All points used in filtering precede the produced point.</td>
</tr>
<tr>
<td>Exp()</td>
<td>Exponential base e. (\text{Exp}(f(t)) = e^{f(t)})</td>
</tr>
<tr>
<td>Log()</td>
<td>Base 10 logarithm of the argument.</td>
</tr>
<tr>
<td>Sqrt()</td>
<td>Square root of the argument.</td>
</tr>
<tr>
<td>Ln()</td>
<td>Natural logarithm of the argument.</td>
</tr>
<tr>
<td>Avg()</td>
<td>The average of the argument. Use the Num Avgs control to set the number of waveforms that will be averaged by this function. (\text{Avg} \left( f(t) \right) = \frac{1}{(t-(N-1))} \sum_{t-N}^{t} f(t)), where (N) is defined per measurement location in the Define Math dialog box.</td>
</tr>
<tr>
<td>Min()</td>
<td>Minimum. Keeps a running tab of min for each waveform point.</td>
</tr>
<tr>
<td>Max()</td>
<td>Maximum. Keeps a running tab of max for each waveform point.</td>
</tr>
</tbody>
</table>

See Also:

- Define Math Dialog Box Overview (see page 189)
- Math Waveform Slot Select (see page 190)
- Math Expression Field (see page 191)
- Math Functions (see page 193)
- Math Sources (see page 195)
- Math Keypad (see page 196)
- Math Syntax Controls (see page 197)
- Math Average Risetime and Mode (see page 198)
- Math Measurement Scalars (see page 199)
Math Sources

Use the source buttons to supply the data source part of a math expression. There are eight channels and eight reference waveform locations to select from. As an example, if you have a math expression using sources C1 and C5, the resulting math waveform operates on data from channels 1 and 5.

Math expressions require at least one source waveform. When the acquisition of a live waveform stops, so does the generation of any math waveforms using that waveform as a source.

Example

If C1 = sin(t) and C2 = cos(t), the math expression C1+C2 creates a math waveform equivalent to sin(t)+cos(t).

When a live waveform updates or a reference waveform is altered, math waveforms containing those waveforms as sources are also updated to reflect the changes. Also, sources must exist, but do not need to be displayed, to be used in math waveforms.

See Also:

Define Math Dialog Box Overview (see page 189)
Math Waveform Slot Select (see page 190)
Math Expression Field (see page 191)
Math Functions (see page 193)
Math Keypad (see page 196)
Math Syntax Controls (see page 197)
Math Average Risetime and Mode (see page 198)
Math Measurement Scalars (see page 199)
Math Keypad

Use the keypad to enter numerical values and binary operators into the math expression.

See Also:

- Define Math Dialog Box Overview (see page 189)
- Math Waveform Slot Select (see page 190)
- Math Expression Field (see page 191)
- Math Functions (see page 193)
- Math Sources (see page 195)
- Math Syntax Controls (see page 197)
- Math Average Risetime and Mode (see page 198)
- Math Measurement Scalars (see page 199)
Math Syntax Controls

Use the buttons shown left to control evaluation order and edit your expressions:

- **Parentheses**: Use the Parentheses button to enter a parenthesis character. Each opening parenthesis must be matched with a closing parenthesis.
- **Clear**: Use the Clear button to clear the entire math expression
- **Backspace**: Use the Backspace button to correct errors as you enter the math expression

**See Also:**

- Define Math Dialog Box Overview (see page 189)
- Math Waveform Slot Select (see page 190)
- Math Expression Field (see page 191)
- Math Functions (see page 193)
- Math Sources (see page 195)
- Math Keypad (see page 196)
- Math Average Risetime and Mode (see page 198)
- Math Measurement Scalars (see page 199)
Math Average, Risetime, and Mode

Use math parameter controls to set the number of averages, filter rise time, and filter mode.

These controls apply to math waveforms containing average and/or filter expressions:

- **Num Avgs**: Use this control to set the number of averages you want calculated for the selected math waveform. Use the up and down arrows to increase or decrease the value or use the popup keypad to set the value.

- **Filter Risetime**: Use this control to set the rise time for filtered math waveforms. Use the up and down arrows to increase or decrease the value or use the popup keypad to set the value.

- **Filter Mode**: Use this control to select a filter mode:
  - Centered: the filter centers around each point.
  - Shifted: All points used in filtering precede the produced point.

See Also:

Define Math Dialog Box Overview (see page 189)
Math Waveform Slot Select (see page 190)
Math Expression Field (see page 191)
Math Functions (see page 193)
Math Sources (see page 195)
Math Keypad (see page 196)
Math Syntax Controls (see page 197)
Math Measurement Scalars (see page 199)
**Math Measurement Scalars**

Use the measurement scalar buttons to enter measurement scalar operands into the math expression.

Measurement scalars are functions that take waveforms as the input expression and output a scalar value. Examples of this are Max, Mean, and Peak-to-Peak measurement scalars.

Example: If \( C1=0.1\sin(t) \) and \( \text{Meas1}=\text{Max}(C1) \), then the math expression \( C1+\text{Meas1} \) would create a math waveform of the value \( 0.1 + 0.1\sin(t) \).

**NOTE.** Measurement scalar buttons are only enabled if the next legal input for the math expression is a measurement scalar and if a measurement is defined and active (on).

**See Also:**
- Define Math Dialog Box Overview (see page 189)
- Math Waveform Slot Select (see page 190)
- Math Expression Field (see page 191)
- Math Functions (see page 193)
- Math Sources (see page 195)
- Math Keypad (see page 196)
- Math Syntax Controls (see page 197)
- Math Average Risetime and Mode (see page 198)
Math Expressions Syntax

The Bachus Nauer Form (BNF) syntax for math expressions follows:

<Expression> := < UnaryExpression> | < BinaryExpression>

<UnaryExpression> := <UnaryOperator> ( <Term> )
| <UnaryOperator> ( <Expression> )

< BinaryExpression> := <Term> <BinaryOperator> <Term>
| <Scalar> <BinaryOperator> <Term>
| <Term> <BinaryOperator> <Scalar>

<Term> := <Waveform> | ( <Expression> )

<Scalar> := <Integer> | <Float> | <Meas-Result>

<Waveform> := <ChannelWaveform> | <ReferenceWaveform>

<ChannelWaveform> := C1 | C2 | C3 | C4 | C5 | C6 | C7 | C8

<ReferenceWaveform> := R1 | R2 | R3 | R4 | R5 | R6 | R7 | R8

<UnaryOperator> := Intg | Diff | Avg | Max | Min |
| Filter | Vmag | Exp | Log | Ln | Sqrt

<BinaryOperator> := + | - | / | *

<Meas-Result> := Meas1 | Meas 2 | Meas 3 | Meas 4 | Meas 5 | Meas 6 | Meas 7 | Meas 8

Math Waveforms Background

This background topic contains information about the features addressed by the controls in this dialog box. This information can help you more effectively use these controls and features.

Math Waveforms

Once you have acquired waveforms or taken measurements on waveforms, the instrument can mathematically combine (+, -, /, x) them to create a waveform that supports your data–analysis task. You can also perform a math operation, such as integration or differentiation, on a single waveform. The figure that follows shows the latter concept (waveform differentiation).
The following screen shows the source and result of integrating a single waveform into an integral math waveform.

You can create up to eight math waveforms; click the following math-waveform background topics:

- Math Waveform Caveats (see page 202)
- Math Waveform Key Points (see page 202)
- Math Waveform Operations (see page 204)

See Also:

Define Math Dialog Box Overview (see page 189)
Math Waveform Slot Select (see page 190)
Math Expression Field (see page 191)
Math Functions (see page 193)
Math Sources (see page 195)
Math Keypad (see page 196)
Math Syntax Controls (see page 197)
Math Average Risetime and Mode (see page 198)
Math Measurement Scalars (see page 199)
Math Waveform Caveats

- **Functions**: Powerful functions, such as integrate, differentiate, average, can be taken on single waveforms or more complicated expressions.

- **Measurement scalars**: The results (scalars) from automatic measurements can be used in expressions. For example, you can use the measurement Mean on a waveform and subtract, from the original waveform, the scalar that results to define a new math waveform.

Some operations that you cannot use with math waveforms follow:

- **Math-on-Math**: You cannot use math waveforms as sources for other math waveforms. For example if you have a math waveform defined as \( M1 = C1 - C2 \), you cannot define a second math waveform as \( M2 = M1 + C3 \). You can, however, expand the second math waveform to \( M2 = C1 - C2 + C3 \).

- **Mag time base expressions**: Sources for math expressions must be sources associated with the Main time base. For example, \( M3 = C1 + C2 \) uses these sources as acquired and displayed by the Main time base, not by the Mag1 or Mag2 time base. You cannot create \( M3 = C1(\text{ Main}) - C2(\text{Mag1}) \).

- **Waveform databases as sources**: If you assign a channel to a waveform database and then use the channel in a math waveform expression, the data currently acquired in the channel is used, not the data accumulated in the waveform database over time.

Math Waveform Key Points

Some examples of typical math expressions and the math waveforms produced follow.

<table>
<thead>
<tr>
<th>Task</th>
<th>Enter this math expression</th>
<th>To display this math waveform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalize a waveform</td>
<td>((C1 - \text{Meas1})/ \text{Meas2}), where ( C1 ) is waveform shown left ( \text{Meas1} = \text{Low of } C1 ) ( \text{Meas2} = \text{amplitude of } C1 )</td>
<td>Shifted and scaled to fit a std. template Normalized math waveform [\begin{array}{c} 1.05V \ 1.00V \ 0.95V \end{array}]</td>
</tr>
<tr>
<td>Simulate ac coupling and integrate</td>
<td>(\text{Intg}(C1-\text{Meas1})), where ( C1 ) is waveform shown left ( \text{Meas1} = \text{set to take the Mean of } C1 )</td>
<td>DC component removed before integration AC integration math waveform [\begin{array}{c} +3V \ -3V \end{array}]</td>
</tr>
</tbody>
</table>
- **Sources:** Math Waveforms can incorporate the following sources:
  - Channel waveforms
  - Reference waveforms
  - Measurement scalars (automated measurements) that measure channel or reference waveforms in any time base
  - Fixed scalars that you enter as numerical constants in expressions

- **Source dependencies:** In general, math waveforms that include sources as operands are affected by updates to those sources:
  - Shifts in amplitude or DC level of input sources that cause the source to clip also clip the waveform data supplied to the math waveform.
  - Changes to the vertical offset setting for a channel source that clip its data also clip the waveform data supplied to the math waveform.
  - Changes to the acquisition mode globally affect all input channel sources, thereby modifying any math waveforms using them. For example, with the acquisition mode set to Envelope, a \( C1 + C2 \) math waveform will receive enveloped channel 1 and channel 2 data and, therefore, will also be an envelope waveform.
  - Clearing the data in a waveform source causes a baseline (zero-volt level) to be delivered to any math waveform that includes that source until the source receives new data.

- **Time base dependencies:** Selections for math–waveform sources (operands) consist of channel and reference waveforms that are acquired or defined and viewed in the main time base. The math waveforms derive their time base and record lengths from waveform sources. You cannot change them directly; you can only change them indirectly by changing the time base for the source.

  In case of sources having different record lengths, the math waveform created matches the shorter waveform, and the additional trailing data from the longer waveform is not used. You may also want to read about the **channel deskewing control.**

- **Expression syntax:** You build math waveforms using the Define Math Waveform dialog box. To help you create valid math waveforms, this dialog box blocks illegal entries by disabling any dialog–box element that would create an invalid entry in the math waveform expression.

  The **expression syntax** describes valid math expressions, which can be quite complex (more than 100 characters long).
Math Waveform Operations

This instrument supports many of the same operations that it provides for channel (live) and reference waveforms. For example, you can:

- Vertically scale and position math waveforms on screen
- Take automatic measurements on math waveforms
- Take cursor measurements on math waveforms

In addition to the operations listed, you can save math waveforms as references and make them the source of the four instrument waveform data bases.

Some operations allowed on channel waveforms are not allowed on math waveforms:

- Independent horizontal scaling. Each math waveform that you create derives its horizontal scale and position from the sources you include in its math expression. Horizontal controls will not operate with math waveforms.
- You can adjust these controls for the source waveforms and your adjustments will reflect in the math waveform as the sources update. You can also magnify math waveforms using the Mag1 or Mag2 derived time bases.
- Independent vertical offset. You cannot adjust the offset for a math waveform; you can adjust the offset of channel waveforms used as sources to a math waveform.
- Explicit gating of waveforms. The entire math waveform is used as input to the automatic measurement system.

Keys to Working with Math Waveforms

Basically, you use the same techniques to work with math waveforms that work with channel waveforms. The key points that follow describe operating considerations to take into account when using math waveforms.

- **Source considerations**: In general, be aware that changes to source waveforms that you include as math–expression operands are reflected in the math waveform. See Source Dependencies under Keys to Creating.

- **Display considerations**: Turn on and off the display of math waveforms like you do channel and reference waveforms. Use the same front–panel controls (waveform selection buttons, vertical position and scale knobs) and application controls (waveform control bar elements at the bottom of the display; vertical setup menu). Mouse operation for positioning waveforms on screen work also.

As is true for channel and reference waveforms, turning a math waveform on or off in any time base display, Main, Mag1, or Mag2, also turns it on or off in all the time bases.
About Dialog Box

Access the About DSA8300 dialog box from Help > About the DSA8300. The dialog box is a read-only dialog box that displays the product name, instrument serial number, software version number, and copyright notices.

 Autoset Properties Dialog Box

Use this dialog box to set autoset properties and start the Autoset. Autoset automatically adjusts the instrument parameters to display a waveform of the active signal. Access this dialog box from Utilities > Autoset Properties.

Click the Autoset button to start the autoset process and display the autoset notifier (see page 208). This is the same as pushing the AUTOSET front panel button.

See Also:

Autoset Mode Settings (see page 205)
Autoset Options Settings (see page 207)

Autoset Mode Settings

These controls set the default autoset mode to use when doing an Autoset operation.
Controls-specific help

NOTE. For NRZ or RZ eye mode to work, you must set the signal bit rate in the Horizontal Setup (see page 66) dialog box.

Available settings are:

- **NRZ Eye**: Sets the default autoset for the instrument to acquire the waveform data as follows:
  - One bit (two eye crossings) is displayed over about 7.5 horizontal divisions, centered on the screen.
  - The high/low values are displayed over about 6 vertical divisions, also centered on screen.
  - The Horizontal Reference is set to the first eye crossing.
  - NRZ Eye autoset works on the selected channel or Math waveform.

- **RZ Eye**: Sets the default autoset for the instrument to acquire the waveform data as follows:
  - Two full bits (three eye crossings) are displayed over about 7 horizontal divisions, centered on the screen.
  - The high/low values are displayed over about 5 vertical divisions, also centered on screen.
  - RZ Eye autoset works on the selected channel or Math waveform.
  - The Horizontal Reference is set to the first eye crossing.

- **TDR**: Sets the default autoset for the instrument to acquire the waveform data as a TDR waveform. TDR autoset works on the selected TDR capable channel as follows:
  - The first significant reflection is located and displayed at the third horizontal division.
  - With no significant reflections located, the incident edge is placed at the one-half horizontal division (from left edge).
  - If the Display Incident Edge is on, the incident edge is placed at the one-half horizontal division (from left edge). If the Display Incident Edge is off, the incident edge is placed one horizontal division off the left edge of the screen.
  - When the selected channel is a TDR capable channel and its TDR step is ON, a TDR autoset operation is implicitly executed when autoset is invoked.
- **Period**: Sets the default autoset for the instrument to acquire the waveform data such that the record contains 2 to 3 periods. Period autoset works on the selected channel or Math waveform for only repetitive data.

- **Edge**: Sets the default autoset for the instrument to acquire the waveform data such that the center 20% of the record contains a rising edge. Edge autoset works on the selected channel or Math waveform for only repetitive data.

**NOTE.** When the Trigger Source is set to Pattern Sync, Edge and Period autosets acquire waveform data at 2 bits/div rather than 2 to 3 periods.

**See Also:**

Autoset Options Settings (see page 207)

---

**Autoset Options Settings**

Use controls to select the Autoset Options.

![Options](options.png)

Autoset automatically adjusts the parameters for the selected Options (vertical, horizontal, and/or trigger instrument systems) on the selected waveform. When TDR Mode is selected, the TDR Options also affect the waveform adjustments.

**NOTE.** In some Autoset modes or AutoSync operations, one or more of the options may not be applied as selected.

**See Also:**

Autoset TDR Options Settings. (see page 208)
AutoSet TDR Options Settings

TDR AutoSet automatically adjusts the parameters to display the Incident Edge on screen when this option is selected. When TDR Mode is selected, the TDR Options also affect the waveform adjustments.

**See Also:**

AutoSet Notifier Windows (see page 208)

AutoSet Notifier Windows

The instrument displays an autoSet notifier window when running an AutoSet or AutoSync (or both) operation. The notifier window lists the following conditions:

- Signal Source (Selected waveform).
- Type (Mode). Displays the selected mode.
- Communication Standard selected.
- Bit Rate.
- Options. Lists the instrument systems selected for autoSet. The Options listed may include:
  - Any of the general instrument systems (Trigger, Horizontal, and/or Vertical)
  - Any of the selected AutoSync options (Data Rate, Pattern Length, and/or Data Clock Ratio)
  - Any of the TDR options (Incident Edge)

The AutoSet Type and Options are defined in the AutoSet Properties Dialog Box (see page 205).

The AutoSync Options are defined in the Pattern SyncFrameScan Setup Dialog Box (see page 134).

AutoSync options only display if the Trigger Source Setting (see page 131) is set to Pattern Sync and an AutoSync option is selected.
Calibration Dialog Box Overview

Calibration is the process of characterizing (and subsequently correcting for) various DC inaccuracies that vary due to long term drift (but are stable over the specified operating range of the instrument). Calibration data is stored in nonvolatile calibration memory areas in the mainframe and for each channel within a sampling module. On power-on, the instrument automatically retrieves the calibration data (into volatile run-time memory) for use in operation (that is, correction) and display.

Access this dialog box from Utilities > Calibration.

Use the Calibration dialog box to set and view calibration values for the following:

- Calibration information for the mainframe and all resident sampling module channels.
- Update portions of the calibration information for the mainframe and/or resident sampling module channels, such as the “electronic calibration sticker(s)” information, date, time, and temperature.

Calibration data consists of two parts:

- Calibration Information. The readout-only information displayed in various portions of this dialog box and indicates the current state of the calibration data for each particular item. This is essentially an “electronic calibration sticker.” Only qualified personnel should update the calibration information. Refer to the DSA8300 Specifications and Performance Verification Manual or the DSA8300 Digital Serial Analyzer and Modules Service Manual for more information.
- Calibration Correction Values. The actual correction values generated from the characterization process. Only qualified personnel may characterize and change these values. Contact Technical Support for further information.
Calibration Readout Fields

Use the Calibration dialog box to set and view calibration values.

The Mainframe, Upper Sampling Modules, and Lower Sampling Modules sections of this dialog box reflect the information about the calibration data (that was retrieved during power-on).

A background temperature monitoring process periodically updates the Temp (Temperature) readout fields in these sections (both occur approximately once a minute).

- **Model & Serial#**: Shows the model and serial number of the mainframe and sampling modules.
- **Date/Time**: Shows the date and time that was recorded the last time the calibration information was updated.
- **Status**: Shows the current status of the calibration:
  - **Warm up**: On power-on, and for the first 20 minutes after power-on, the status readout will normally show Warm up (as an indicator that the instrument is within its warm-up period and measurement accuracy is not guaranteed).
  - **Defaults**: If the instrument could not recall the calibration data from its nonvolatile memory area on power-on, the status displays Defaults. Defaults status normally indicates a hardware problem. If this occurs, you should contact Technical Support.
  - **Pass**: After the 20 minute warm-up period has elapsed, the status changes to Pass (unless it is Defaults) and remain this way for the rest of the time the instrument is on.
- **ΔTemp**: Shows the temperature delta between the current measured temperature and the temperature recorded the last time the calibration information was updated.
- **Calibrated in Mainframe**: These readout fields, listed only for sampling module channels, show the channel, model, and serial number of the mainframe in which the sampling module channel resided when the calibration information was updated.

**NOTE.** If any sampling modules are present in the upper sampling module slots, the CH1 and CH2 readouts in the Lower Sampling Modules section will display “overridden by upper modules,” indicating that the channels of the sampling module in the lower left slot are not available for use. To make them available, you must power off the instrument and remove all sampling modules in the upper slots.
Update Calibration Information

Updating calibration information should only be done by qualified personnel. Refer to the *DSA8300 Specifications and Performance Verification Manual* or the *DSA8300 Digital Serial Analyzer and Modules Service Manual* for more information.

See Also:
- Calibration Dialog Box Overview (see page 209)
- Update Calibration Information (see page 211)

Compensation Dialog Box Overview

Access this dialog box from Utilities > Compensation.

Use this dialog box to:
- View the compensation information for the mainframe and all resident sampling module channels.
- Perform compensation for the mainframe and/or resident sampling module channels.
- Manage the compensation storage memory areas for the mainframe and/or resident sampling module channels.
After first installing a sampling module or after moving a sampling module from one compartment to another, you should run compensation from the Utilities menu to make sure the instrument meets its specifications. You must also run compensation whenever the extender configuration is changed from that present at the last compensation. In short, if you install or remove an 80E00 extender, run compensation. If you exchange an extender for one of a different length, run compensation.

Turn on display of the **Compensation Indicator Button (see page 216)**. It will tell you if the instrument or any of its modules requires compensation or calibration.

Compensation is the process of characterizing (and subsequently correcting for) various DC inaccuracies caused by temperature variations.

There are two nonvolatile compensation memory areas in the mainframe and for each channel within a sampling module, referred to as Factory and User compensation memories. Also, there is a volatile, in-use memory version of all compensation data, referred to as the run-time compensation memory, that holds the compensation data that is actually used during operation of the instrument. On power-on, the instrument automatically retrieves the compensation data stored in the nonvolatile User memories into the volatile run-time memory version.

**See Also:**

- Compensation Readout Fields (see page 212)
- Compensation Select Action (see page 214)
- Compensation Targets (see page 215)
- Compensation Results Storage (see page 215)
- Execute Compensation (see page 216)
- Compensation Indicator Button (see page 216)

### Compensation Readout Fields

Use the Compensation dialog box to set, store, and view compensation values.

Look in the Mainframe, Upper Sampling Modules, and Lower Sampling Modules readouts of Compensation dialog box to see information that reflects the compensation data present in the run-time compensation memory. A background temperature-monitoring process periodically updates the Status and ΔTemp (Temperature) fields in these readouts about once a minute.

- **Model & Serial #:** Displays the model and serial number of the mainframe and of the sampling modules.
- **Date/Time:** Displays the date and time corresponding to the last successful compensation.
- **Status:** Displays the current status of the compensation data present in the run-time compensation memory. On power-on, and for the first 20 minutes after power-on, the status readout will normally show Warm up (as a precaution that the instrument is within its warm-up period). If, for some reason, the User compensation data could not be successfully recalled from its nonvolatile memory area on power-on, the status will display “Defaults.” Defaults status normally means a hardware problem. You can force the instrument to generate new run-time compensation data by running compensation. If the operation is successful (that is, goes from Defaults to Warm up or Pass), the instrument may be
Controls-specific help

Compensation Readout Fields

used safely and you may want to store the run-time compensation back into the User compensation memories. If a status of Defaults continues to appear at power-on, you may want to contact Technical Support.

- **ΔTemp**: Displays the temperature difference (delta) between the current measured temperature and the temperature recorded at the last successful compensation (that is, that value stored in the run-time compensation memory).

**NOTE.** If any sampling modules are present in the upper sampling module slots, the CH1 and CH2 readouts in the Lower Sampling Modules section will display “overridden by upper module”, indicating that the channels of the sampling module in the lower left slot are not available for use. To make them available, you must power off the instrument and remove all sampling modules in the upper slots.

After the 20-minute warm-up period has elapsed, the Status field changes to either Pass or Comp Req’d (unless it is Defaults):

- **Pass** status: Indicates that the specific item (that is, mainframe or sampling module channel) may be used safely, as its current temperature is near enough to the temperature at which the run-time compensation data was generated.

- **Comp Req’d** status: Indicates the mainframe or sampling-module channel is not within an acceptable range, providing you with a caution and indicating that you should execute a compensation (at least for those items which do not show Pass). As the instrument continues to operate after the 20 minute warm-up period, the same temperature and status monitoring takes place (that is, status will change from Pass to Comp Req’d if a new measured temperature is not within an acceptable range). The acceptable temperature range is typically ±5 °C. For best accuracy, the temperature range should be within ±2 °C.

- **Fail** status: Indicates an unsuccessful compensation, meaning that the specific part of the instrument may fail to meet specifications and should not be used. You should attempt another compensation, paying careful attention to the messages (for example, removing input signals if required). If compensation continues to fail, you should contact Technical Support.

**NOTE.** If the status for the mainframe or any sampling module channel should change from Pass to Comp Req’d, the instrument does not notify you automatically. You may want to display this dialog box and look at the current status before performing critical analysis and measurement tasks as some instrument specifications are guaranteed only when the compensation status displays Pass.

**See Also:**
- System Compensation Dialog Box Overview (see page 211)
- Compensation Select Action (see page 214)
- Compensation Targets (see page 215)
- Compensation Results Storage (see page 215)
- Execute Compensation (see page 216)
- Compensation Indicator Button (see page 216)
Compensation Select Action

Use the Compensation dialog box to set, store, and view compensation values.

There are four basic actions that you may perform when dealing with compensation and the compensation memories: Save, Recall, Compensate, and Compensate and Save. The Select Action controls allow selection of one of these actions, with further options, thereby determining the exact operation to be performed. Recall and Compensate both affect the compensation information displayed in the information readout fields (since both operations affect the contents of the run-time compensation memory).

- **Save**: Saves the selected items from the volatile run-time compensation memory into the nonvolatile User compensation memories.

- **Recall**: Recalls the selected items from the selected nonvolatile User or Factory compensation memories into the volatile run-time compensation memory. After a recall, the compensation information in the dialog box reflects the changes to the run-time compensation memory.

- **Compensate**: Performs compensation on the selected items. Compensation data generated during compensation is stored in the run-time compensation memory (only those portions that were found to be valid). If the compensation succeeds, as indicated by a Pass status (or a continued Warm up status during the warm-up period), all generated compensation data is stored in the run-time compensation memory, and the information in the dialog box reflects these changes. The instrument uses the new compensation values from a successful compensation while it remains powered on.

- **Compensate and Save**: Performs a compensation (see **Compensate**, above) on the selected items and then saves it (see the **Save** function).

If some part of the compensation failed for a specific item (that is, mainframe or sampling module channel), as indicated by a Fail status, then only those portions that generated compensation data successfully are stored in the run-time compensation memory. The run-time compensation memory portions that correspond to those parts of the compensation that failed are not updated, but retain compensation data from the last compensation that generated them successfully. Therefore, the Date/Time and ΔTemp information is not updated either.

**NOTE.** After a successful compensation, the compensation data is not automatically stored for you in the User nonvolatile compensation memory. To retain the current compensation results permanently (after you power off the instrument), you must specifically store them into the nonvolatile User compensation memory using the **Save** operation.

**NOTE.** Every time you display the Compensation dialog box, all of the selectable controls revert back to default settings: Compensate And Save (Select Action), Mainframe (target item), and User (Storage).

See Also:

- System Compensation Dialog Box Overview (see page 211)
- Compensation Readout Fields (see page 212)
- Compensation Targets (see page 215)
Compensation Targets

Use the Compensation dialog box to set, store, and view compensation values.

Use the two pulldown-list controls below the Select Action control to select one or more target items for the Select Action that you've chosen. The first pulldown list control allows you to select from Mainframe, All Modules, or Module. If you select Module, the second pulldown list control allows you to select a specific sampling module channel.

See Also:
- System Compensation Dialog Box Overview (see page 211)
- Compensation Readout Fields (see page 212)
- Compensation Select Action (see page 214)
- Compensation Results Storage (see page 215)
- Execute Compensation (see page 216)
- Compensation Indicator Button (see page 216)

Compensation Results Storage

Use the Compensation dialog box to set, store, and view compensation values.

Use the Compensation results storage controls to select the destination or source for Recall and Save actions:

- **User**: Saves the current volatile run-time compensation data into the nonvolatile User compensation memory of the selected item(s); or when you want to Recall the nonvolatile User compensation data into the run-time compensation memory.

- **Factory**: Recalls the compensation data that was stored at the factory into the run-time compensation memory. You cannot save to the nonvolatile Factory compensation memory.

See Also:
- System Compensation Dialog Box Overview (see page 211)
- Compensation Readout Fields (see page 212)
- Compensation Select Action (see page 214)
- Compensation Targets (see page 215)
- Execute Compensation (see page 216)
- Compensation Indicator Button (see page 216)
Execute Compensation

Use the Compensation dialog box to set, store, and view compensation values.

Click the **Execute** button to perform the action or operation that you have specified in the Select Action controls. Follow additional instructions that may be displayed (for example, for the Compensate action). After the requested operation completes, the readouts in the dialog box are updated as necessary to reflect the results of the operation.

**TIP.** An actual Save operation only occurs if the compensation status is Pass, Comp Req’d, or Warm up (that is, any time the compensation is valid, even though it may not be within the acceptable temperature range for current operation). A save of multiple items will save those items that meet these update criteria.

See Also:
- [System Compensation Dialog Box Overview](#)
- [Compensation Readout Fields](#)
- [Compensation Select Action](#)
- [Compensation Targets](#)
- [Compensation Results Storage](#)
- [Compensation Indicator Button](#)

## Compensation Indicator Button

Use the Compensation dialog box to set, store, and view compensation values.

Check the **Display** box to display the Compensation Indicator button. When checked, this button is shown near the right-bottom corner of the instrument screen. Check the **Animate** box to display the button with animation.

**NOTE.** You can also turn the display and animation of the indicator on or off from the View menu in the application menu bar.

The color of the thermometer icon on the Compensation Indicator button indicates the need for calibration, compensation, or warm-up as follows:

A **Red** thermometer means that one or more of the following is true:
Calibration status of the main instrument is Defaults
Compensation status of the main instrument is Fail, Required, or Defaults
Calibration status of one or more modules is Defaults
Compensation status of one or more modules is Fail, Required, or Defaults

**NOTE.** In case of more than one status occurring (for example, two modules require compensation and the main instrument requires calibration), the thermometer remains red until all required compensations and calibrations are successfully completed.

A **Yellow** thermometer means that the recommended 20 minute warm-up time has not yet elapsed since the instrument was powered on.

A **Green** thermometer means the instrument and its modules have met the recommended warmed up time and passed their last calibrations and compensations.

**NOTE.** If the Compensation Indicator Button is displayed, right clicking it pops up a menu for quick access of compensation and calibration functions. You can run them from the right-click menu or access their dialog boxes.

**See Also**

- System Compensation Dialog Box Overview (see page 211)
- Compensation Readout Fields (see page 212)
- Compensation Select Action (see page 214)
- Compensation Targets (see page 215)
- Compensation Results Storage (see page 215)
- Execute Compensation (see page 216)

**Diagnostics: Subsystem Level Tab**

Access this dialog box from **Utilities > Diagnostics**. Use this tab to perform diagnostics on hardware subsystems. Select one or more subsystems and click the Run button. If you do not select Loop or Halt on failure, the instrument runs the selection(s) once and returns a result of either Pass or a three-digit result code that displays the first failure encountered in the specific subsystem(s).
You can select one or more subsystems (or deselect subsystems) using the Ctrl or Shift keys.

**NOTE.** *The three digit failure result codes are useful if you need to contact Technical Support.*

- **Run:** Starts the execution diagnostics for the selected subsystems. It will then change to a Stop button that may be used to stop the execution after testing is complete on the current subsystem under test.
- **Loop:** Sets the instrument to repeatedly test the selected subsystems (until terminated with the Abort or Stop buttons).
- **Halt on failure:** Sets the instrument to automatically stop on the first failure.
- **Abort:** Terminates (ends) the testing as soon as possible.
- **Loop Count:** Shows how many times the diagnostics have executed for the selected set of subsystems has executed.
- **Result:** Shows the results of the subsystem (Pass or a three-digit failure code).
- **Failures:** Shows how many total tests have failed in the subsystem.
- **Subsystem:** Shows which subsystem is currently selected (status information which shows you where you are, or where you will go, as you move between the three levels of diagnostics through the Subsystem, Area, and Test tabs).
- **Area:** Shows which area is currently selected (status information which shows you where you are at, or where you will go, as you move between the three levels of diagnostics through the Subsystem, Area, and Test tabs).
- **Test:** Shows which test is currently selected (status information which shows you where you are at, or where you will go, as you move between the three levels of diagnostics through the Subsystem, Area, and Test tabs).
The subsystem level of diagnostics is the highest level at which to perform diagnostics. For more detailed diagnostics, see (see page 219) or (see page 220) diagnostics. The same principles of use apply that Subsystem Level diagnostics use.

See Also:

Diagnostics: Area Level Tab (see page 219)
Diagnostics: Test Level Tab (see page 220)

Diagnostics: Area Level Tab

Access this dialog box from Utilities > Diagnostics. Use this tab to perform diagnostics on hardware circuit areas of a specific subsystem. Select one or more areas and click the Run button. If you do not select Loop or Halt on failure, the instrument runs the selection(s) once and returns a result of either Pass or a three-digit result code that displays the first failure encountered in the specific area(s).

You can select one or more areas (or deselect areas) using the Ctrl or Shift keys.

- **Run**: Starts the execution of the diagnostics for the selected areas. It will then change to a Stop button that may be used to stop the execution after testing is complete on the current set of selected areas.
- **Loop**: Sets the instrument to repeatedly test the selected areas (until terminated with the Abort or Stop buttons).
- **Halt on failure**: Sets the instrument automatically stop on the first failure.
- **Abort**: Terminates (ends) the testing as soon as possible.
- **Loop Count**: Shows how many times the diagnostics have executed for the selected set of areas has executed.

- **Result**: Shows the results of the diagnostics for the area (Pass or a three-digit failure code).

- **Failures**: Shows how many total tests have failed in the area.

- **Subsystem**: Shows which subsystem is currently selected (status information which shows you where you are at, or where you will go, as you move between the three levels of diagnostics through the Subsystem, Area, and Test tabs).

- **Area**: Shows which area is currently selected (status information which shows you where you are at, or where you will go, as you move between the three levels of diagnostics through the Subsystem, Area, and Test tabs).

- **Test**: Shows which test is currently selected (status information which shows you where you are at, or where you will go, as you move between the three levels of diagnostics through the Subsystem, Area, and Test tabs).

**See Also:**

- Diagnostics Subsystem Level Tab (see page 217)
- Diagnostics Test Level Tab (see page 220)

---

**Diagnostics: Test Level Tab**

Use this tab to perform one or more low-level diagnostic tests on a specific hardware circuit area of a specific subsystem. Select one or more tests and click the Run button. If you do not select Loop or Halt on failure, the instrument runs the selection(s) once and returns a result of either Pass or a three-digit result code that indicates a failure of the specific test(s). Access this dialog box from **Utilities > Diagnostics**.
You can select one or more tests (or deselect tests) using the Ctrl or Shift keys.

- **Run**: Starts the execution of the selected tests. It will then change to a Stop button that may be used to stop the execution after testing is complete on the current set of selected tests.

- **Loop**: Sets the instrument to repeatedly execute the selected tests (until terminated with the Abort or Stop buttons).

- **Halt on failure**: Sets the instrument to automatically stop testing on the first failure.

- **Abort**: Terminates (ends) the testing as soon as possible.

- **Loop Count**: Shows how many times the selected set of tests has executed.

- **Result**: Shows the result of the test (Pass or a three-digit failure code).

- **Failures**: Shows how many times the test has failed.

- **Subsystem**: Shows which subsystem is currently selected (status information which shows you where you are at, or where you will go, as you move between the three levels of diagnostics through the Subsystem, Area, and Test tabs).

- **Area**: Shows which area is currently selected (status information which shows you where you are at, or where you will go, as you move between the three levels of diagnostics through the Subsystem, Area, and Test tabs).

- **Test**: Shows which test is currently selected (status information which shows you where you are at, or where you will go, as you move between the three levels of diagnostics through the Subsystem, Area, and Test tabs).

**See Also:**

- [Diagnostics Subsystem Level Tab (see page 217)](#)
- [Diagnostics: Area Level Tab (see page 219)](#)

**User Preferences: General Tab**

Access this dialog box from **Utilities > Preferences**. Use the General tab in the User Preferences dialog box to set defaults for various application settings:
- **Virtual Keyboard Type**: Sets the default on-screen keyboard layout (Alphabetical or QWERTY).
- **Power Up Diagnostics**: Sets the power up instrument self-diagnostics mode (Normal or Cycle).
- **UI Save/Recall Directory**: Sets the pathname to the default image save file location.
- **PI Save/Recall Directory**: Sets the pathname to the default ??? save file location.

**See Also:**
- User Preferences: Startup Tab (see page 222)
- User Preferences: GPIB Configuration Tab (see page 224)

**User Preferences: Start-up Tab**

Access this dialog box from **Utilities > Preferences**. Use this dialog box to set the start-up values you want used at the beginning of each session.
TIP. Click the keyboard icon to display the pop-up keyboard. The keyboard allows you to enter text using the mouse or touchscreen.

- **Setup from the last session**: Sets the instrument to use the system settings from the last session as the start-up settings for the current session.
- **Factory setup**: Sets the instrument to use the default factory system settings.
- **Saved setup**: Sets the instrument to load system settings previously saved to a file. Enter the path of the saved setup in the Saved Setup path field.

**TIP.** If the specified file name is not valid or is not of the correct type, the instrument will load the default factory setup.

See Also:

[User Preferences: General Tab](#) (see page 221)
[User Preferences: GPIB Configuration Tab](#) (see page 224)
User Preferences: GPIB Configuration Tab

This control sets the GPIB instrument address and communication mode. Access this dialog box from Utilities > Preferences > GPIB Configuration tab.

- **GPIB Address**: Sets the instrument GPIB address. The default instrument GPIB address is 1.
- **GPIB Mode**: Sets the instrument GPIB communication mode. Select Talk/Listen (Slave) (default), Off Bus, or Controller (Master). The DSA8300 is set to Talk/Listen (Slave) mode by default to enable remote access and control. Software applications that communicate with the instrument using GPIB should use the specified GPIB address. Refer to the DSA8300 Programmer Manual for more information about remote GPIB control.

**NOTE.** The instrument automatically restarts (reboots) when changing between Talk/Listen and Controller modes.

**See Also:**

DSA8300 Online Programmer Guide
User Preferences: General Tab (see page 221)
User Preferences: Startup Tab (see page 222)
System Properties Dialog Box: Mainframe Tab

Access this dialog box from Utilities > System Properties. Use the Mainframe tab to view information about the main instrument. This is a read-only dialog box.

The Total On-Time and Current On-Time readouts do not update automatically while the dialog box is open. To get updated information, close the dialog box and reopen it.

**NOTE.** This information is helpful to have if you need to call Technical Support for any reason.

See Also:

- System Properties Dialog Box: Modules Tab (see page 226)
- System Properties Dialog Box: Probes Tab (see page 227)
Access this dialog box from **Utilities > System Properties**. Use the Modules tab view information about installed modules. The initial view of this dialog box presents module channel numbers for those installed. To view characteristics and other information for one or more module channels, click the + next to the channel number.

**NOTE.** When a probe is attached to a module, the resulting dynamic range and nondestruct range equals the lesser value of the two devices.

See Also:

- **System Properties Dialog Box: Mainframe Tab (see page 225)**
- **System Properties Dialog Box: Probes Tab (see page 227)**
- **System Properties Dialog Box: Options Tab (see page 228)**
System Properties Dialog Box: Probes Tab

Access this dialog box from **Utilities > System Properties**. Use the Probes tab view information about probes that are currently installed.

The default view of this dialog box presents probe channel numbers for those installed. To view characteristics and other information for one or more probes, click the + next to the channel number.

**NOTE.** This dialog box will not update automatically if you attach or detach probes while it is open. To get updated information, close the dialog box and reopen it.

**NOTE.** The dynamic range and non-destruct range equals the lesser value of the probe or the module to which it is connected.

**See Also:**

- System Properties Dialog Box: Mainframe Tab (see page 225)
- System Properties Dialog Box: Modules Tab (see page 226)
- System Properties Dialog Box: Options Tab (see page 228)
System Properties Dialog Box: Options Tab

Use the Options tab to view information about the options enabled in the main instrument. This information may be helpful to have if you need to call Technical Support for any reason.

Access this dialog box from Utilities > System Properties.

The Option Installation Key area displays the keys entered to enable purchased options.

See Also:

System Properties Dialog Box: Mainframe Tab (see page 225)
System Properties Dialog Box: Modules Tab (see page 226)
System Properties Dialog Box: Probes Tab (see page 227)
Waveform Properties Dialog Box

Use this dialog box to set waveform properties of the active (selected) waveform, including waveform position, offset, label and color. These controls are the same as those found in the Vertical and Horizontal Setup tabs, except for the waveform Color and Waveform Label controls.

Access this dialog box from Utilities > Waveform Properties. You can also display the dialog box by right clicking on the waveform icon at the left of the display and selecting Properties from the menu that pops up.

![Waveform Properties Dialog Box](image)

The settings apply to the selected (see page 30) waveform. To set properties for another waveform, close the Waveform Properties dialog box, select another waveform, and reopen the Waveform Properties dialog box.

See Also:

- Vertical Setup Basic Dialog Box Overview (see page 147)
- Horizontal Setup Dialog Box Overview (see page 66)
Automatic Measurements Reference Overview

This reference describes the instrument automatic measurements. Automatic measurements support Pulse, Return-to-Zero (RZ), and Non-Return-to-Zero (NRZ) signals, providing measurements in three categories, Amplitude, Timing, and Area.

This reference gathers reference information for automatic measurements. Specifically, it lists:

- A definition for each auto-measurement type (for example, rise time, period, and suppression ratio), organized according to the signal measured (Pulse, Return-to-Zero eye pattern, or Non-Return-to-Zero eye pattern).

- Descriptions of the reference parameters (levels and crossings) that the automatic measurement system uses when taking automatic measurements.

- Descriptions of the methods for tracking the High and Low values that the automatic measurement system uses when in taking automatic measurements.

To learn about the controls that set up the automatic measurements, see the Meas Setup dialog box (see page 98).

Pulse Amplitude Measurements

**AC RMS**

The root-mean-square voltage, minus the DC component, of the waveform that is sampled within the measurement region.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.

**Amplitude**

The vertical difference between the High and Low of the signal. The method used to determine the High and the Low values can be controlled independently by the tracking method (see page 276).

Amplitude = High – Low, where High and Low where High and Low (see page 268) are measured values.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Average Optical Power (dBm)** | The true average component of an optical signal, expressed in decibels. This measurement results from the use of a hardware average-power monitor circuit rather than from the calculation of digitized waveform data.  
*NOTE.* Average optical power measurements return valid results only on channels that contain average power monitors. In general, all optical sampling module channels contain average power monitors.  
To determine Average Optical Power (dBm), this measurement simply converts average optical power (watts) to decibels using a log10 function, referenced to 1mW. To see how average optical power in watts is determined, see the **Average Optical Power (Watts)** measurement.  
For best measurement results:  
- Use a factory-calibrated wavelength. If using the USER wavelength setting, make sure that it is properly compensated by performing the User Wavelength Gain compensation found by clicking the Optical button in the Vertical Setup dialog box.  
- Compensate the optical channel (found in the Utilities->Compensation dialog box). A portion of this overall optical channel compensation will correct for minor DC variances in the average power monitor. |
| **Average Optical Power (watts)** | The true average component of an optical signal. Average optical power measurements return valid results only on channels that contain average power monitors.  
*NOTE.* In general, all optical sampling module channels contain average power monitors.  
To obtain accurate results, the O/E converter is calibrated at a number of wavelengths to determine the conversion gain of the O/E converter at each wavelength.  
For best average optical power measurement results:  
- Use a factory-calibrated wavelength. If using the USER wavelength setting, make sure that it is properly compensated by performing the User Wavelength Gain compensation found by clicking the Optical button in the Vertical Setup dialog box.  
- Compensate the optical channel, which corrects for minor DC variances in the average-power monitor as part of the compensation routine. To access, choose Compensation in the Utilities menu of the application. |
| **Cycle Mean** | The arithmetic mean of the waveform over the first cycle of the measurement region. The waveform cycle is determined at the crossings (see page 268) of the mid-reference level.  
The mid-reference level (see page 268) is adjustable and defaults to 50% of the pulse amplitude.  
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement. |
| **Cycle RMS** | The root-mean-square amplitude of the waveform within the first period of the measurement region.  
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement. |
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
<th>Measurement Gates</th>
<th>Vertical Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain</td>
<td>The amplitude gain between two waveforms. The measurement returns the ratio between the amplitudes measured within the measurement regions of the two sources. Gain = Amplitude1 / Amplitude2, where Amplitude1 and Amplitude2 are the Amplitude (see page 231) measurements of the two source waveforms. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2)s of the two sources. For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>High</td>
<td>The top reference level for a measured waveform. Several methods (see page 276) can be applied to the data sampled in the upper half of the waveform to determine the High value. You can use the Tracking Method control (see page 105) to select among them. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Low</td>
<td>The bottom reference level for a measured waveform. Several methods (see page 276) can be applied to the data sampled in the lower half of the waveform to determine the Low value, and you can use the Tracking Method control (see page 105) to select among them. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Max</td>
<td>The largest amplitude peak of the waveform over the measurement region. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mean</td>
<td>The arithmetic mean of the waveform over the measurement region. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mid</td>
<td>The computation of the middle point between the maximum and minimum amplitude peaks of the waveform over the measurement region. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Min</td>
<td>The smallest amplitude value of the waveform over the measurement region. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Optical Modulation Amplitude

The difference between the average power levels of the logic 1, High, and the logic 0, Low, of the optical pulse signal. The levels are the Mean values of the logical levels sampled within an Aperture of the logical 1 and 0 regions of the pulse. The logical 1 and 0 time intervals are marked by the crossings of a reference level determined by the Average Optical Power (AOP) of the signal.

Pulse OMA [watts] = \( P_1 - P_0 \), where:

- \( P_1 \) (see page 268) and \( P_0 \) (see page 268) are the average power levels of the logical 1 and 0, determined within the respective apertures.

The adjustable Aperture (see page 268) defaults to 20% center respectively of the logical 1 and logical 0 time intervals.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

For best measurement results:

- Perform a vertical compensation (see page 215) upon installing the sampling module and any time the temperature of the system has changed by more than 5 degrees Celsius.
- Perform a Dark Level (see page 171) compensation before taking this measurement.

<table>
<thead>
<tr>
<th>+Overshoot</th>
<th>The ratio of the maximum peak to the signal amplitude over the measurement region, expressed as a percentage.</th>
</tr>
</thead>
<tbody>
<tr>
<td>+Overshoot = 100 * (Max – High) / (High – Low), where:</td>
<td></td>
</tr>
<tr>
<td>Max is the signal maximum</td>
<td></td>
</tr>
<tr>
<td>High and Low are the 100% and 0% reference levels</td>
<td></td>
</tr>
</tbody>
</table>

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.

<table>
<thead>
<tr>
<th>-Overshoot</th>
<th>The ratio of the minimum waveform value to the signal amplitude over the measurement region, expressed as a percentage.</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Overshoot = 100 * (Low – Min) / (High – Low), where:</td>
<td></td>
</tr>
<tr>
<td>Min is the signal minimum</td>
<td></td>
</tr>
<tr>
<td>High and Low are the 100% and 0% signal reference levels</td>
<td></td>
</tr>
</tbody>
</table>

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement.

### Peak-to-Peak Noise

The maximum range of the waveform amplitude variance sampled within a fixed-width vertical slice located at the center of the measurement region.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

1. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).
2. Optimize the vertical resolution (see page 236) before taking this measurement.
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Pk-Pk**   | The absolute difference between the maximum and minimum (see page 268) amplitude values of the waveform in the measurement region.  
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement. |
| **RMS**     | The true root-mean-square value of the waveform over the measurement region.  
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement. |
| **RMS Noise** | One standard deviation of the waveform amplitude variance, sampled within a fixed-width vertical slice located at the center of the measurement region.  
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
3. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).  
For best results with this measurement, optimize the vertical resolution (see page 236) before taking this measurement. |
| **Signal-to-Noise Ratio** | The ratio of the signal amplitude to the noise level. The noise level is defined as one standard deviation of the waveform amplitude variance within a fixed-width vertical slice located at the center of the measurement region.  
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
This measurement requires the use of a waveform database. When this measurement is turned on, it automatically sets the measurement system to use a waveform database if available (see page 250). |
To Optimize the Vertical Resolution

Optimizing vertical resolution improves the result this measurement produces. Try these methods:

- Execute Autoset (push AUTOSET on the front-panel).
- Adjust the instrument vertical scale using the Vertical SCALE knob, or increase the signal amplitude, to increase the overall vertical size of the waveform while keeping the waveform upper and lower peaks on screen.

Pulse Timing Measurements

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burst width</td>
<td>The time between the first and last crossings, either positive or negative, of the waveform at the mid-reference level in the measurement region. The mid-reference level is adjustable and defaults to 50% of the pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).</td>
</tr>
<tr>
<td>Cross+</td>
<td>The time of the first positive crossing of the data sampled at the mid-reference level in the measurement region. Cross+ = Tcross, where Tcross is the horizontal coordinate of the first positive crossing. The mid-reference level is adjustable and defaults to 50% of the pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default, searching is forward from the Start Gate for the first rising edge, but can be reversed, so that searching is backward from the Stop Gate.</td>
</tr>
<tr>
<td>Cross-</td>
<td>The time of the first negative crossing of the data sampled at the mid-reference level in the measurement region. Cross- = Tcross, where Tcross is the horizontal coordinate of the first negative crossing. The mid-reference level is adjustable and defaults to 50% of the pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default, searching is forward from the Start Gate for the first falling edge, but can be reversed, so that searching is backward from the Stop Gate.</td>
</tr>
<tr>
<td>Delay</td>
<td>The time interval between the crossings of the two mid-reference levels on the two sources of the measurement. Delay = Tcross(source1) – Tcross(source2), where Tcross is the first positive or negative crossing time at mid-reference level. The mid-reference levels are adjustable and default to 50% of the pulse amplitude. The slope can be selected to be the first positive, the first negative, or the first crossing (positive or negative) in the region. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2) of the two sources. By default, searching is forward from the Start Gate for each source, but can be reversed, so that searching is backward from the Stop Gate. Direction can be controlled independently for the two waveform sources.</td>
</tr>
</tbody>
</table>
+Duty Cycle

The ratio (expressed as a percentage) of the first positive pulse width within the measurement region to the period of the signal. The time intervals are determined at mid-reference level.

If Tcross1 is positive, then: +Duty Cycle = 100 * (Tcross2 – Tcross1) / (Tcross3 – Tcross1).
If Tcross1 is negative, then: +Duty Cycle = 100 * (Tcross3 – Tcross2) / (Tcross3 – Tcross1).

Tcross1, Tcross2 and Tcross3 are the times of the first three consecutive crossings at the mid-reference level.

The mid-reference levels are adjustable and default to 50% of the pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

-Duty Cycle

The ratio (expressed as a percentage) of the first negative pulse width within the measurement region to the period of the signal. The time intervals are determined at mid-reference level.

If Tcross1 is positive, then: -Duty Cycle = 100 * (Tcross3 – Tcross2) / (Tcross3 – Tcross1).
If Tcross1 is negative, then: -Duty Cycle = 100 * (Tcross2 – Tcross1) / (Tcross3 – Tcross1).

Tcross1, Tcross2 and Tcross3 are the times of the first three consecutive crossings at the mid-reference level.

The mid-reference level is adjustable and defaults to 50% of the pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

Fall Time

The time interval between times of the high reference level and the low reference level crossings on the negative slope of the pulse. RZ Fall Time = TcrossL – TcrossH, where:
TcrossL is the time of the crossing of the low reference level
TcrossH is the time of crossing of the high reference level. The low reference and high reference levels are adjustable and default to 10% and 90% of the pulse amplitude.

There are four Reference Level Calculation methods available for determining these reference levels. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).
By default, the algorithm searches forward from the Start Gate for the first falling edge, but the Direction of traversal can be reversed, so that the search will be backward from the Stop Gate.

Frequency

The inverse of the Period of the signal. Frequency = 1 / (Tcross3 – Tcross1), where Tcross3 and Tcross1 are the times of the first two consecutive crossings on the same slope at the mid-reference level.

The mid-reference level is adjustable and defaults to 50% of the pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

Period

The time interval between two consecutive crossings on the same slope of the signal at the mid-reference level. Period = Tcross3 – Tcross1, where Tcross3 and Tcross1 are the times of the first two consecutive crossings on the same slope at the mid-reference level.

The mid-reference level is adjustable and defaults to 50% of the pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase</td>
<td>The amount of lead or lag of Source1 relative to Source2, expressed in degrees, where 360° comprise a signal period. Tcross1 of source1 is the time of the first crossing of either polarity on source 1. Tcross3 of source1 is the time of the next crossing on source 1 of the same polarity as Tcross1. Tcross1 of source 2 is the time of the first crossing of either polarity on source 2 after Tcross1 of source1. All Tcrossings are at the mid-reference levels, which are adjustable and default to 50% of the pulse amplitude. If measurement gates are enabled, the measurement region is constrained between the Start Gate (G1) and Stop Gate (G2) of the sources.</td>
</tr>
<tr>
<td>Pk-Pk Jitter</td>
<td>The delta between the minimum and maximum of time crossings of data sampled at the mid-reference level. Pk-Pk Jitter = Tcrosspp, where Tcrosspp is the difference between the maximum crossing time and the minimum crossing time for a histogram of the Tcross values. Tcross is the horizontal coordinate of the first positive or negative crossing. The mid-reference level is adjustable and defaults to 50% of the pulse amplitude. The slope can be selected to be the first positive, the first negative, or the first crossing (positive or negative) in the region. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default, the algorithm searches forward from the Start Gate for the first specified edge, but the Direction of traversal can be reversed, so that the search will be backward from the Stop Gate. This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.</td>
</tr>
<tr>
<td>Rise Time</td>
<td>The time interval between the low-reference level and the high reference level crossings on the positive slope of the pulse. RZ Rise Time = TcrossH – HcrossL, where: TcrossH is the time of crossing of the high reference level. TcrossL is the time of crossing of the low reference level. The low reference and high reference levels are adjustable and default to 10% and 90% of the pulse amplitude. There are four Reference Level Calculation methods available for determining these reference levels. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default the algorithm searches forward from the Start Gate for the first rising edge, but the Direction of traversal can be reversed, so that the search will be backward from the Stop Gate.</td>
</tr>
<tr>
<td>RMS Jitter</td>
<td>The time variance on the time crossings of data sampled at the mid-reference level. RMS Jitter is defined as one standard deviation (s) of that variance. RMS Jitter = Tcrosss, where Tcrosss is one standard deviation of the variance of crossing times for a histogram of the Tcross values. Tcross is the horizontal coordinate of the first positive or negative crossing. The mid-reference level is adjustable and defaults to 50% of the pulse amplitude. The slope can be selected to be the first positive, the first negative, or the first crossing (positive or negative) in the region. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default, the algorithm searches forward from the Start Gate for the first falling edge, but the Direction of traversal can be reversed, so that the search will be backward from the Stop Gate. This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.</td>
</tr>
</tbody>
</table>
Automatic Measurements Reference

Pulse Area Measurements

| +Width | The horizontal interval between the crossings of the rising and falling edges at the mid-reference level of the first positive pulse in the measurement region. +Width = Tcross2 – Tcross1, where Tcross1 and Tcross2 are the two consecutive horizontal crossings on the first positive pulse. The mid-reference level is adjustable and defaults to 50% of the pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). |
| -Width | The horizontal interval between the crossings of the falling and rising edges at the mid-reference level of the first negative pulse in the measurement region. -Width = Tcross2 – Tcross1, where Tcross2 and Tcross1 are the two consecutive horizontal crossings on the first negative pulse. The mid-reference level is adjustable and defaults to 50% of the pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). |

Pulse Area Measurements

| Area | The area under the curve for the waveform within the measurement region. Area measured above ground is positive; area measured below ground is negative. Area = waveform(t) dt, over the measurement region. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). For best results, optimize the vertical resolution (see page 236) before taking this measurement. |
| Cycle Area | The area under the curve for the first waveform period within the measurement region. Area measured above ground is positive; area measured below ground is negative. Area = waveform(t) dt over the first waveform period within the measurement region. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). For best results, optimize the vertical resolution (see page 236) before taking this measurement. |
# RZ Amplitude Measurements

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
</table>
| **RZ AC RMS**        | The root mean square amplitude, minus the DC component, of the waveform that is sampled within the measurement region.  
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).  
For best results with this measurement:  
- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
- Optimize the vertical resolution (see page 236) before taking this measurement. |
| **RZ Amplitude**     | The difference between the logical 1 level (High) and the logical 0 level (Low) of the RZ signal. Both High and Low levels are measured within the Eye Aperture.  
RZ Amplitude = High – Low, where High and Low (see page 268) are the logical 1 and 0 levels.  
The Eye Aperture (see page 268) is adjustable and defaults to 5% of the RZ pulse width.  
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).  
For best results with this measurement:  
- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
- Optimize the vertical resolution (see page 236) before taking this measurement. |
| **RZ Area**          | The area under the curve for the RZ waveform within the measurement region. Area measured above ground is positive; area measured below ground is negative. RZ Area = \( \int \text{waveform}(t) \, dt \) over the measurement region.  
If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
This measurement requires the use of a waveform database.  
When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available. For best results with this measurement, perform a Dark Level compensation before taking this measurement if the source of the measured waveform is an optical channel. Also optimize the vertical resolution (see page 236) before taking this measurement. |
| **RZ Cycle Area**    | The area under the curve for the first RZ bit period. Area measured above ground is positive; area measured below ground is negative. RZ Area = \( \int \text{waveform}(t) \, dt \), where the measurement region is from Start Gate (G1) to Stop Gate (G2), if measurement gates are enabled, or the first acquired RZ cycle.  
If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available. For best results with this measurement, perform a Dark Level compensation before taking this measurement if the source of the measured waveform is an optical channel. Also optimize the vertical resolution (see page 236) before taking this measurement. |
### RZ Average Optical Power (dBm)

The true average component of an optical signal, expressed in decibels. This measurement results from the use of a hardware average power monitor circuit rather than from the calculation of digitized waveform data.

**NOTE.** Average optical power measurements return valid results only on channels that contain average power monitors. In general, all optical sampling module channels contain average power monitors.

To determine RZ Average Optical Power (dBm), this measurement simply converts average optical power (watts) to decibels using a log10 function referenced to 1 mW. To determine average optical power in watts, see the **RZ Average Optical Power (Watts)** measurement.

For best average optical power measurement results:

- Use a factory-calibrated wavelength. If using the USER wavelength setting, make sure that it is properly compensated by performing the User Wavelength Gain compensation found by clicking the Optical button in the Vertical Setup dialog box.
- Compensate the optical channel, which corrects for minor DC variances in the average power monitor as part of the compensation routine. To access, choose Compensation in the Utilities menu of the application.

### RZ Average Optical Power (Watts)

The true average component of an optical signal.

**NOTE.** Average optical power measurements return valid results only on channels that contain average power monitors. In general, all optical sampling module channels contain average power monitors.

To obtain accurate results, the O/E converter is calibrated at a number of wavelengths to determine the conversion gain of the O/E converter at each wavelength. For best average optical power measurement results:

- Use a factory-calibrated wavelength. If using the USER wavelength setting, make sure that it is properly compensated by performing the User Wavelength Gain compensation found by clicking the Optical button in the Vertical Setup dialog box.
- Compensate the optical channel, which corrects for minor DC variances in the average power monitor as part of the compensation routine. To access, choose Compensation in the Utilities menu of the application.

### RZ Extinction Ratio

The ratio of the average power levels of the logic 1 level (High) to the logic 0 level (Low) of an optical RZ signal. All level determinations are made within the RZ Eye Aperture.

RZ ExtRatio = High / Low, where High and Low (see page 268) are the logical 1 and 0 levels.

The **Eye Aperture** (see page 268) is adjustable and defaults to 5% of the RZ pulse width. If enabled, **measurement gates** (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best measurement results:

- Always perform a Dark Level compensation before taking this measurement to make sure accurate results. Access the Dark Level compensation from the Optical page of the Vertical Setup dialog box (see page 168).
- **Optimize the vertical resolution** (see page 236) before taking this measurement.
| **RZ Extinction Ratio (%)** | The ratio of the average power levels of the logic 0 level (Low) to the logic 1 level (High) of an optical RZ signal, expressed as a percentage. All level determinations are made within the RZ Eye Aperture.  
RZ ExtRatio [%] = 100 * (Low / High), where High and Low (see page 268) are the logical 1 and 0 levels.  
The Eye Aperture (see page 268) is adjustable and defaults to 5% of the RZ pulse width.  
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).  
For best measurement results:  
▪ Always perform a Dark Level compensation before taking this measurement to ensure accurate results. Access the Dark Level compensation from the Optical page of the Vertical Setup dialog box (see page 168).  
▪ Optimize the vertical resolution (see page 236) before taking this measurement. |
| **RZ Extinction Ratio (dB)** | The ratio of the average power levels of the logic 1 level (High) to the logic 0 level (Low) of an optical RZ signal, expressed in decibels, dB. All level determinations are made within the RZ Eye Aperture.  
RZ ExtRatio [dB] = 10 * log (High / Low), where High and Low (see page 268) are the logical 1 and 0 levels.  
The Eye Aperture (see page 268) is adjustable and defaults to 5% of the RZ pulse width.  
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).  
For best measurement results:  
▪ Always perform a Dark Level compensation before taking this measurement to ensure accurate results. Access the Dark Level compensation from the Optical page of the Vertical Setup dialog box (see page 168).  
▪ Optimize the vertical resolution (see page 236) before taking this measurement. |
### RZ Eye Height

RZ Eye Height is a measure of how noise affects the vertical opening between the **High** and **Low** levels of an RZ pulse. The RZ pulse is sampled within the Eye Aperture, where the **High** and **Low** levels are determined as the mean of the histogram of the data distribution in the upper and lower half of the pulse, respectively. The noise levels are characterized by $s_{\text{high}}$ and $s_{\text{low}}$, the standard deviations from the mean for the **High** and **Low** levels.

RZ Eye height = $(\text{High} - 3 \times s_{\text{high}}) - (\text{Low} + 3 \times s_{\text{low}})$, where **High** and **Low** (see page 268) are the logical 1 and 0 levels, and $s_{\text{high}}$ and $s_{\text{low}}$ are the standard deviations.

The **Eye Aperture** (see page 268) is adjustable and defaults to 5% of the RZ pulse width.

If enabled, **measurement gates** (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:

- **Perform a Dark Level** (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- **Optimize the vertical resolution** (see page 236) before taking this measurement.

### RZ Eye Opening Factor

RZ Eye Opening Factor is a measure of how noise affects the vertical opening between **High** and **Low** levels of an RZ pulse. The RZ pulse is sampled within the Eye Aperture, where the **High** and **Low** levels are determined as the mean of the histogram of the data distribution in the upper and lower half of the pulse, respectively. The noise levels are characterized by $s_{\text{high}}$ and $s_{\text{low}}$, the standard deviations from the mean for the **High** and **Low** levels.

RZ Eye Opening Factor = $\frac{(\text{High} - s_{\text{high}}) - (\text{Low} + s_{\text{low}})}{(\text{High} - \text{Low})}$, where **High** and **Low** (see page 268) are the logical 1 and 0 levels, and $s_{\text{high}}$ and $s_{\text{low}}$ are the standard deviations.

The **Eye Aperture** (see page 268) is adjustable and defaults to 5% of the RZ pulse width.

If enabled, **measurement gates** (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:

- **Perform a Dark Level** (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- **Optimize the vertical resolution** (see page 236) before taking this measurement.
| **RZ Gain** | **RZ Gain** is defined as the amplitude gain between two waveforms. The measurement returns the ratio between the amplitudes measured within the Eye Aperture of each of the waveforms. RZ Gain = Ampl2 / Ampl1, where Ampl1 and Ampl2 are the amplitudes of the two source waveforms. The **Eye Aperture (see page 268)** is adjustable and defaults to 5% of the RZ pulse width. If enabled, **measurement gates (see page 102)** constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to **use a waveform database if available (see page 250)**. For best results with this measurement:  
- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
- Optimize the vertical resolution (see page 236) before taking this measurement. |
| **RZ High** | The logical 1 level of the RZ signal. The data within the Eye Aperture is sampled, a histogram is built from the upper half of the RZ eye, and the mean of the histogram yields the High level. The **Eye Aperture (see page 268)** is adjustable and defaults to 5% of the RZ pulse width. If enabled, **measurement gates (see page 102)** constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to **use a waveform database if available (see page 250)**. For best results with this measurement:  
- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
- Optimize the vertical resolution (see page 236) before taking this measurement. |
| **RZ Low** | The logical 0 level of the RZ signal. The data within the Eye Aperture is sampled, a histogram is built from the lower half of the RZ eye, and the mean of the histogram yields the Low level. The **Eye Aperture (see page 268)** is adjustable and defaults to 5% of the RZ pulse width. If enabled, **measurement gates (see page 102)** constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to **use a waveform database if available (see page 250)**. For best results with this measurement:  
- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
- Optimize the vertical resolution (see page 236) before taking this measurement. |
**RZ Max**
The maximum vertical value of the waveform that is sampled within the measurement region. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).
When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).
For best results with this measurement:
- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

---

**RZ Mean**
The arithmetic mean of the waveform that is sampled within the measurement region. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).
When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).
For best results with this measurement:
- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

---

**RZ Mid**
The middle level between the Max and Min vertical values of the waveform that is sampled within the measurement region.
RZ Mid = (Max + Min) / 2, where Max and Min are the maximum and minimum measurements.
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).
When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).
For best results with this measurement:
- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

---

**RZ Min**
The minimum vertical value of the waveform that is sampled within the measurement region.
If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).
When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).
For best results with this measurement:
- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.
| RZ Peak-to-Peak | The difference between the Max and Min vertical values of the waveform that is sampled within the measurement region. RZ Peak-to-Peak = Max – Min, where Max and Min are the maximum and minimum measurements. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250). For best results with this measurement:  
  - Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
  - Optimize the vertical resolution (see page 236) before taking this measurement. |
| RZ Peak-to-Peak Noise | The maximum range of the data distribution sampled within a fixed-width vertical slice located at the center of the Eye Aperture (see page 268) at the High or Low levels. PkPk noise = High\text{pp} or PkPk noise = Low\text{pp} 
The Eye Aperture (see page 268) is adjustable and defaults to 5% of the RZ pulse width. The High or Low selection for Noise At control in the Measurement Setup dialog specifies that the measurement to be performed on the logical 1 or 0 levels. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250). For best results with this measurement:  
  - Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
  - Perform Autoset or otherwise optimize the vertical resolution (see page 236) before this measurement; increase the overall vertical size of the waveform (but without producing off-screen waveform points). |
**RZ Q Factor**

A figure of merit of an eye diagram, reporting the ratio between the amplitude of the RZ pulse to the total RMS noise on the High and Low levels. The RZ pulse is sampled within the Eye Aperture, where the High and Low levels are determined as the mean of the histogram of the data distribution in the upper and lower half of the pulse, respectively. The noise levels are characterized by $s_{\text{high}}$ and $s_{\text{low}}$, the standard deviations from the mean for the High and Low levels.

$$RZ \ Q \ Factor = \frac{\text{High} - \text{Low}}{s_{\text{high}} + s_{\text{low}}},$$

where:

- **High and Low (see page 268)** are the logical 1 and 0 levels
- $s_{\text{high}}$ and $s_{\text{low}}$ are the standard deviations.

The **Eye Aperture (see page 268)** is adjustable and defaults to 5% of the RZ pulse width.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:

- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

**RZ RMS**

The true root mean square of the waveform that is sampled within the measurement region.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:

- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

**RZ RMS Noise**

One standard deviation of the data distribution sampled within a fixed-width vertical slice located at the center of the Eye Aperture at the High (logical 1) or Low (logical 0) levels.

$$\text{RMS noise} = \begin{cases} s_{\text{high}} & \text{if High is selected} \\ s_{\text{low}} & \text{if Low is selected} \end{cases}$$

The **Eye Aperture (see page 268)** is adjustable and defaults to 5% of the RZ pulse width. The High or Low selection for Noise At control in the Measurement Setup dialog instructs the measurement to be performed on the logical 1 or 0 levels.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:

- Perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.
### RZ Signal-to-Noise Ratio

The ratio of the RZ pulse amplitude to the noise on either the High (logical 1) or Low (logical 0) level. The data within the Eye Aperture is sampled, and the mean of the histogram yields the High and Low levels. The noise is defined as one standard deviation of the distribution within a fixed-width vertical slice located at the center of the Eye Aperture (see page 268).

\[
\text{S/N Ratio} = \frac{\text{High} - \text{Low}}{\text{High}} \quad \text{or} \quad \frac{\text{High} - \text{Low}}{\text{Low}}
\]

where High and Low (see page 268) are the logical 1 and 0 levels.

The Eye Aperture (see page 268) is adjustable and defaults to 5% of the RZ pulse width. The High or Low selection for Noise At control in the Measurement Setup dialog instructs the measurement to be performed on the logical 1 or 0 levels.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement, perform a Dark Level (see page 168) compensation before taking this measurement if the source of the measured waveform is an optical channel.

### RZ Suppression Ratio

The ratio of the average power level of the logic High to the Suppressed level measured between two consecutive RZ pulses. The RZ pulse is sampled within the Eye Aperture where the High is determined as the mean of the histogram of the data distribution in the upper half of the pulse. The same region is sampled to record the data distribution in the lower half of the pulse, data corresponding to the logical level 0. Similarly, data is sampled in an equivalent sized region placed at one-half bit interval offset from the Eye Aperture (see page 268). The mean of the histogram of the data distribution between the peaks adjusted by subtracting the zero level histogram yields the Suppressed level.

\[
\text{RZ Suppression Ratio} = \frac{\text{High}}{\text{Suppress} - \text{Low}}
\]

where:

- High and Low (see page 268) are the logical 1 and 0 levels
- Suppress is the mean of the histogram of the data within an Eye Aperture (see page 268) in the suppressed region

The Eye Aperture (see page 268) is adjustable and defaults to 5% of the RZ pulse width.

1. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). The region used for sampling the suppressed region is equal to the Eye Aperture (see page 268) and has no independent control.

When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best measurement results:

- Always perform a Dark Level compensation before taking this measurement to ensure accurate results. Access the Dark Level compensation from the Optical page of the Vertical Setup dialog box (see page 168).
- Optimize the vertical resolution (see page 236) before taking this measurement.
### RZ Suppression Ratio (%)

The inverse ratio of the average power level of the logic High to the Suppressed level measured between two consecutive RZ pulses, with the result expressed in percentage. The RZ pulse is sampled within the Eye Aperture where the High is determined as the mean of the histogram of the data distribution in the upper half of the pulse. The same region is sampled to record the data distribution in the lower half of the pulse, data corresponding to the logical level 0. Similarly, data is sampled in an equivalent sized region placed at one-half bit interval offset from the Eye Aperture (see page 268). The mean of the histogram of the data distribution between the peaks adjusted by subtracting the zero level histogram yields the Suppressed level.

**RZ Suppression Ratio [%] = 100 * ((Suppress - Low) / High),**

- **High and Low (see page 268)** are the logical 1 and 0 levels
- **Suppress** is the mean of the histogram of the data within an Eye Aperture (see page 268) in the suppressed region

The Eye Aperture (see page 268) is adjustable and defaults to 5% of the RZ pulse width.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). The region used for sampling the suppressed region is equal to the Eye Aperture (see page 268) and has no independent control.

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best measurement results:

- Always perform a Dark Level compensation before taking this measurement to ensure accurate results. Access the Dark Level compensation from the Optical page of the Vertical Setup dialog box (see page 168).
- Optimize the vertical resolution (see page 236) before taking this measurement.

### RZ Suppression Ratio (dB)

The ratio of the average power level of the logic High to the Suppressed level measured between two consecutive RZ pulses, with the result expressed in decibels. The RZ pulse is sampled within the Eye Aperture where the High is determined as the mean of the histogram of the data distribution in the upper half of the pulse. The same region is sampled to record the data distribution in the lower half of the pulse, data corresponding to the logical level 0. Similarly, data is sampled in an equivalent sized region placed at one-half bit interval offset from the Eye Aperture (see page 268). The mean of the histogram of the data distribution between the peaks adjusted by subtracting the zero level histogram yields the Suppressed level.

**RZ Suppression Ratio [dB] = 10 * log (High / (Suppress - Low)),**

- **High and Low (see page 268)** are the logical 1 and 0 levels
- **Suppress** is the mean of the histogram of the data within an Eye Aperture (see page 268) in the suppressed region

The Eye Aperture (see page 268) is adjustable and defaults to 5% of the RZ pulse width.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). The region used for sampling the suppressed region is equal to the Eye Aperture (see page 268) and has no independent control.

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best measurement results:

- Always perform a Dark Level compensation before taking this measurement to ensure accurate results. Access the Dark Level compensation from the Optical page of the Vertical Setup dialog box (see page 168).
- Optimize the vertical resolution (see page 236) before taking this measurement.
Use a Waveform Database

This measurement must be performed using a statistical (waveform) database. The instrument acquires or computes the specified measurement source, accumulates it into the waveform database, and then takes the measurement on the database data.

When you select the RZ or NRZ signal type, the instrument attempts to automatically allocate one of the four waveform databases it provides to your measurement source.

RZ Timing Measurements

RZ Bit Rate

The inverse of the time interval between two consecutive rising or falling edges (that is, the reciprocal of the Bit Time). The crossing times are computed as the mean of the histogram of the data slice at the mid-reference level.

The choice of rising or falling edge is automatic based on the first slope encountered in the measurement region. RZ Bit Rate = 1 / (Tcross3 – Tcross1), where Tcross3 and Tcross1 are the mean of the histogram of the two consecutive crossings on the same type slope at the mid-reference level. The mid-reference level is adjustable and defaults to 50% of the RZ maximum pulse amplitude.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.

RZ Bit Time

The time interval between two consecutive rising or falling edges. The crossing times are computed as the mean of the histogram of the data slice at the mid-reference level. The choice of rising or falling edge is automatic based on the first slope encountered in the measurement region. RZ Bit Time = Tcross3 – Tcross1, where Tcross3 and Tcross1 are the mean of the histogram of the two consecutive crossings on the same type slope at the mid-reference level.

The mid-reference level is adjustable and defaults to 50% of the RZ maximum pulse amplitude.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.

RZ Cross+

The time of a positive crossing, defined as the mean of the histogram of the data sampled at the mid-reference level. Cross+ = Tcross, where Tcross is the mean of the histogram of a positive crossing.

The mid-reference level is adjustable and defaults to 50% of the RZ maximum pulse amplitude.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default the algorithm searches forward from the Start Gate for the first rising edge, but the Direction of traversal can be reversed, so that the search will be backward from the Stop Gate.

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.
**RZ Cross-**
The time of a negative crossing, defined as the mean of the histogram of the data sampled at the mid-reference level. Cross- = Tcross, where Tcross is the mean of the histogram of a negative crossing.

The mid-reference level is adjustable and defaults to 50% of the RZ maximum pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default, the algorithm searches forward from the Start Gate for the first falling edge, but the Direction of traversal can be reversed, so that the search will be backward from the Stop Gate.

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.

**RZ Delay**
The time interval between the crossings of the mid-reference levels on the two sources of the measurement. The crossing times are computed as the mean of the histogram of the data slice at the mid-reference level. RZ Delay = Tcross(source1) – Tcross(source2), where Tcross is the mean of the histogram of a positive or negative crossing at mid-reference level.

The mid-reference level is adjustable and defaults to 50% of the RZ maximum pulse amplitude. The slope can be selected to be the first positive, the first negative, or the first crossing (positive or negative) in the region.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default, for each source, the algorithm searches forward from the Start Gate for the first rising or falling edge as defined by Slope, but the Direction of traversal can be reversed, so that the search will be backward from the Stop Gate.

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.

**RZ +Duty Cycle**
The ratio of the RZ pulse width to the RZ bit time. If the first crossing is positive, then: Duty Cycle = (Tcross2 – Tcross1) / (Tcross3 – Tcross1). If the first crossing is negative, then: Duty Cycle = (Tcross3 – Tcross2) / (Tcross3 – Tcross1). Tcross1, Tcross2 and Tcross3 are the mean of the histogram of the first three consecutive crossings at the mid-reference level.

The mid-reference level is adjustable and defaults to 50% of the RZ maximum pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.

**RZ Eye Width**
The 3s guarded delta between the rising and falling edge crossings. Eye Width = (Tcross2 – 3 * Tcross2s) – (Tcross1 + 3 * Tcross1s), where Tcross1 and Tcross2 are the mean of the histogram of the two crossings.

The mid-reference level is adjustable and defaults to 50% of the RZ maximum pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.
### RZ Fall Time

RZ Fall Time characterizes the negative slope of the RZ pulse by computing the time interval between the mean crossings of the high reference level and the low reference level. RZ Fall Time = TcrossL - TcrossH, where

- TcrossL is the mean of the histogram of the crossing of the low reference level
- TcrossH is the mean of the histogram of the crossing of the high reference level. The adjustable low reference and high reference levels default to 20% and 80% of the RZ maximum pulse amplitude.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.

### RZ Phase

The amount of lead or lag of Source 1 relative to Source2, expressed in degrees, where 360° comprise a RZ bit period. The crossing times are computed as the mean of the histogram of the data slice at the mid-reference level.

- Tcross1 of source1 is mean of the histogram at the time of the first crossing of either polarity on source 1.
- Tcross3 of source1 is the mean of the histogram at time of the next crossing on source 1 of the same polarity as Tcross1.
- Tcross1 of source2 is the mean of the histogram at the time of the first crossing of either polarity on source 2 after Tcross1 of source1.

All Tcrossings are at the mid-reference levels, which are adjustable and defaults to 50% of the RZ maximum pulse amplitude.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.

### RZ Pk-Pk Jitter

The delta between the minimum and maximum of time crossings at the reference level, with the mean of the histogram being Tcross. Pk-PK Jitter = Tcrosspp.

The mid-reference level is adjustable and defaults to 50% of the RZ maximum pulse amplitude. The jitter measurement can be performed on the positive or negative slope. The slope can be selected to be the first positive, the first negative, or the first crossing (positive or negative) in the region.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default, the algorithm searches forward from the Start Gate for the first specified edge, but the Direction of traversal can be reversed, so that the search will be backward from the Stop Gate.

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.
### RZ Pulse Symmetry

RZ Pulse Symmetry measures to what extent the RZ pulse is symmetrical around the peak at the mid-reference level. The pulse peak is the center of the interval, sized to Eye Aperture, which yields the maximum mean vertical value. RZ Pulse Symmetry [%] = 100 * ( (Tcross0 – Tcross1) / (Tcross2 – Tcross1) ), where:

- Tcross1 and Tcross2 are the time crossings of the RZ pulse of the mid-reference level.
- Tcross0 is the time coordinate of the pulse peak. The mid-reference level is adjustable and defaults to 50% of the RZ maximum pulse amplitude.

If gating is enabled, the measurement region is constrained between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.

### RZ Rise Time

RZ Rise Time characterizes the positive slope of the RZ pulse by computing the time interval between the mean crossings of the low reference level and the high reference level. RZ Rise Time = TcrossH - HcrossL, where:

- TcrossH is the mean of the histogram of the crossing of the high reference level
- TcrossL is the mean of the histogram of the crossing of the low reference level. The adjustable low reference and high reference levels default to 20% and 80% of the RZ maximum pulse amplitude.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.

### RZ RMS Jitter

Jitter is the measure of time variance at the location where the signal crosses the mid-reference level. RMS Jitter is defined as one standard deviation (s) of that variance. The mean of the histogram of the crossing data distribution is Tcross. RMS Jitter = Tcross.

The mid-reference level is adjustable and defaults to 50% of the RZ maximum pulse amplitude. The jitter measurement can be performed on the positive or negative slope. The slope can be selected to be the first positive, the first negative, or the first crossing (positive or negative) in the region.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default, the algorithm searches forward from the Start Gate for the first specified edge, but the Direction of traversal can be reversed, so that the search will be backward from the Stop Gate.

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.

### RZ +Width

The time interval between the crossings of the rising and falling edges at the mid-reference level. +Width = Tcross2 – Tcross1, where Tcross1 and Tcross2 are the mean of the histogram of the rising and falling crossings.

The mid-reference level is adjustable and defaults to 50% of the RZ pulse amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available.
RZ Area Measurements

**RZ Area**

The area under the curve for the RZ waveform within the measurement region. Area measured above ground is positive; area measured below ground is negative. RZ Area = $\int \text{waveform}(t) \, dt$ over the measurement region. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available. For best results with this measurement, perform a Dark Level compensation before taking this measurement if the source of the measured waveform is an optical channel. Also optimize the vertical resolution (see page 236) before taking this measurement.

**RZ Cycle Area**

The area under the curve for the first RZ bit period. Area measured above ground is positive; area measured below ground is negative. RZ Area = $\int \text{waveform}(t) \, dt$, where the measurement region is from Start Gate (G1) to Stop Gate (G2), if measurement gates are enabled, or the first acquired RZ cycle. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available. For best results with this measurement, perform a Dark Level compensation before taking this measurement if the source of the measured waveform is an optical channel. Also optimize the vertical resolution (see page 236) before taking this measurement.

NRZ Amplitude Measurements

**Other NRZ Measurements:**

- NRZ Timing Measurements (see page 264)
- NRZ Area Measurements (see page 268)

**See Also:**

- RZ Amplitude Measurements (see page 240)
- RZ Area Measurements (see page 254)
- RZ Timing Measurements (see page 250) (see page 236)
**NRZ AC RMS**

The root mean square amplitude, minus the DC component, of the selected waveform within the measurement region.

If enabled, **measurement gates (see page 102)** constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

When this measurement is turned on, it will automatically set the measurement system to **use a waveform database if available (see page 250)**

For best results with this measurement:

- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

---

**NRZ Amplitude**

The difference between the logical 1 level (High) and the logical 0 level (Low) of the NRZ signal. Both High and Low levels are measured within the Eye Aperture.

NRZ Amplitude = High – Low, where **High and Low (see page 268)** are the logical 1 and 0 levels.

The **Eye Aperture (see page 268)** is adjustable and defaults to 20% of the NRZ bit time.

If enabled, **measurement gates (see page 102)** constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to **use a waveform database if available (see page 250)**.

For best results with this measurement:

- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

---

**NRZ Average Optical Power (dBm)**

The true average component of an optical signal, expressed in decibels. This measurement results from the use of a hardware average power monitor circuit rather than from the calculation of digitized waveform data.

NOTE. **Average optical power measurements return valid results only on channels that contain average power monitors. In general, all optical sampling module channels contain average power monitors.**

To determine average optical power in watts, see the **NRZ Average Optical Power (Watts)** measurement.

For best average optical power measurement results:

- Use a factory-calibrated wavelength. If using the USER wavelength setting, make sure that it is properly compensated by performing the User Wavelength Gain compensation found by clicking the Optical button in the Vertical Setup dialog box.
- Compensate the optical channel, which corrects for minor DC variances in the average power monitor as part of the compensation routine. Select Utilities > Compensation to access the compensation tool.
### NRZ Average Optical Power

The true average component of an optical signal.

**NOTE.** *Average optical power measurements return valid results only on channels that contain average power monitors. In general, all optical sampling module channels contain average power monitors.*

To obtain accurate results, the O/E converter is calibrated at a number of wavelengths to determine the conversion gain of the O/E converter at each wavelength. For best average optical power measurement results:

- Use a factory-calibrated wavelength. If using the USER wavelength setting, make sure that it is properly compensated by performing the User Wavelength Gain compensation found by clicking the Optical button in the Vertical Setup dialog box.

- Compensate the optical channel, which corrects for minor DC variances in the average power monitor as part of the compensation routine. Select Utilities > Compensation to access the compensation tool.

### NRZ Crossing %

The height of eye crossing as a percentage of eye height measured in the Eye Aperture (see page 268).

NRZ Crossing% = \(100 \times \frac{\text{EyeCross} - \text{Low}}{\text{High} - \text{Low}}\), where High and Low (see page 268) are the logical 1 and 0 levels, and EyeCross (see page 268) is the level at eye crossing.

The Eye Aperture (see page 268) is adjustable and defaults to 20% of the NRZ bit time.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

1. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:

- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.

- Optimize the vertical resolution (see page 236) before taking this measurement.

### NRZ Crossing Level

The mean signal level at the eye crossing.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:

- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.

- Optimize the vertical resolution (see page 236) before taking this measurement.
NRZ Extinction Ratio

The ratio of the average power levels of the logic 1 level (High) to the logic 0 level (Low) of an optical NRZ signal. All level determinations are made within the NRZ Eye Aperture.

$$\text{NRZ ExtRatio} = \frac{\text{High}}{\text{Low}}$$

where High and Low (see page 268) are the logical 1 and 0 levels.

The Eye Aperture (see page 268) is adjustable and defaults to 20% of the NRZ bit time.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best measurement results:
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

NRZ Extinction Ratio (%)

The ratio of the average power levels of the logic 0 level (Low) to the logic 1 level (High) of an optical NRZ signal, expressed as a percentage. All level determinations are made within the NRZ Eye Aperture.

$$\text{NRZ ExtRatio} \% = 100 \times \left( \frac{\text{Low}}{\text{High}} \right)$$

where High and Low (see page 268) are the logical 1 and 0 levels.

The Eye Aperture (see page 268) is adjustable and defaults to 20% of the NRZ bit time.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best measurement results:
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

NRZ Extinction Ratio (dB)

The ratio of the average power levels of the logic 1 level (High) to the logic 0 level (Low) of an optical NRZ signal, expressed in decibels (dB). All level determinations are made within the NRZ Eye Aperture.

$$\text{NRZ ExtRatio} \text{ [dB]} = 10 \times \log \left( \frac{\text{High}}{\text{Low}} \right)$$

where High and Low (see page 268) are the logical 1 and 0 levels.

The Eye Aperture (see page 268) is adjustable and defaults to 20% of the NRZ bit time.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

2. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best measurement results:
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.
### NRZ Extinction Ratio (dB) – Calibrated

The ratio of the average power levels of the logic 1 level (High) to the logic 0 level (Low) of an optical NRZ signal, expressed in decibels (dB). The precision is improved by calibrating the optical module (“Calibrated Extinction Ratio”) per filter setting. This optical calibration is performed at Tektronix to a laboratory standard. Use of this measurement is recommended (instead of the standard ER) when available for improved accuracy and module-to-module repeatability. This improvement only applies to balanced NRZ eye diagrams.

Extinction Ratio calibration is a factory installed option to certain Tektronix optical modules. All level determinations are made within the NRZ Eye Aperture.

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best measurement results:
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.
- If using an 80C12 optical module, the electrical signal output must be terminated into a high quality 50 Ω terminator or load.

### NRZ Eye Height

A measure of how noise affects the vertical opening between the High and Low levels of an NRZ eye. The NRZ eye is sampled within the Eye Aperture, where the High and Low levels are determined as the mean of the histogram of the data distribution in the upper and lower half of the eye, respectively. The noise levels are characterized by $s_{\text{high}}$ and $s_{\text{low}}$, the standard deviations from the mean for the High and Low levels.

$$\text{NRZ Eye height} = (\text{High} - 3 \times s_{\text{high}}) - (\text{Low} + 3 \times s_{\text{low}}),$$

where High and Low (see page 268) are the logical 1 and 0 levels, and $s_{\text{high}}$ and $s_{\text{low}}$ are the standard deviations.

The Eye Aperture (see page 268) is adjustable and defaults to 20% of the NRZ bit time. If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.
**NRZ Gain**

The amplitude gain between two waveforms. The measurement returns the ratio between the amplitudes measured within the Eye Aperture of each of the waveforms.

NRZ Gain = Ampl2 / Ampl1, where Ampl1 and Ampl2 (see page 254) are the amplitudes of the two source waveforms.

The Eye Aperture (see page 268) is adjustable and defaults to 20% of the NRZ bit time.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

**NRZ High**

The logical 1 of the NRZ signal. The data within the Eye Aperture is sampled, a histogram is built from the upper half of the NRZ eye, and the mean of the histogram yields the High level.

The Eye Aperture (see page 268) is adjustable and defaults to 20% of the NRZ bit time.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

**NRZ Low**

The logical 0 of the NRZ signal. The data within the Eye Aperture is sampled, a histogram is built from the lower half of the NRZ eye, and the mean of the histogram yields the Low level.

The Eye Aperture (see page 268) is adjustable and defaults to 20% of the NRZ bit time.

If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.
### NRZ Max
- The maximum vertical value of the waveform that is sampled within the measurement region.
- If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).
- When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).
- For best results with this measurement:
  - Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
  - Optimize the vertical resolution (see page 236) before taking this measurement.

### NRZ Mean
- The arithmetic mean of the selected waveform within the measurement region.
- If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).
- When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).
- For best results with this measurement:
  - Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
  - Optimize the vertical resolution (see page 236) before taking this measurement.

### NRZ Mid
- The middle level between the Max and Min vertical values of the selected waveform within the measurement region.
- NRZ Mid = (Max + Min) / 2, where Max and Min are the maximum and minimum measurements.
- If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).
- When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).
- For best results with this measurement:
  - Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
  - Optimize the vertical resolution (see page 236) before taking this measurement.

### NRZ Min
- The minimum vertical value of the selected waveform within the measurement region.
- If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).
- When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).
- For best results with this measurement:
  - Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
  - Optimize the vertical resolution (see page 236) before taking this measurement.
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
</table>
| **NRZ +Overshoot**                | The ratio of the maximum value of the measured signal to its amplitude, expressed as a percentage. The waveform is scanned for the maximum value within the measurement region, while the amplitude is measured in the Eye Aperture.  
   \[ \text{NRZ } +\text{Overshoot} = 100 \times \frac{(\text{Max} - \text{High})}{(\text{High} - \text{Low})} \]  
   Where Max is the signal maximum, and High and Low (see page 268) are the logical 1 and 0 levels.  
   The Eye Aperture (see page 268) is adjustable and defaults to 20% of the NRZ bit time.  
   If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
   When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).  
   For best results with this measurement:  
   - Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
   - Optimize the vertical resolution (see page 236) before taking this measurement. |
| **NRZ -Overshoot**                | The ratio of the minimum value of the measured signal to its amplitude, expressed as a percentage. The waveform is scanned for the minimum value within the measurement region, while the amplitude is measured in the Eye Aperture.  
   \[ \text{NRZ } -\text{Overshoot} = 100 \times \frac{(\text{Low} - \text{Min})}{(\text{High} - \text{Low})} \]  
   Where Min is the signal minimum, and High and Low (see page 268) are the logical 1 and 0 levels.  
   The Eye Aperture (see page 268) is adjustable and defaults to 20% of the NRZ bit time.  
   If enabled, measurement gates (see page 102) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).  
   When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).  
   For best results with this measurement:  
   - Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
   - Optimize the vertical resolution (see page 236) before taking this measurement. |
| **NRZ Optical Modulation Amplitude** | An approximation defined as the difference of the logical power 1 and 0 determined a vertical slice through the eye crossing. The levels are determined as the means of the histograms of the vertical data slice through the High (logical 1) and Low (logical 0) levels.  
   \[ \text{NRZ OMA} \ [\text{Watts}] = P1 - P0 \]  
   Where:  
   P1 (see page 268) and P0 (see page 268) are the average power levels of the logical 1 and 0, determined at the eye crossing.  
   This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250). If a waveform database is not available, no valid measurement results will be produced. |
| **NRZ Peak-to-Peak** | The difference between the Max and Min vertical values of the [selected (see page 30)](.) waveform within the measurement region. NRZ Peak-to-Peak = Max – Min, where Max and Min are the maximum and minimum measurements. If enabled, [measurement gates (see page 102)](.) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to [use a waveform database if available (see page 250)](.). For best results with this measurement:  
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
- Optimize the vertical resolution (see page 236) before taking this measurement. |

| **NRZ Peak-to-Peak Noise** | The maximum range of the amplitude variance sampled within a fixed-width vertical slice located at the center of the [Eye Aperture (see page 268)](.) at the High or Low levels. PkPk noise = \( H_{\text{high}} \) or PkPk noise = \( L_{\text{low}} \). The [Eye Aperture (see page 268)](.) is adjustable and defaults to 20% of the NRZ bit time. The High or Low selection for [Noise At (see page 102)](.) control in the Measurement Setup dialog instructs the measurement to be performed on the logical 1 or 0 levels. If enabled, [measurement gates (see page 102)](.) constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to [use a waveform database if available (see page 250)](.). For best results with this measurement:  
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.  
- Perform Autoset or otherwise optimize the vertical resolution (see page 236) before this measurement; increase the overall vertical size of the waveform (but without producing off-screen waveform points). |
| **NRZ Q Factor** | A figure of merit of an eye diagram, reporting the ratio between the amplitude of the NRZ eye to the total RMS noise on the High and Low levels. The NRZ eye is sampled within the Eye Aperture, where the High and Low levels are determined as the mean of the histogram of the data distribution in the upper and lower half of the eye, respectively. The noise levels are characterized by $s_{\text{high}}$ and $s_{\text{low}}$, the standard deviations from the mean for the High and Low levels.

NRZ Q Factor $= (\text{High} – \text{Low}) / (s_{\text{high}} + s_{\text{low}})$, where **High and Low (see page 268)** are the logical 1 and 0 levels, and $s_{\text{high}}$ and $s_{\text{low}}$ are the standard deviations.

The **Eye Aperture (see page 268)** is adjustable and defaults to 20% of the NRZ bit time.

If enabled, **measurement gates (see page 102)** constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to **use a waveform database if available (see page 250)**.

For best results with this measurement:

- **Perform a Dark Level (see page 171)** compensation before taking this measurement if the source of the measured waveform is an optical channel.
- **Optimize the vertical resolution (see page 236)** before taking this measurement.

| **NRZ RMS** | The true root mean square amplitude of the **selected (see page 30)** waveform within the measurement region.

If enabled, **measurement gates (see page 102)** constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

When this measurement is turned on, it will automatically set the measurement system to **use a waveform database if available (see page 250)**.

For best results with this measurement:

- **Perform a Dark Level (see page 171)** compensation before taking this measurement if the source of the measured waveform is an optical channel.
- **Optimize the vertical resolution (see page 236)** before taking this measurement.
### NRZ RMS Noise

One standard deviation of the amplitude variance sampled within a fixed-width vertical slice located at the center of the Eye Aperture at the High (logical 1) or Low (logical 0) levels.

\[
\text{RMS noise } = \text{High or } \text{RMS noise } = \text{Low}
\]

The **Eye Aperture (see page 268)** is adjustable and defaults to 20% of the NRZ bit time. The High or Low selection for Noise At control in the Measurement Setup dialog instructs the measurement to be performed on the logical 1 or 0 levels.

If enabled, **measurement gates (see page 102)** constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:

- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 236) before taking this measurement.

### NRZ Signal-to-Noise Ratio

NRZ Signal-to-Noise is the ratio of the NRZ eye amplitude to the noise on either the High (logical 1) or Low (logical 0) level. The data within the Eye Aperture is sampled, and the mean of the histogram yields the High and Low levels. The noise is defined as one standard deviation of the distribution within a fixed-width vertical slice located at the center of the **Eye Aperture (see page 268)**.

\[
S/N \text{ Ratio } = (\text{High – Low}) / \text{High or } S/N \text{ Ratio } = (\text{High – Low}) / \text{Low}
\]

where High and Low (see page 268) are the logical 1 and 0 levels.

The **Eye Aperture (see page 268)** is adjustable and defaults to 20% of the NRZ bit time. The High or Low selection for Noise At (see page 103) control in the Measurement Setup dialog specifies that the measurement be performed on the logical 1 or 0 levels.

If enabled, **measurement gates (see page 102)** constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement, Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.

---

### NRZ Timing Measurements

Other NRZ Measurements:

- NRZ Amplitude Measurements (see page 254)
- NRZ Area Measurements (see page 268)
<p>| <strong>NRZ Bit Rate</strong> | The inverse of the time interval between two consecutive eye-crossing points. (In other words, it is the reciprocal of the Bit Time.)( \text{NRZ Bit Rate} = \frac{1}{(\text{Tcross2} - \text{Tcross1})} ), where Tcross2 and Tcross1 are the mean of the histogram of the two consecutive eye crossings. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250). |
| <strong>NRZ Bit Time</strong> | NRZ Bit Time is measured as the time interval between two consecutive eye-crossing points.( \text{NRZ Bit Time} = \text{Tcross2} - \text{Tcross1} ), where Tcross2 and Tcross1 are the mean of the histogram of the two consecutive eye crossings. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250). |
| <strong>NRZ Crossing Time</strong> | The horizontal position of the eye crossing. Data is sampled on a horizontal slice at the eye crossing, and the mean of the horizontal histogram returns the crossing time. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250). |
| <strong>NRZ Delay</strong> | The time interval between the crossings of the mid-reference levels on the two sources of the measurement.( \text{NRZ Delay} = \text{Tcross(source1)} - \text{Tcross(source2)} ), where Tcross is the positive or negative crossing time at mid-reference level. The mid-reference level is adjustable and defaults to 50% of the NRZ eye amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). By default, for each source, the algorithm searches forward from the Start Gate, but the Direction of traversal can be reversed, so that the search will be backward from the Stop Gate. This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250). |
| <strong>NRZ Duty Cycle Distortion</strong> | The ratio of the time interval between the points where the rising and the falling edges cross the mid-reference level and the NRZ bit time.( \text{NRZ Duty Cycle Distortion} = \frac{\text{abs} ((\text{Trise} - \text{Tfall}))}{(\text{Tcross2} - \text{Tcross1})} ), where Tcross1 and Tcross2 are the mean of the histogram of the two consecutive eye crossings, and Trise and Tfall are the time points where the rising and falling edges cross the mid-reference level. The mid-reference level is adjustable and defaults to 50% of the NRZ eye amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2). This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250). |</p>
<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NRZ Eye Width</strong></td>
<td>The 3s guarded delta between two consecutive eye crossings.</td>
</tr>
<tr>
<td></td>
<td>Eye Width = (Tcross2 – 3 * Tcross2s) – (Tcross1 + 3 * Tcross1s), where Tcross1 and Tcross2 are the mean of the histogram of the two crossings.</td>
</tr>
<tr>
<td></td>
<td>This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).</td>
</tr>
<tr>
<td><strong>NRZ Fall Time</strong></td>
<td>NRZ Fall Time characterizes the negative slope of the NRZ eye by computing the time interval between the mean crossings of the high reference level and the low reference level.</td>
</tr>
<tr>
<td></td>
<td>RZ Fall Time = TcrossL - TcrossH, where TcrossL is the mean of the histogram of the crossing of the low reference level, and TcrossH is the mean of the histogram of the crossing of the high reference level. The adjustable low reference and high reference levels default to 10% and 90% of the NRZ eye amplitude.</td>
</tr>
<tr>
<td></td>
<td>If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).</td>
</tr>
<tr>
<td></td>
<td>This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).</td>
</tr>
<tr>
<td><strong>NRZ Frequency</strong></td>
<td>NRZ Frequency is defined as half of the inverse of the time interval between two consecutive eye crossing points (that is, the reciprocal of the Period). It is the frequency of a digital signal of a 0-1-0-1... stream.</td>
</tr>
<tr>
<td></td>
<td>NRZ Frequency = 1 / (2 * (Tcross2 – Tcross1)), where Tcross1 and Tcross2 are the mean of the histogram of the two crossings.</td>
</tr>
<tr>
<td></td>
<td>If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).</td>
</tr>
<tr>
<td></td>
<td>This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).</td>
</tr>
<tr>
<td><strong>NRZ Period</strong></td>
<td>NRZ Period is twice the time interval between two consecutive eye-crossing points. It is the period of a digital signal of a 0-1-0-1... stream.</td>
</tr>
<tr>
<td></td>
<td>NRZ Period = 2 * (Tcross2 – Tcross1), where Tcross1 and Tcross2 are the mean of the histogram of the two crossings of the eye diagram.</td>
</tr>
<tr>
<td></td>
<td>If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).</td>
</tr>
<tr>
<td></td>
<td>This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).</td>
</tr>
</tbody>
</table>
NRZ Phase
The amount of lead or lag of one source over the second measurement source, expressed in degrees, where 360° comprise a NRZ bit period.

Tcross1 of source1 is the time of the first crossing of either polarity on source 1.

Tcross3 of source1 is the time of next crossing on source 1 of the same polarity as Tcross1.

Tcross1 of source2 is the time of the first crossing of either polarity on source 2 after Tcross1 of source1.

All Tcrossings are at the mid-reference level, which is adjustable and defaults to 50% of the NRZ eye amplitude. If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

NRZ Pk-Pk Jitter
The delta between the minimum and maximum of time crossings, with the mean of the histogram being Tcross.

Pk-PK Jitter = Tcrosspp

The Jitter At control in the Measurement Setup dialog specifies whether the jitter is to be measured at the eye cross or at the mid-reference level. The mid-reference level is adjustable and defaults to 50% of the eye amplitude.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

NRZ Rise Time
Computes the time interval between the mean crossings of the low reference level and the high reference level to characterize the positive slope of the eye.

NRZ Rise Time = TcrossH - HcrossL, where TcrossH is the mean of the histogram of the crossing of the high reference level, and TcrossL is the mean of the histogram of the crossing of the low reference level. The adjustable High and Low reference levels default to 10% and 90% of the NRZ eye amplitude.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

NRZ RMS Jitter
Jitter is the measure of time variance on the rising and falling edges at the NRZ eye crossing or at the mid-reference level.

RMS Jitter is defined as one standard deviation (s) of that variance. The mean of the histogram of the crossing data distribution is Tcross. RMS Jitter = Tcross. The Jitter At control in the Measurement Setup dialog specifies if the jitter is to be measured at the eye cross or at the mid-reference level. The mid-reference level is adjustable and defaults to 50% of the eye amplitude.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).
NRZ Area Measurements

Other NRZ Measurements:
- NRZ Amplitude Measurements (see page 254)
- NRZ Timing Measurements (see page 264)

NRZ Area
The area under the curve for the NRZ waveform within the measurement region. Area measured above ground is positive; area measured below ground is negative. \[ \text{NRZ Area} = \int \text{waveform}(t) \, dt \], over the measurement region.

If enabled, measurement gates constrain the measurement region to the area between the Start Gate (G1) and Stop Gate (G2).

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 268) before taking this measurement.

NRZ Cycle Area
The area under the curve for the first NRZ bit time within the measurement region. Area measured above ground is positive; area measured below ground is negative. \[ \text{NRZ Cycle Area} = \int \text{waveform}(t) \, dt \], over the first NRZ bit within the measurement region.

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set the measurement system to use a waveform database if available (see page 250).

For best results with this measurement:
- Perform a Dark Level (see page 171) compensation before taking this measurement if the source of the measured waveform is an optical channel.
- Optimize the vertical resolution (see page 268) before taking this measurement.

To Optimize the Vertical Resolution
Optimizing vertical resolution improves the result this measurement produces. Try these methods:
- Execute Autoset (push AUTOSET on the front-panel).
- Adjust the instrument vertical scale using the Vertical SCALE knob, or increase the signal amplitude, to increase the overall vertical size of the waveform while keeping the waveform upper and lower peaks on screen.

Reference Level Calculation Method- All Sources
The methods available for calculating reference levels used in taking automatic measurement follow. The methods are shown using a pulse, but they also apply to RZ and NRZ waveforms.
Pulse Waveform Measurement Reference Levels

**Pulse high and low reference levels**: The automatic measurement system uses the parameters shown in the illustration when measuring Pulse source waveforms.
Pulse crossings and mid-reference level: The following measurement parameters are used when deriving pulse measurements.

Pulse crossings and mid-reference level (AOP): The following measurement parameters are normally used when measuring Optical Modulation Amplitude on a pulse. Crossings at the measured Average Optical Power level determine the positions of the eye apertures for the logical 1 and logical 0 of the pulse (size set in the measurement Region control). The High, Power Logic 1, and Low, Power Logic 0 levels are determined as the mean values of the logical levels sampled within the eye aperture of the logical 1 and 0 regions of the pulse.
Overshoot levels: The following measurement parameters are used when deriving pulse overshoot measurements.

See Also:
- RZ Waveform Measurement Reference Levels (see page 272)
- NRZ Waveform Measurement Reference Levels (see page 273)
RZ Waveform Measurement Reference Levels

The automatic measurement system uses the following levels when measuring RZ source waveforms.

**RZ measurement reference levels**: The levels labeled in the following figure are used when deriving measurements on RZ waveforms.

**RZ crossings**: The levels labeled in the following figure are used when deriving RZ measurements.
**RZ Eye-Aperture parameters**: The parameters labeled in the following figure are used when deriving measurements on RZ waveforms.

![Eye-Aperture Diagram]

**See Also:**
- Pulse Waveform Measurement Reference Levels (see page 269)
- NRZ Waveform Measurement Reference Levels (see page 273)

**NRZ Waveform Measurement Reference Levels**

The automatic measurement system uses the following levels when measuring NRZ source waveforms.

**NRZ measurement reference levels**: The following levels are used when deriving measurements on NRZ waveforms.
NRZ crossings: The following measurement parameters are used when deriving NRZ measurements.

NRZ Eye-Aperture parameters: The following parameters are used when deriving measurements on NRZ waveforms.
NRZ overshoot levels: The following measurement parameters are used when deriving overshoot measurements on NRZ waveforms.

NRZ crossings (OMA): The following measurement parameters are used when approximating Optical Modulation Amplitude (OMA) on NRZ waveforms. As shown, OMA on NRZ waveforms is determined from the means of histograms of the data from level 1 and level 0, taken on a vertical slice through the NRZ eye crossing. This method gives an approximation of Optical Modulation Amplitude of an NRZ waveform; Optical Modulation Amplitude measurements are primarily defined for Pulse signals.
High/Low Level Tracking Algorithms

This topic describes measurements methods tracking the High and Low values used for automatic measurements.

The levels that the automatic measurement system derives as the High (Top) or Low (Bottom) for a waveform influence the fidelity of amplitude and aberration measurements. For many of the automatic measurements supported, the instrument automatically determines these levels and disables all or some of the High/Low tracking method controls (for example, for RMS). If the measurement you select has High/Low methods that are appropriate to adjust (for example, RISE time), the instrument automatically enables the method controls for your adjustment. The methods available are shown below:

See Also:
- Pulse Waveform Measurement Reference Levels (see page 269)
- RZ Waveform Measurement Reference Levels (see page 272)
Mean (of Histogram) sets the values statistically. Using a histogram, it selects the mean or average value derived using all values either above or below the midpoint (depending on whether it is defining the high or low reference level). This setting is best for examining eye patterns and optical signals.

Min-max uses the highest and lowest values of the waveform record. This setting is best for examining waveforms that have no large, flat portions at a common value, such as sine waves and triangle waves - almost any waveform except for pulses.

Mode (of Histogram) sets the values statistically. Using a histogram, it selects the most common value either above or below the midpoint (depending on whether it is defining the high or low reference level). Since this statistical approach ignores short-term aberrations (overshoot, ringing, and so on), Mode is the best setting for examining pulses.

Auto switches between methods. Auto method first attempts to calculate the high and low values using the Mode method. Then, if the histogram does not show obvious consistent high and low levels, Auto method automatically switches to the MiniMax or Mean method. For example, the Mode histogram operating on a triangle wave would not find consistent high and low levels, so the instrument would switch to the Min/Max mode. Consistent high and low levels are found on a square wave, so the Auto mode would use the Mode method.
**Exterior Cleaning**

Periodically you may need to clean parts of your instrument. To do so, follow the instructions in the tabbed topics.

---

**WARNING.** Before performing any procedure that follows, power off the instrument and disconnect it from line voltage.

---

**CAUTION.** To prevent getting moisture inside the instrument during external cleaning, use only enough liquid to dampen the cloth or applicator.

Clean the exterior surfaces of the chassis with a dry lint–free cloth or a soft–bristle brush. If any dirt remains, use a cloth or swab dipped in a 75% isopropyl alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do not use abrasive compounds on any part of the chassis that may damage the chassis.

Clean the On/Standby switch using a dampened cleaning towel. Do not spray or wet the switch directly.

---

**CAUTION.** Avoid the use of chemical cleaning agents which might damage the plastics used in this instrument. Use a 75% isopropyl alcohol solution as a cleaner and wipe with a clean cloth dampened with deionized water. (Use only deionized water when cleaning the menu buttons or front–panel buttons.) Before using any other type of cleaner, consult your Tektronix ServiceCenter or representative.

---

**Flat Panel Display Cleaning**

Periodically you may need to clean parts of your instrument. To do so, follow the instructions in the tabbed topics.

---

**WARNING.** Before performing any procedure that follows, power off the instrument and disconnect it from line voltage.

---

The instrument display is a soft plastic display and must be treated with care during cleaning.

---

**CAUTION.** Improper cleaning agents or methods can damage the flat panel display. Avoid using abrasive cleaners or commercial glass cleaners to clean the display surface. Avoid spraying liquids directly on the display surface. Avoid scrubbing the display with excessive force.
Clean the flat panel display surface by gently rubbing the display with a clean-room wipe (such as Wypall Medium Duty Wipes, #05701, available from Kimberly–Clark Corporation).

If the display is very dirty, moisten the wipe with distilled water or a 75% isopropyl alcohol solution and gently rub the display surface. Avoid using excess force or you may damage the plastic display surface.

**Optical Connector Cleaning**

Periodically you may need to clean parts of your instrument. To do so, follow the instructions in the tabbed topics.

**WARNING.** Before performing any procedure that follows, power off the instrument and disconnect it from line voltage.

When using optical modules, the measurement accuracy is increased (or maintained) by keeping the optical connectors clean. It’s important to follow the procedures for cleaning optical connectors provided in the optical module user manual. (Sampling-module user manuals are electronic documents, installable from the *8000 Series Product Documentation CD* that ships with the instrument.)
Connect to a Network

The instrument is built on a PC-based platform that runs Microsoft Windows 7. Like any Windows computer, you can connect the instrument to a network to enable printing, file sharing, Internet access, and other communications functions.

To make a network connection, consult with your network administrator and then use the standard Windows utilities to configure the instrument for compatibility with your network. You can find information on how to make this connection in the Windows online help system.

Print a Hard Copy

You can print a copy of the screen image to a printer attached to the serial or USB ports on the instrument, or to a network printer if your instrument is connected to a network. This instrument uses Windows 7 print drivers, so the process to install printers is the same as it is on a PC.

To print the screen image to a printer:

1. Push the **PRINT** front-panel button.
2. Select a printer from the **Name** list.
3. Click **OK**.

**TIP.** This instrument also provides an Ink-saver mode that uses less ink when printing. You can select Ink-saver mode before printing from **File > Page Setup**.

You can also save the screen image to a graphical-format file that you can include in documents or other applications. To print the screen image to a file:

1. Push the **PRINT** front-panel button.
2. Select the **Print to File** check box, and click **OK**.
3. In the Print to File dialog box, navigate to where you want to save the file and enter a file name, and
4. Select a file type from the **Save as type** list. Available types are BMP, PNG, JPEG, TIFF, and Targa.
5. Click **Save** to save the screen image to the specified file type, name, and location.
Save a Waveform to a File

The first method of saving a waveform to a file, using the Save Waveform command in the File menu, stores the waveform data as a .WFM file. When the Save Waveform dialog box appears, select the waveform you want to save, check File to save it to a file, enter a directory path and file name for where you want to save the waveform, and click Save To. To recall the saved waveform, use the Recall Waveform command in the File menu.

The second way to save a waveform to a file is to export it to an ASCII text file. To do this, select Export Waveform from the file menu. When the Export dialog box appears, select the waveform you want to export, specify the directory path and file name to which you want it exported, select the type of file you want to save, and then click Export.

The final method of storing a waveform to a file is to simply right-click the waveform icon in the Waveform Bar (see page 12) (or directly on the waveform in the display graticule) and select Copy. This action stores numeric representations of the waveform data on the Windows clipboard. From here, you can paste it into most Windows applications that support pasting from the Windows clipboard. (The copy waveform saves the waveform data as time/amplitude pairs.)

Run Other PC Applications

Because this instrument uses a Microsoft Windows interface, you can access the Windows desktop to load and run other Windows-based applications such as Microsoft Excel, WordPad, and Paint. Click here (see page 282) for guidelines on using Microsoft Windows and Microsoft Windows applications.

Export Feature

You can also use the Export dialog box, displayed from the File menu, to export waveform and histogram data ASCII values. Such values can be imported by a variety of PC-based tools (for example Microsoft Excel).

Connectivity Tools

You also have connectivity options! If you install the connectivity support that comes with this instrument, you can export data for use with PC-based data-analysis tools. Click here (see page 2) for more information.

Microsoft Windows Desktop Guidelines

Because the instrument uses the Microsoft Windows interface, you have access to the Windows operating system. You can access the Windows desktop to load and run other Windows-based applications such as Microsoft Excel, WordPad, and Paint.
Although you have access to the Windows interface, you should avoid making changes to the operating system as they may cause problems or annoyances while trying to use the instrument. The following are some guidelines for using the Windows environment on your instrument:

- Do not install any version of Microsoft Windows not provided by Tektronix. You must have the correct version of Microsoft Windows for the instrument to operate correctly.

- If the instrument powers on in Windows Safe Mode, the touch screen is inoperative. You might need to use a mouse or keyboard to restore normal operation.

- To keep the start-up time to a minimum, keep the network connectivity (for items such as network printers and drives) to a minimum.

- Be careful when making changes in the Control Panel. Avoid making changes to any controls with which you are unfamiliar.

- Do not change the default LCD monitor color resolution and screen area settings. If the settings change, the video port may not work properly.

- For best instrument performance, disable any anti-virus software on the instrument.

- Some third-party applications may not work properly with the instrument. If your instrument stops working after you install new, third-party software, try reloading the instrument software from the DSA8300 Product Software CD. IF that does not work, uninstall the new software to see if that fixes the problem.

- If you are running without an external monitor connected and need easy access to the Windows Taskbar (including the Start button and Quick Start Toolbar), change the Taskbar properties to Always on top and Auto hide. This setting causes the Taskbar to appear whenever you move the mouse cursor to the bottom of the display. Be aware that when the Windows Taskbar is visible, the instrument control bar at the bottom of the screen is obscured.

- If you do have an external monitor attached and the instrument is set to the dual monitor mode, you can drag the taskbar from the instrument display to the external monitor display giving you easy access to the taskbar. To prevent the screen saver from turning on while you're taking measurements or viewing the display, disable the Windows screen saver. If the screen saver turns on while taking measurements, touch the screen (assuming the touch screen is not turned off), move the mouse, or touch any key on the attached keyboard.

- Do not delete or change any system fonts. Changing or removing fonts can affect the quality of the display.

- Avoid changing the system Display Properties such as the Background, Appearance, Effects, or Settings. Making such changes can affect the usability of the instrument and the touch screen.

- Avoid making changes to the contents of the Windows folder or the DSA8300 folder.

- Avoid making changes to the BIOS settings. Changing the BIOS settings can affect the overall operation of the instrument.

- Avoid changing the Windows power management system.
Symbols and Numbers
1-8 buttons, 18
10MHz Reference (TDR), 128

Symbol Index

A
AC RMS (pulse ampl), 231
Accessories, 5
Acq (Acquisition) setup tab, 37
Acquire and display a signal, 26
Acquisition
Average, 37
Background, 40
Condition, 38
Cycle, 44
Envelope, 37
Key points, 41
None, 40
Print screen to file, 40
Print screen to printer, 40
Ring Bell, 40
Run/Stop Button Only, 38
Sample, 37
Save all waveforms, 40
Signal sampling
background, 43
Stop Action settings, 40
Stop After settings, 38
Waveform record, 44
Acquisition front panel controls
CLEAR DATA button, 20
MENU button, 20
RUN/STOP button, 20
ActiveX Control API, 4
Advanced trigger setup, 139
Alphabetical keyboard, 15
Amplitude (pulse ampl), 231
Analysis and connectivity
Data analysis, 2
Overview, 2
software, 4
TekVISA, 2
TekVISA ActiveX (TVC), 2
TekVISA Excel toolbar, 2
TekVISA programming manual, 4
VXI 11.2 LAN server, 2
VXI plug & play driver install, 4
VXI Plug-and-Play, 2
Area (pulse area), 239
Automatic measurements
Caveats, 108
Key points, 109
Overview, 108
Automatic measurements introduction, 30
AutoSet considerations, 161
AutoSet Option (TDR), 128
AutoSync Options, 137
Average, 38
Average Optical Power (dBm) (pulse ampl), 232
Average Optical Power (watts) (pulse ampl), 232
BIN7, 175
BIN8, 175
Bits (horiz units), 77
Burst width (pulse timing), 236
Buttons
1-8 channel select buttons, 18
Acquisition CLEAR
DATA, 20
Acquisition MENU, 20
Acquisition RUN/STOP, 20
CH (channel), 18
Channel source, 18
Horizontal MENU, 21
Mag1, Mag2 view, 20
MAIN view, 20
MATH, 18
REF (reference), 18
Trigger MENU, 22
Trigger SET TO 50%, 22
Utility AUTOSET, 23
Utility CURSORs, 23
Utility DEFAULT SETUP, 23
Utility FINE, 23
Utility PRINT, 23
Utility SELECT, 23
Utility SETUP DIALOGS, 23
Utility TOUCH SCREEN, 23
Vertical MENU, 19
Change instrument settings, 23
Channel delay, 153
Channel deskew, 153
Channel select buttons, 18
Channel source front panel controls
CH (channel) button, 18
MATH button, 18
REF (reference) button, 18
Clear References dialog box, 179
Clipping, 159
Clock Source (Pattern Sync), 135
Clock trigger modes, 143
Colors, setting, 59
Condition, 38
Cross+ (pulse timing), 236
Cross- (pulse timing), 236
Cursor
Background, 47
Caveats, 47
Color, 47
Cursor 1, Cursor 2 settings, 47
Enable cursors, 32
Function settings, 46
Horizontal cursors, 31
Measuring different sources, 47
Position field, 47
readouts, 31
Set cursor function (type), 46
Setup dialog box overview, 45
Index

Source field, 47
Units, 50
Vertical cursors, 31
Waveform cursors, 31
Cycle Area (pulse area), 239
Cycle Mean (pulse ampl), 232
Cycle RMS (pulse ampl), 232

D
Data acquisition introduction, 26
Data analysis, 2
Data Rate (Pattern Sync), 135
Data:Clock Ratio (Pattern Sync), 135
Delay (channel), 153
Delay (pulse timing), 236
Deskew (channel), 153
Dielectric constant (horiz units), 77
Display, 12
  Customizing, 59
  Features, 61
  Graticule settings, 53
  Horizontal reference, 53
  Horizontal-scale readout, 53
  Infinite Persistence, 51
  Key points, 55
  Linear, 60
  Mag1, Mag2, 57
  Main, Mag1, and Mag2 views, 53
  None, 60
  Normal, 51
  Preview, 53
  Screen components, 53
  Set parameters, 59
  settings, 51
  Setup tab, 50
  Show Vectors, 51
  Sin(x)/x, 60
  Upper, lower amplitude-limits readouts, 53
  Variable Persistence, 51
  Vectors, 51
  Waveform data point interpolation, 60
  Waveform display persistence, 60

E
Distance (horiz units), 77
+Duty Cycle (pulse timing), 237
-Duty Cycle (pulse timing), 237
EMPH7, 175
EMPH8, 175
Emphasize Counts, 175
Envelope, 38
Excel, 2
Export dialog box, 179
Eye (clock trigger mode), 143

F
Factory default settings, 24
Fall Time (pulse timing), 237
FrameScan, 79
  Controls, 138
  Enable FrameScan mode, 86
  Overview, 82
  Reset FrameScan data, 86
  Set FrameScan scan bits, 86
  Setup dialog box, 134
  Theory of operation, 84
Free Run, 143
Frequency (pulse timing), 237
Front panel controls
  Acquisition, 20
  Channel number select buttons, 18
  Channel source, 18
  Horizontal, 21
  Trigger, 22
  Utility, 23
  Vertical, 19
  View, 20

G
Gain (pulse ampl), 233
Gate (measurement), 104
General purpose knob, 104
Getting Started, 7
GPIB
  configuration settings, 224
  controller, 224
  device, 224
  master, 224
  slave, 224
  Graticule settings, 53
  Graticule style, 59
  Graticules, 14

H
High (pulse ampl), 233
High/Low level tracking algorithms, 276
Histograms
  About, 33
  Background, 64
  Boundary setting, 64
  Boundary units setting, 64
  Clear histogram data, 62
  Display a histogram, 63
  Display Options settings, 63
  Enable a histogram, 62
  Enable Waveform database use, 62
  Key features, 64
  Limit Controls settings, 64
  Measurement region boundaries, 64
  Set display scaling algorithm (linear, logarithmic), 64
  Set histogram scaling algorithm (linear, logarithmic), 63
  Set horizontal histogram, 62
  Set the histogram color, 63
  Set the histogram display scaling algorithm, 63
  Set the histogram source, 62
  Set vertical histogram, 62
  Setup dialog box, 61
  Source settings, 62
  Statistical readout definitions, 66
  Holdoff (trigger), 145
  Horizontal cursors, 31
  Horizontal front panel controls
    MENU button, 21
    POSITION knob, 21
    RESOLUTION knob, 21
    SCALE knob, 21
  Horizontal settings
    All Timebases overview, 76
Index

Bits, 77
Comm Standard, 76
Dielectric constant, 77
Display scale, 78
Distance, 77
FrameScan, 79
Math and Reference
timebases, 69
Overview, 66
Pattern Sync, 79
Per division, 78
Per screen, 78
Position, 71
Propagation velocity, 77
Record length, 74
Reference, 75
Resolution, 73
Scale, 69
Seconds, 77
Timebase overview, 67
Timebase select, 68
Units, 77
Horz tab, 66
How to
Acquire and display a
signal, 26
Add or delete mask
vertices, 94
Add/delete a mask
polygon, 94
Change instrument
settings, 23
Clear histogram data, 62
Clear mask waveform and hit
data, 88
Create a User (custom)
mask, 95
Create/delete a mask
polygon, 94
Display a histogram, 63
Display mask on screen, 89
Enable a histogram, 62
Enable cursors, 32
Enable FrameScan mode, 86
Enable histogram waveform
database use, 62
Enable mask hit counting, 88
Enable mask margin
settings, 90
Enable waveform database
with mask, 88
Factory default settings, 24
Import a mask, 95
Mask Edit dialog box
overview, 94
Move mask vertices, 94
Reset FrameScan data, 86
Restore default setup, 24
Save a custom mask, 95
Select a mask polygon, 94
Select a mask vertex, 94
Select and display
waveforms, 24
Select Comm standard
mask, 88
Select mask color, 89
Select mask signal source, 88
Set a measurement region
(gate), 104
Set Automatic mask
autoset, 91
Set cursor color, 47
Set cursor type
(vertical, horizontal,
waveform), 46
Set FrameScan scan bits, 86
Set High/Low autoset
alignment mode, 91
Set histogram boundary units
:absolute, %), 64
Set histogram display scaling
algorithm, 63
Set histogram region
boundaries, 64
Set histogram scaling
algorithm (linear,
logarithmic), 63
Set horizontal histogram, 62
Set Manual mask autoset,
parameters, 91
Set mask autoset
parameters, 91
Set mask margin
parameter, 90
Set mask vertex horizontal
position, 94
Set mask vertex vertical
position, 94
Set RefLevel parameters, 107
Set the histogram color, 63
Set the histogram source, 62
Set vertical histogram, 62
Turn off cursor display, 46
View mask hit count
statistics, 98
K
Knobs
General purpose knob, 23
Horizontal POSITION, 21
Trigger LEVEL, 22
Vertical OFFSET, 19
Vertical POSITION, 19
Vertical RESOLUTION, 21
Vertical SCALE, 19
L
Linear, 60
Low (pulse ampl), 233
M
Mag1, Mag2, 57
Mag1, Mag2 buttons, 20
Main Position (Pattern Sync), 135
MAIN view, 20
Mask testing
Add or delete mask
vertices, 94
Add/delete a mask
polygon, 94
Clear mask waveform and hit
data, 88
Create a User (custom)
mask, 95
Create/delete a mask
polygon, 94
Display mask on screen, 89
Enable mask hit counting, 88
Enable mask margin
settings, 90
Enable waveform database
with mask, 88
Introduction, 34

DSA8300 Printable Online Help 287
Index

Mask Edit dialog box overview, 94
Mask hit count readout, 98
Mask Setup dialog box overview, 86
Mask source settings, 88
Mask usage guidelines, 95
Move mask vertices, 94
Point and polygon definitions, 95
Select a mask polygon, 94
Select a mask vertex, 94
Select Comm standard mask, 88
Select mask color, 89
Select mask signal source, 88
Set Automatic mask autoset, 91
Set High/Low autoset alignment mode, 91
Set Manual mask autoset, 91
Set mask autoset parameters, 91
Set mask margin parameter, 90
Set mask vertex horizontal position, 94
Set mask vertex vertical position, 94
Math waveforms overview, 29
Mathecd, 2
MATLAB, 2
Max (pulse ampl), 233
Mean (pulse ampl), 233
Measurement
AC RMS (pulse ampl), 231
Amplitude (pulse ampl), 231
Area (pulse area), 239
Automatic measurements caveats, 108
Automatic measurements key points, 109
Automatic measurements overview, 108
Average Optical Power (dBm) (pulse ampl), 232
Average Optical Power (watts) (pulse ampl), 232
Burst width (pulse timing), 236
Cross+ (pulse timing), 236
Cross- (pulse timing), 236
Cycle Area (pulse area), 239
Cycle Mean (pulse ampl), 232
Cycle RMS (pulse ampl), 232
Delay (pulse timing), 236
+Duty Cycle (pulse timing), 237
-Duty Cycle (pulse timing), 237
Fall Time (pulse timing), 237
Frequency (pulse timing), 237
Gain (pulse ampl), 233
High (pulse ampl), 233
High/Low level tracking algorithms, 276
High/Low parameters, 105
Low (pulse ampl), 233
Max (pulse ampl), 233
Mean (pulse ampl), 233
Measurement Setup overview, 98
Mid (pulse ampl), 233
Min (pulse ampl), 233
NRZ +Overshoot (ampl), 261
NRZ -Overshoot (ampl), 261
NRZ AC RMS (ampl), 255
NRZ Amplitude (ampl), 255
NRZ amplitude measurements, 254
NRZ Area, 268
NRZ area measurements, 268
NRZ Average Optical Power (dBm) (ampl), 255
NRZ Average Optical Power (watts) (ampl), 256
NRZ Bit Rate (timing), 265
NRZ Bit Time (timing), 265
NRZ Crossing % (ampl), 256
NRZ Crossing Level (ampl), 256
NRZ Crossing Time (timing), 265
NRZ Cycle Area, 268
NRZ Delay (timing), 265
NRZ Duty Cycle Distortion (timing), 265
NRZ Extinction Ratio (%) (ampl), 257
NRZ Extinction Ratio (ampl), 257
NRZ Extinction Ratio (dB) - Calibrated (ampl), 258
NRZ Extinction Ratio (dB) (ampl), 257
NRZ Eye Height (ampl), 258
NRZ Eye Width (timing), 266
NRZ Fall Time (timing), 266
NRZ Frequency (timing), 266
NRZ Gain (ampl), 259
NRZ High (ampl), 259
NRZ Low (ampl), 259
NRZ Max (ampl), 260
NRZ Mean (ampl), 260
NRZ measurement reference levels, 273
NRZ Mid (ampl), 260
NRZ Min (ampl), 260
NRZ Optical Modulation Amplitude (ampl), 261
NRZ Peak-to-Peak (ampl), 262
NRZ Peak-to-Peak Noise (ampl), 262
NRZ Period (timing), 266
NRZ Phase (timing), 267
NRZ Pk-Pk Jitter (timing), 267
NRZ Q Factor (ampl), 263
NRZ Rise Time (timing), 267
NRZ RMS (ampl), 263
NRZ RMS Jitter (timing), 267
NRZ RMS Noise (ampl), 264
NRZ Signal-to-Noise Ratio (ampl), 264
NRZ timing measurements, 264
Optical Modulation Amplitude (pulse ampl), 234
+Overshoot (pulse ampl), 234
-Overshoot (pulse ampl), 234
Peak-to-Peak Noise (pulse ampl), 234
Period (pulse timing), 237
Phase (pulse timing), 238
Pk-Pk (pulse ampl), 235
Pk-Pk Jitter (pulse timing), 238
Pulse area measurements, 239
Pulse measurements, 231
Pulse timing measurements, 236
Pulse waveform reference levels, 269
Reference level calculation, 268
RefLevel, 106
Region parameters (pulse), 102
Region parameters (RZ, NRZ), 103
Rise Time (pulse timing), 238
RMS (pulse ampl), 235
RMS Jitter (pulse timing), 238
RMS Noise (pulse ampl), 235
RZ +Duty Cycle (timing), 251
RZ +Width (timing), 253
RZ AC RMS, 240
RZ Amplitude, 240
RZ amplitude measurements, 240
RZ Area, 254
RZ area measurements, 254
RZ Average Optical Power (dBm), 241
RZ Average Optical Power (watts), 241
RZ Bit Rate (timing), 250
RZ Bit Time (timing), 250
RZ Cross+ (timing), 250
RZ Cross- (timing), 251
RZ Cycle Area, 254
RZ Delay (timing), 251
RZ Extinction Ratio, 241
RZ Extinction Ratio (%), 242
RZ Extinction Ratio (dB), 242
RZ Eye Height, 243
RZ Eye Opening Factor, 243
RZ Eye Width (timing), 251
RZ Fall Time (timing), 252
RZ Gain, 244
RZ High, 244
RZ Low, 244
RZ Max, 245
RZ Mean, 245
RZ Mid, 245
RZ Min, 245
RZ Peak-to-Peak, 246
RZ Peak-to-Peak Noise, 246
RZ Phase (timing), 252
RZ Pk-Pk Jitter (timing), 252
RZ Pulse Symmetry (timing), 253
RZ Q Factor, 247
RZ Rise Time (timing), 253
RZ RMS, 247
RZ RMS Jitter (timing), 253
RZ RMS Noise, 247
RZ Signal-to-Noise Ratio, 248
RZ Suppression Ratio, 248
RZ Suppression Ratio (%), 249
RZ Suppression Ratio (dB), 249
RZ timing measurements, 250
RZ waveform reference levels, 272
Set a measurement region (gate), 104
Signal-to-Noise Ratio (pulse ampl), 235
Source parameters, 101
+Width (pulse timing), 239
-Width (pulse timing), 239
_measurements bar, 12
Menu bar, 12
Mid (pulse ampl), 233
Min (pulse ampl), 233
Mouse/touchscreen operations, 17

N
NRZ +Overshoot (ampl), 261
NRZ -Overshoot (ampl), 261
NRZ AC RMS (ampl), 255
NRZ Amplitude (ampl), 255
NRZ Area, 268
NRZ Average Optical Power (dBm) (ampl), 255
NRZ Average Optical Power (watts) (ampl), 256
NRZ Bit Rate (timing), 265
NRZ Bit Time (timing), 265
NRZ Crossing % (ampl), 256
NRZ Crossing Level (ampl), 256
NRZ Crossing Time (timing), 265
NRZ Cycle Area, 268
NRZ Delay (timing), 265
NRZ Duty Cycle Distortion (timing), 265
NRZ Extinction Ratio (%) (ampl), 257
NRZ Extinction Ratio (ampl), 257
NRZ Extinction Ratio (dB) -Calibrated (ampl), 258
NRZ Extinction Ratio (dB) (ampl), 257
NRZ Eye Height (ampl), 258
NRZ Eye Width (timing), 266
NRZ Fall Time (timing), 266
NRZ Frequency (timing), 266
NRZ Gain (ampl), 259
NRZ High (ampl), 259
NRZ Low (ampl), 259
NRZ Max (ampl), 260
NRZ Mean (ampl), 260
NRZ measurement reference levels, 273
NRZ Mid (ampl), 260
NRZ Min (ampl), 260
NRZ Optical Modulation Amplitude (ampl), 261
NRZ Peak-to-Peak (ampl), 262
NRZ Peak-to-Peak Noise (ampl), 262
NRZ Period (timing), 266
NRZ Phase (timing), 267
NRZ Pk-Pk Jitter (timing), 267
NRZ Q Factor (ampl), 263
<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>NRZ Rise Time (timing)</td>
<td>267</td>
</tr>
<tr>
<td>NRZ RMS (ampl)</td>
<td>263</td>
</tr>
<tr>
<td>NRZ RMS Jitter (timing)</td>
<td>267</td>
</tr>
<tr>
<td>NRZ RMS Noise (ampl)</td>
<td>264</td>
</tr>
<tr>
<td>NRZ Signal-to-Noise Ratio (ampl)</td>
<td>264</td>
</tr>
<tr>
<td>Offset (vertical)</td>
<td>159</td>
</tr>
<tr>
<td>Offset, vertical</td>
<td>151</td>
</tr>
<tr>
<td>On-screen operations</td>
<td>14</td>
</tr>
<tr>
<td>Optical Modulation Amplitude</td>
<td>234</td>
</tr>
<tr>
<td>Options</td>
<td>5</td>
</tr>
<tr>
<td>Other (clock trigger mode)</td>
<td>143</td>
</tr>
<tr>
<td>+Overshoot (pulse ampl)</td>
<td>234</td>
</tr>
<tr>
<td>-Overshoot (pulse ampl)</td>
<td>234</td>
</tr>
<tr>
<td>Page Setup dialog box</td>
<td>182</td>
</tr>
<tr>
<td>Pattern (clock trigger mode)</td>
<td>143</td>
</tr>
<tr>
<td>Pattern Length (Pattern Sync)</td>
<td>135</td>
</tr>
<tr>
<td>Pattern Sync</td>
<td>79</td>
</tr>
<tr>
<td>Pattern Sync Controls</td>
<td>135</td>
</tr>
<tr>
<td>Pattern Sync Setup dialog box</td>
<td>134</td>
</tr>
<tr>
<td>Peak-to-Peak Noise (pulse ampl)</td>
<td>234</td>
</tr>
<tr>
<td>Per division (horiz scale)</td>
<td>78</td>
</tr>
<tr>
<td>Per screen (horiz scale)</td>
<td>78</td>
</tr>
<tr>
<td>Period (pulse timing)</td>
<td>237</td>
</tr>
<tr>
<td>Phase (pulse timing)</td>
<td>238</td>
</tr>
<tr>
<td>Phase reference</td>
<td></td>
</tr>
<tr>
<td>Free Run, 113</td>
<td></td>
</tr>
<tr>
<td>Off, 113</td>
<td></td>
</tr>
<tr>
<td>Phase corrections</td>
<td>113</td>
</tr>
<tr>
<td>Phase Reference Setup overview</td>
<td>110</td>
</tr>
<tr>
<td>Phase-correction timebase</td>
<td>113</td>
</tr>
<tr>
<td>Spread spectrum clocking</td>
<td></td>
</tr>
<tr>
<td>trigger, 113</td>
<td></td>
</tr>
<tr>
<td>Triggered, 113</td>
<td></td>
</tr>
<tr>
<td>Triggered (SSC), 113</td>
<td></td>
</tr>
<tr>
<td>Phase Reference Caveats</td>
<td>119</td>
</tr>
<tr>
<td>Pk-Pk (pulse ampl), 235</td>
<td></td>
</tr>
<tr>
<td>Pk-Pk Jitter (pulse timing), 238</td>
<td></td>
</tr>
<tr>
<td>Pop-up keyboard and keypad, 15</td>
<td></td>
</tr>
<tr>
<td>Position (vertical), 160</td>
<td></td>
</tr>
<tr>
<td>Position, vertical, 151</td>
<td></td>
</tr>
<tr>
<td>Preset settings (TDR), 122</td>
<td></td>
</tr>
<tr>
<td>Print dialog box, 182</td>
<td></td>
</tr>
<tr>
<td>Propagation velocity (horiz units), 77</td>
<td></td>
</tr>
<tr>
<td>Pulse measurement reference levels, 269</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td></td>
</tr>
<tr>
<td>QWERTY keyboard, 15</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Readout area, 12</td>
<td></td>
</tr>
<tr>
<td>Readout docking, 12</td>
<td></td>
</tr>
<tr>
<td>Readout On/Off, 12</td>
<td></td>
</tr>
<tr>
<td>Readouts, 12</td>
<td></td>
</tr>
<tr>
<td>READY light, 22</td>
<td></td>
</tr>
<tr>
<td>Recall Setup dialog box, 185</td>
<td></td>
</tr>
<tr>
<td>Recall setups caveats, 186</td>
<td></td>
</tr>
<tr>
<td>RefLevel tab, 106</td>
<td></td>
</tr>
<tr>
<td>Region gate (measurement), 104</td>
<td></td>
</tr>
<tr>
<td>Related documents, 1</td>
<td></td>
</tr>
<tr>
<td>Remotely control the instrument, 2</td>
<td></td>
</tr>
<tr>
<td>Restore default (factory) setup, 24</td>
<td></td>
</tr>
<tr>
<td>Rise Time (pulse timing), 238</td>
<td></td>
</tr>
<tr>
<td>RMS (pulse ampl), 235</td>
<td></td>
</tr>
<tr>
<td>RMS Jitter (pulse timing), 238</td>
<td></td>
</tr>
<tr>
<td>RMS Noise (pulse ampl), 235</td>
<td></td>
</tr>
<tr>
<td>Run/Stop Button Only, 38</td>
<td></td>
</tr>
<tr>
<td>RZ +Duty Cycle (timing), 251</td>
<td></td>
</tr>
<tr>
<td>RZ +Width (timing), 253</td>
<td></td>
</tr>
<tr>
<td>RZ AC RMS, 240</td>
<td></td>
</tr>
<tr>
<td>RZ Amplitude, 240</td>
<td></td>
</tr>
<tr>
<td>RZ Area, 254</td>
<td></td>
</tr>
<tr>
<td>RZ Average Optical Power (dBm), 241</td>
<td></td>
</tr>
<tr>
<td>RZ Average Optical Power (watts), 241</td>
<td></td>
</tr>
<tr>
<td>RZ Bit Rate (timing), 250</td>
<td></td>
</tr>
<tr>
<td>RZ Bit Time (timing), 250</td>
<td></td>
</tr>
<tr>
<td>RZ Cross+ (timing), 250</td>
<td></td>
</tr>
<tr>
<td>RZ Cross- (timing), 251</td>
<td></td>
</tr>
<tr>
<td>RZ Cycle Area, 254</td>
<td></td>
</tr>
<tr>
<td>RZ Delay (timing), 251</td>
<td></td>
</tr>
<tr>
<td>RZ Extinction Ratio, 241</td>
<td></td>
</tr>
<tr>
<td>RZ Extinction Ratio (%), 242</td>
<td></td>
</tr>
<tr>
<td>RZ Extinction Ratio (dB), 242</td>
<td></td>
</tr>
<tr>
<td>RZ Eye Height, 243</td>
<td></td>
</tr>
<tr>
<td>RZ Eye Opening Factor, 243</td>
<td></td>
</tr>
<tr>
<td>RZ Eye Width (timing), 251</td>
<td></td>
</tr>
<tr>
<td>RZ Fall Time (timing), 252</td>
<td></td>
</tr>
<tr>
<td>RZ Gain, 244</td>
<td></td>
</tr>
<tr>
<td>RZ High, 244</td>
<td></td>
</tr>
<tr>
<td>RZ Low, 244</td>
<td></td>
</tr>
<tr>
<td>RZ Max, 245</td>
<td></td>
</tr>
<tr>
<td>RZ Mean, 245</td>
<td></td>
</tr>
<tr>
<td>RZ measurement reference levels, 272</td>
<td></td>
</tr>
<tr>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Sample, 38</td>
<td></td>
</tr>
<tr>
<td>Save Setup dialog box, 184</td>
<td></td>
</tr>
<tr>
<td>Save setups caveats, 186</td>
<td></td>
</tr>
<tr>
<td>Save Waveform dialog box, 188</td>
<td></td>
</tr>
<tr>
<td>Saving a waveform, 181</td>
<td></td>
</tr>
<tr>
<td>Scale (vertical), 160</td>
<td></td>
</tr>
<tr>
<td>Scale, vertical, 149</td>
<td></td>
</tr>
<tr>
<td>Seconds (horiz units), 77</td>
<td></td>
</tr>
<tr>
<td>Select and display waveforms, 24</td>
<td></td>
</tr>
<tr>
<td>Select waveform, 12</td>
<td></td>
</tr>
<tr>
<td>Set RefLevel parameters, 107</td>
<td></td>
</tr>
<tr>
<td>Setting colors (waveform, graticule, cursor, mask, etc.), 59</td>
<td></td>
</tr>
</tbody>
</table>
Setups tabs
- Acq (Acquisition), 37
- Acquisition mode, 37
- Cursor, 45
- Disp (Display), 50
- Hist (Histogram), 61
- Horz (Horizontal), 66
- Mask, 86
- Meas (Measurements), 98
- Mode/Trigger, 129
- Phase Reference, 110
- TDR, 120
- Vert (Basic), 147
- Vert (Optical), 168
- Wfm Database, 171

Signal acquisition process, 9
Signal conditioning and scaling, 28
Signal-to-Noise Ratio (pulse ampl), 235
Sin(x)/x, 60
Software, 5
Spread spectrum clocking trigger, 113
SSC trigger, 113
Status bar, 12
Step Rate (TDR), 128
Stop Action settings, 40
Stop After (acquisition)
  - Average Complete, 38
  - FrameScan Cycle, 38
  - Histogram Hits, 38
  - Histogram Waveforms, 38
  - Mask (n) Hits, 38
  - Mask Samples, 38
  - Mask Total Hits, 38
  - Mask Waveforms, 38
  - Number of Acquisitions, 38

System Properties dialog box
- Mainframe tab, 225
- Modules tab, 226
- Options tab, 228
- Probes tab, 227

Disp (Display), 50
General (user preferences), 221
GPIB configuration (user preferences), 224
HiLow, 105
Hist (Histogram), 61
Horz (Horizontal), 66
Mainframe (system properties), 225
Mask, 86
Meas, 98
Options (system properties), 226
Phase Ref, 110
Probe (system properties), 227
RefLevel, 106
Source, 101
Start-up (user preferences), 222

TDR
- ACQ settings, 125
- Acquisition On, 125
- Acquisition units, 125
- Advanced TDR setup, 127
- Autoset overview, 127
- Channel select setting, 122
- Deskew settings (step), 126
- Diff setting, 122
- On setting, 124
- Polarity setting, 124
- Preset settings, 122
- Step deskew settings, 126
- Step polarity setting, 124
- TDR 10MHz Reference, 127
- TDR Autoset Option, 127
- TDR Setup dialog box, 120
- TDR Step Rate, 127
- TDR Step settings, 124

TDR clock, 143
TekVISA
  - ActiveX (TVC), 2
  - Excel toolbar, 2
  - programming manual, 4
  - TekVISA, 2

Theory of operation
- Acquisition system, 7
- Signal acquisition process, 9
- Signal processing transformation system, 7
- Timebase system, 7
- Trigger system, 7

Timebase (horizontal)
- controls, 21

Toolbar, 12
Touchscreen, 17
TRIG'D light, 22

Trigger
- Advanced trigger setup, 139
- Background, 141
- Clock, 131
- Clock recovery, 143
- Clock recovery outputs, 133
- Direct, 131
- External, 143
- Eye, 143
- Free run, 143
- Free Run, 131
- Holdoff, 145
- Holdoff (reference), 140
- Internal, 143
- Key points, 141
- Mode/Trigger Setup dialog box, 129
- Other, 143
- Pattern, 143
- Source settings, 131
- Sources, 143
- TDR, 131
- Trigger modes (clock), 143

Trigger front panel controls
- LEVEL knob, 22
- MENU button, 22
- READY light, 22
- SET TO 50% button, 22
- TRIG'D light, 22

U
User interface
- Acquisition front panel controls, 20
- Alphabetical keyboard, 15
Channel select front panel controls, 18
Channel source front panel controls, 18
Graticules, 14
Horizontal front panel controls, 21
Measurements bar, 12
Menu bar, 12
Mouse/touchscreen operations, 17
On-screen operations, 14
Overview, 11
Pop-up keyboard and keypad, 15
QWERTY keyboard, 15
Readout area, 12
Readout docking, 12
Readout On/Off, 12
Readouts, 12
Select waveform, 12
Status bar, 12
Toolbar, 12
Trigger front panel controls, 22
Utility front panel controls, 23
Vertical front panel controls, 19
View front panel controls, 20
Virtual keyboard and keypad, 15
Waveform display area, 12
User Preferences dialog box
General tab, 221
GPIB configuration tab, 224
Start-up tab, 222
Utility front panel controls
AUTOSET button, 23
CURSORS button, 23
DEFAULT SETUP button, 23
FINE button, 23
General purpose knob, 23
PRINT button, 23
SELECT button, 23
SETUP DIALOGS button, 23
TOUCH SCREEN button, 23
Virtual keyboard and keypad, 15
VXI 11.2 LAN server, 2
VXI plug&play, 2

W
Waveform cursors, 31
Waveform data point interpolation, 60
Waveform database
Background, 176
BIN7, 175
BIN8, 175
Display options settings, 175
EMPH7, 175
EMPH8, 175
Emphasize Counts, 175
Infinite, 174
Persistence settings, 174
Samples, 174
Setup dialog box overview, 171
Variable, 174
Waveforms, 174
Waveform database caveats, 178
Waveform Database key points, 179
Waveform database overview, 29
Waveform database view, 176
Waveform display persistence, 60
Waveform measurement introduction, 30
Waveform Properties dialog box, 229
Waveform reference level calculation (measurements), 268
+Width (pulse timing), 239
-Width (pulse timing), 239